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MONOGRAM Customer License Agreement 

IMPORTANT: THE ENCLOSED MONOGRAM PROGRAM IS LICENSED BY MONOGRAM TO CUS- 

TOMERS FOR THEIR USE ONLY ON THE TERMS SET FORTH BELOW. OPENING THIS PACKAGE 

OR USING THE ENCLOSED DISKETTES INDICATES YOUR ACCEPTANCE OF THESE TERMS. 

I. License. 
MONOGRAM hereby grants you a non-exclusive license to use the enclosed MONOGRAM software 
and manual subject to the terms and restrictions set forth in this License Agreement. Title to such 
software and manual remains with MONOGRAM. 

II. Copyright. 

The software and the manual are copyrighted. You may not copy or otherwise reproduce any part of 
the software or the manual or its documentation, except that you may make archival copies of the 
software solely for the purpose of backing up your software and protecting your investment from loss. 

III. Restrictions on Use and Transfer. 

The original and any backup copies of the software and the manual are to be used only in connection 
with a single computer. You may physically transfer the software from one computer to another, 
provided that the software is used in connection with only one computer at a time. You may not transfer 

the software electronically from one computer to another over a network. You may not distribute 
copies of the software or the manual to others. YOU MAY NOT USE, COPY, MODIFY, TRANSFER, 

SUBLICENSE, RENT, LEASE, CONVEY, TRANSLATE OR FORMAT OR DECOMPILE OR DISASSEMBLE 
THE SOFTWARE OR ANY COPY, MODIFICATION OR MERGED PORTION, IN WHOLE ORIN PART, 
EXCEPT AS EXPRESSLY PROVIDED FOR IN THIS LICENSE. 

s 

IV. No Warranty of Performance. 
MONOGRAM DOES NOT AND CANNOT WARRANT THE PERFORMANCE OR RESULTS THAT MAY 

BE OBTAINED BY USING THE SOFTWARE OR THE MANUAL. ACCORDINGLY, THE SOFTWARE 
AND THE MANUAL ARE LICENSED “AS IS” WITHOUT WARRANTY AS TO THEIR PERFORMANCE, 
MERCHANTABILITY OR FITNESS FOR ANY PARTICULAR PURPOSE. THE ENTIRE RISK AS TO THE 
RESULTS AND PERFORMANCE OF THE PROGRAM IS ASSUMED BY YOU. SHOULD THE SOFTWARE 
OR THE MANUAL PROVE DEFECTIVE, YOU (AND NOT MONOGRAM OR ITS DEALERS, OR 

DISTRIBUTORS) ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR 

CORRECTION. 

V. Limited Warranty for Diskettes. 
To the original licensee only, MONOGRAM warrants the magnetic diskettes on which the software is 
recorded to be free from defects in materials and faulty workmanship under normal use and service 

for a period of ninety (90) days from the date the software is delivered. If, during this 90-day period, 
a defect in the diskette should occur, the diskette may be returned to MONOGRAM at the address noted 

below, or to any authorized MONOGRAM dealer, and MONOGRAM will replace the diskette without 
charge to you, provided that you have previously returned the enclosed Warranty Registration Card 
to MONOGRAM. Your sole and exclusive remedy in the event of a defect is expressly limited to 
replacement of the diskette as provided above. Any implied warranties of merchantability and fitness 
for a particular purpose are limited in duration to the period of ninety (90) days from the date of 
delivery. If the failure of a diskette has resulted from accident, abuse or misapplication of the diskette, 
then MONOGRAM shall have no responsibility to replace the diskette under the terms of this limited 

warranty. This limited warranty gives you specific legal rights, and you may also have other rights 
which vary from state to state. 



VI. Diskette Replacement Policy. 

If after ninety (90) days and during the first year after the date of delivery, a defect in a diskette should 

occur, the diskette may be returned to MONOGRAM, accompanied with proof of purchase and 

payment of the applicable replacement fee as outlined in the Warranty and Replacement Policy and 

MONOGRAM will replace the diskette provided that you have previously returned your Warranty 
Registration Card to MONOGRAM. 

VII. Limitation of Liability. 

NEITHER MONOGRAM NOR ANYONE ELSE WHO HAS BEEN INVOLVED IN THE CREATION, 
PRODUCTION, OR DELIVERY OF THIS SOFTWARE OR MANUAL SHALL BE LIABLE FOR ANY 

DIRECT, INCIDENTAL, SPECIAL, EXEMPLARY OR CONSEQUENTIAL DAMAGES, SUCH AS, BUT NOT 
LIMITED TO, LOSS OF ANTICIPATED PROFITS OR BENEFITS, RESULTING FROM THE USE OF THE 

PROGRAM OR ARISING OUT OF ANY BREACH OF ANY WARRANTY, EVEN IF NOTICE HAS BEEN 
MADE OF THE LIKELIHOOD OF SUCH DAMAGES. SOME STATES DO NOT ALLOW THE EXCLUSION 
OR LIMITATION OF DIRECT, INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THE ABOVE 
LIMITATION MAY NOT APPLY TO YOU. 

VIII. Term. 

The license is effective until terminated. You may terminate it at any time by destroying the software 

and the manual together with all copies, modifications and merged portions in any form. It will also 

terminate if you fail to comply with any term or condition of the License Agreement. You agree upon 
such termination to destroy the software and the manual together with all copies, modifications and 

merged portions in any form. 

YOUR USE OF THE SOFTWARE OR MANUAL OR SIGNATURE ON THE ENCLOSED WARRANTY 

REGISTRATION CARD ACKNOWLEDGES THAT YOU HAVE READ THIS CUSTOMER LICENSE 

AGREEMENT AND AGREE TO ITS TERMS. YOU FURTHER AGREE THAT THE LICENSE AGREEMENT 

IS THE COMPLETE AND EXCLUSIVE STATEMENT OF THE AGREEMENT BETWEEN US AND 

SUPERSEDES ANY PROPOSAL OR PRIOR AGREEMENT, ORAL OR WRITTEN, AND ANY OTHER 

COMMUNICATIONS BETWEEN US RELATING TO THE SUBJECT MATTER OF THIS AGREEMENT. 

Monogram Software, Inc. 
531 Van Ness Avenue 

Torrance, CA 90501 

(213) 533-5120 
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CHAPTER I: 
INTRODUCTION 

BUSINESS SENSE FEATURES 
Business Sense is a powerful, easy-to-use, integrated 

accounting system designed for the Macintosh. General 

Ledger, Accounts Receivable, Invoicing, Accounts Payable, 
Payroll and Budgeting functions are provided. Powerful, 

yet flexible, Business Sense was designed to serve in any 

small-to-medium-sized business environment. 

When a window is closed, new transactions are automati- 

cally posted and all modules are updated. This eliminates 
redundant data entry and ensures integrity between 

accounting functions. 

Business Sense uses icons and menus. It was designed for 

& the Macintosh, not converted from an older system. The 
Macintosh user-interface has been fully implemented. You 

can edit information rather than retype it. Business Sense 

works with two floppy disks or a hard disk. 

Business Sense uses multiple windows. You can open 

additional journals and lists without closing one journal to 

go to another. 

You can type the first few letters of an account, customer 

or vendor name, and Business Sense will look up the 

account number for you. You can select an account, 
customer or vendor in its listing window, then click a 

button to transfer the account number to your journal. You 

can use multiplication formulas to calculate money 
amounts. The Find feature locates accounts, descriptions 

and amounts in the lists, journals and reports. 

& Fifty-two reports and graphs are illustrated in Appendix D: 
Reports Catalog. They are available anytime and are always 

up-to-date. Mailing labels can be prepared for customers, 
vendors and employees. Accounting data can be exported 

to spreadsheets, text editors, data base managers and 

communications programs for additional processing or 

analysis. 
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A powerful Recurring Entries function lets you customize 
Business Sense to simplify repetitive journal entries, 
monthly subscriber billing and regular check writing. 

GENERAL LEDGER 
The Business Sense General Ledger handles up to 8,000 
accounts and up to five checking accounts. Money 
amounts can be up to a trillion dollars. Books can be kept — 
for multiple companies. 

Account numbers are four digits long. Departmental sub- 
accounts allow profitability of up to 99 departments or 
profit centers to be tracked. Eight-digit sub-accounts can be 
used to segregate amounts that will be summarized in the 
Income Statement or Balance Sheet. 

Transactions can be distributed to an unlimited number of 

accounts. 

Monthly closing is not required. The books stay open for 
all months all year. 

You can pay bills directly from the Chart Of Accounts, or 

put them through the Accounts Payable module. 

Sales are tabulated for seven localities and three tax- “ 

exempt sales categories. 

ACCOUNTS RECEIVABLE 
The Accounts Receivable module processes up to 8,000 

open item and balance forward customers. Credit limits, 
invoice aging and commissions are tracked. The program 
will calculate and apply finance charges, and produces 
customer statements on demand. Credit memos can be 
issued efficiendy. 
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INVOICING 
Business Sense prepares detailed invoices for some sales or 
for all sales. Sales taxes are calculated for invoices based 
on codes in the line items. Multiple ship-to addresses are 
stored for each customer. 

ACCOUNTS PAYABLE 
The Accounts Payable module holds up to 8,000 vendors. 
It lets you select invoices for payment individually or in 

groups. It prints one itemized check when you pay a 
vendor for multiple invoices. It tracks discounts, credit 
memos and partial payments, and prints 1099 Forms at the 
end of the year. A vendor analysis report and selective 
aging reports are available. 

PAYROLL 
The Payroll module calculates 10 categories of wages and 
10 deductions for up to 8,000 salaried and hourly employ- 
ees. Federal, state and local tax tables, straight percentages, 

or fixed deduction amounts can be applied. 

Business Sense prints itemized paychecks and tracks 
employer tax contributions. The Payroll report shows 
monthly and quarterly information for Form 941. W-2 
Forms are printed at the end of the year. 

BUDGETING 
Budgets are easily tracked. Income Statements can com- 

pare actual to budget for any period, for the whole com- 
pany or for a profit center. 
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RECOMMENDED HARDWARE 
Business Sense works with the following equipment: 

e Apple Macintosh 512KE, Macintosh Plus, Macintosh SE 

or Macintosh II computer. 

e Hard disk drive or second floppy disk drive. 

e Apple ImageWriter I or ImageWriter II printer. 

nq = 

More computer memory will give more speed and allow ™ 

more accounts and transactions at one time. You can 

estimate the size of your data files: 

Estimating the size of ___Accounts in Chart Of Accounts 

your data files + _ Customers 

+ _ Vendors 

= ___ Total accounts @ 500 bytes = bytes 

Employees @ 1500 bytes = bytes 

Checks @____ items per check = check lines 

Deposits @__sitems per deposit = deposit lines 

Invoices @__ lines perinvoice = invoice lines 

Other entries @__ lines each = other lines “ey 

Total lines @ 100 bytes = bytes 

Total data files = _bytes 

512K bytes of memory is enough for about 500,000 bytes 
of data. A megabyte of memory will accommodate about 

1,000,000 bytes of data. An unlimited number of transac- 

tions can be accommodated by summarizing the data disk 

during the year. 

The Apple LaserWriter or LaserWriter Plus printer can be 
used to print reports, but the forms tractor on the Image- 
Writer is needed for Invoices, Billing Statements, W-2 

Forms and 1099 Forms. Checks can be manually-fed 
through the LaserWriter or tractor-fed through the Image- ‘a. 

Writer. 
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USING THIS MANUAL 
Business Sense is easy to understand and to use. There are, 
however, some important decisions to make when you 
begin using the program. This manual gives advice to help 

you make well-informed decisions and shows you short- 
cuts that will increase your efficiency and satisfaction. Read 

the manual before beginning to enter your company data. 
Pay particular attention to setting up your Chart Of Ac- 

counts and to safeguarding your data with backup disks. 

Chapter 2: 

Chapter 3: 

Chapter 4: 

Chapter 5: 

Chapter 6: 

Chapter 7: 

Chapter 8: 

Quick Start Test Drive gives you hands-on 
experience with the Business Sense Demo 
Program. 

Tips for Users gives you perspective about 
operations and data. 

Starting Your Accounting System advises you 
about decisions to make in converting your 

books to Business Sense. It has a step-by- 
step procedure to accomplish this. 

Using Business Sense tells how to start and 
stop the program, and discusses backup and 
control. 

Main Window Icons explains each of the 
icons Business Sense uses to represent your 

data. 

Pull-Down Menu Commands explains each 
menu command. 

Tips for Advanced Users offers additional 
advice to users with special needs. 
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CHAPTER 2: 
QUICK START TEST DRIVE 

To get the feel of Business Sense, take a test drive with the 

Demo Disk. 

STARTING THE DEMO PROGRAM 

e Turn on the Macintosh. 

e Insert the Business Sense Demo Disk. 

r 
é File Edit View Special . 

EJ Business Sense™ - Demo Disk HEEVIE 
3 ttems T1SK in disk 60K available 

03 

1 wi. oe 

Business Sense™ - Der 

Business Sense™ Demo Business Sense™ - Demo Data 

Rk 

e Double-click on the Business Sense Demo icon to 
Start the program, or click once on the icon and choose 

Open from the File menu. After the title screen appears, 
the Main window will appear as shown on page 2-2. 
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2-2 Business Sense 

& File Edit Function Gl Report AR/AP/Payroll Report 

es : LEARNED LUMBER CO. 

The Main window is the “control center,” or “home base” 

of the program. It contains 14 icons and six pull-down 
menus. 

You can have multiple icons open at one time, so you 
don’t have to quit one activity to begin another. 

The Demo Program 
Business Sense Demo is the actual Business Sense progra 

with two simplifications. Because the Demo Data is for the 
first two months of 1987, the Demo Program always thinks 
today is February 28, 1987. 

To let you experiment freely and reuse the data, the Demo 
Program throws away journal entries instead of posting 

them. This keeps the Demo Program from printing in- 
voices or checks, or giving Hash Totals. The full version of 

Business Sense checks all transactions to make sure they 

refer to real account numbers, and that they balance. 



COMPANY INFO 
The first icon, Company Info, holds general information 

about your company. For this test drive, your company is 

“Learned Lumber.” 

e Click the mouse on the Company Info icon, and a 
dialog box appears: 

Co. Name LEARNED LUMBER CO. 

Addr 1 6700 Hermosa Way 

Addr 2 

City,state 
ZipCode = [90415 
Federal ID# 

State iD# 

First Month of Fiscal Year 

if you enter ae password, please 

write it down in case you forget it! 

Unrestricted Password 

Restricted Password 

This information will appear on reports. Passwords can be 

& used to protect your data. 

e Click the mouse on the OK button to return to the Main 
window. 

CHART OF ACCOUNTS 
The Chart Of Accts icon represents the list of asset, liability, 

equity, revenue and expense accounts for your company. 

e Click the mouse on the Chart Of Accts icon. A 
window will open showing the account numbers, 
types and names: 

Xd ux 

33° 0% ro 

x 2 4 % xP’. ao = 

c Market Account 

Prepaid insurance - Fire 

paid insurance - Trucks 
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A starter chart of accounts like this one, which you can 

modify to suit your business, is included with Business 

Sense. 

e Scroll by clicking on the down-arrow in the window’s 
right border, to view more accounts. Scroll down until 

account number 6070 is visible. 

e Click on account 6065/01, Telephone—Hermosa. “ 
A “More” tab appears. 

e Click on the “More” tab. A dialog box appears: 

Account Name |Telephone-Hermosa | Acct*| 6065/01 = 

General Telephone 

PO Box 4392 

Los Angeles, CA 

92588 

@ Default Address 

Name 

Address 1 

Address 2 

City,State 

Zip Code 
yi 

© Address 1 © Address 4 © Address 7 

© Address 2 O Address 5 O Address 8 

O Address 3 ©O Address 6 O Address 9 

Business Sense holds up to 10 payee names and addresse 
for each account, so you can pay bills in one step, directly — 

from the Chart of Accounts. 

e Click on the Address 1 radio button. A different payee 
name and address appears: 

Account Name |Telephone-Hermosa | Acct*| 6065/01 = 

Name (snow } 
Address 1 
Address 2 (newt ) 

City,state [Marina del fey, CA (pone } 
ZipCode (90292 

© Default Address 

@ Address 1 © Address 4 O Address 7? 

O Address 2 O Address 5 O Address 8 

© Address 3 O Address 6 O Address 9 Ty 

e Click on the DONE button to return to the Chart Of 
Accts list. 

e Click on the Close box in the top left corner of the 
Chart Of Accts window to close the window. 
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CUSTOMERS 
Business Sense records important information about your 

customers. 

e Click on the Customers icon, and a window will open 
showing the customers list: 

IMViLongvies Oeve! of 

1050 /O7O00 /INViHright Rooa Addi tions 

This window shows the customer number and name, and 

whether the account will be aged by open invoices or 

balance forward. 

e Click on the first customer, Allen Contractors. 

e Click on the “More” tab to see additional information 
about Allen Contractors: 

Bill/Ship 

Bill To @® 

ShipTo 1 ©  City,State|Long Beach, CA 
Ship To 2 O Zip Code | 96881 

ShipTo3 © Contact | Ralph Miller 

ShipTo4 © Phone* Terms | 2% 10, Net 30 

ShipTo5 © FOB ‘Hermosa si Discount Acct*| 4500/01 
snip vie [Truce] Ship Te 6 O “ Sales Person ID | 1000 | 

ShipTo? © Credit Limit | 15000.00 Commission |7.00 | 

Ship To 8 
r O  Finence Charges |1.00 | % Over Days 

& ShipTo9 © minimum Charge| —s_ || Rewenue Acct* 
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2-6 Business Sense 

You will record your collections contact, shipping instruc- 
tions, terms and discounts, credit limit, sales commission 

assignment, and finance charges information here. Nine 

additional ship-to addresses can be associated with this 
customer: 

e Click on the Ship To 1 radio button, and one of the 
additional addresses will appear: f 

Bill/Ship Nome Meadowview Homes | Acct*#| 1050/0100 D < 

Addrt 
Bill To @) Addr2 

ShipTo! @ City,Stete 

Ship To 2 O Zip Code 

ShipTo3 © Contact /|Bred Culver 3 

ShipTo 4 Phone# =| 714-526-2345 | 
Terms |2% 10, Net 30 

ShipToS © FOB Hermosa | Discount Acct*| 4500/01 
Ship Vie |Truck | Ship To 6 © Sales Person 1D 1000 

ShipTo 7 O Credit Limit [15000.00 Commission |7.00 | 
Ship To 8 

4 ©  sinence Charges |1.00 | % Over Days 
ShipTo9 O minimum Cherge| _—_—i«| Revenue Acct*(4200 _—«| 

e Click on the DONE button to return to the Customers “ 
window. 

e Close the Customers window by clicking on the close 
box. 

INVOICING 
Prepare invoices and record sales on account in the Sales/ 
AR Journal. 

e Click on the Sales/AR icon. A journal window will 
appear: 

LEARNED LUMBER CO. Debi ts 
For month of F 

HH EHH Desor te 0 i 
Ha stat cts ’ Hig Gam 

@ 8 ° ° 

COOP O OOOOH TORE EEE E EEO EEEEEE OEE O OOOO EEO E REET EEE e EEE EH EEE HEHE S OEE EEEEEEEEE HERE EEE SEHESEREEES 

POPUP EEEUE EPR) POPES EECESS CO UUUOCEEEOSES) COUPE SS ESSE EESS EOC) 

POU ePREEPPP PEEP ee eee eee eee ee (OE SUPPOSE SSEEE POSSESS OSSSESD Cee 

PPP TEeeEETEP ETP) POSE OSES EOSS COU UCSCOOECEOS) (COC CSUCESSSEEES POSS Tee) 

POPUP UEPERUTE PE EPS E ESSE SUUEOSESESEEES BOUSSSSSSSSESSSD eee 

POOP PERE UEPE ETE COPS COPE SCC OEESEES) CSE Ceres 



The last entry, on 02/26 for invoice 23132, has four lines. 
The first line is an invoice summary, charging the sale to 
the customer. The last three lines list the quantity, descrip- 
tion, revenue account, amount and tax code for each line 

item. 

When this invoice was created, Business Sense helped by 
filling in the date and invoice number, by looking up 
account numbers and by calculating the total amount of 

the invoice. 

When you close this window after entering new sales, the 
full version of Business Sense will offer to print invoices. 

e Click on the Close box to close the Sales/AR Journal. 

ACCOUNTS RECEIVABLE 
e Select AR Aging from the AR/AP/Payroll Report 

menu. A dialog box will show your options: 

customer Neme (+?) 
Account Number[ e 

CJ Age Selected Customer 

(C include Credit Memos 

@ Open invoice 

O Balance Forward 

Select Aging Period 

@ 0-30 Days @ 61-90 Days 

@ 31-60 Days @ 91+ Days 

e Click on the OK button to see the Open Invoice Aging 
report: 

i} Open invoice Aging 

LEARNED LUMBER CO. 
2/28/1987 

Pee Cus te ate HE Hee O- 08 ie | -60fHE 61-9081 PMT otal et: 
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Business Sense 

e You could print the report by selecting Print from the 

File menu. 

e Click on the close box to finish with the report. 

APPLY AR PAYMENTS 
Customer payments On account are entered in the Cash ‘oa 

Receipts Journal. To record a payment from Ocean Front 

Sales: 

e Click on the Cash Receipts Journal icon. Business 
Sense can handle multiple checking accounts. The 
“Checking - CRJ” window appears: 

LEARNED LUMBER pee 
sos the — - Febru 

e Select Apply AR Payments from the Function menu. 
A dialog box appears: 

Apply AR Payments 

customer Nome] 
Account Number peepee F : 2 

(ox } (snow) = (cancet } 

e In the Customer Name box, type “ocean” for Ocean 
Front Sales. 

e Click on the SHOW button; “ocean” changes to “Ocean 
Front Sales.” The account number appears: 

Apply AR Payments | 

Customer Neme| Ocean Front Sales 

>< Account Number | 1050/0500 



e Click on the OK button. The Customer Ledger Card for 
Ocean Front Sales appears: 

= 
Total this Batoh LEARNED LUMBER CO. i a 

sassstsesesetesssate cesses: egetecehesesseesesesesics sass s! . bt oes} th Pye ' bd f 

The Amount Paid column proposes the amounts which 

would pay off the invoices. Type in a smaller number to 
record a partial payment. The first invoice, number 23125, 
is already selected. 

e Click on the Pay Off Invoice button at the top of the 
Ledger Card. The Macintosh beeps. The running Batch 
Total is shown: $2000.00. 

e Ocean Front took a prompt payment discount on the 

second invoice. Click on the Discount Taken edit box 
for Invoice 23131. Calculate the discount amount with 
Business Sense to verify it. 

e Type .02°1900 into the Discount Taken box, and Tab. 
Business Sense calculates 38.00. 

-e Click the Pay Off Invoice button to pay the remaining 
balance. The Macintosh beeps. The Batch Total, 3862.00, 
corresponds to Ocean Front’s check, confirming the 
amounts. 
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e Close the Customer Ledger Card by clicking on the 

close box. The receipts have been entered in the Cash 
Receipts Journal: 

LEARNED LUMBER CO. Total this Batch 
1967 3062 00 

as 

eee 
as 
02/23) 
aa 
Secasseel 
02/25. 

x pes 

aft) : 

” we +, ite 
$F Sie +5 

Ranalt 279 he 

IE 8 
é 

ongviews Dev. - Paid irw. 

e Put away the Cash Receipts Journal by clicking on the 

close box. 

VENDORS 
Business Sense also records information about your 

vendors. “ey 

e Click on the Vendors icon, and a window will open 
showing the vendors list: 

LEARNED LUMBER CO. 
F Feb 1967 

This window shows the vendor number, name, and 1099 

information for individuals. . 
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e Click on the first vendor, Acme Sash & Frame. 

e Click on the “More” tab to see additional information 
about Acme: 

Name Acme Sash @ Frame Acct*#| 2050/0150 

Addri 788 Forrest Lane 

Addr2 

City, Stete| Mendicino, CA 

Zip Code |96659 

Discount Terms: 

Discount [2.00 |x before(10 | Deys 

Discount Acct# 

The mailing address for checks and discount for prompt 
payment are shown here. Like almost everything else, they 
can be edited. 

© Click on the DONE button to return to the vendors list. 

¢ Close the Vendors list by clicking on the close box. 

ACCOUNTS PAYABLE 
To record purchases on account from vendors: 

° Click on the Purchases/AP icon. The Purchases/AP 
Journal window opens, with the first blank line selected: 

Purchases/AP 

L 

Pusch. Window Frames — 

. Windows Frames - 

by GS - 3° Lonall 

bs 8 - S° Longif 

Purch 150 Sheets 3/4” Pi 

iP ch 150 Sheets 3/4” Pi 

Purch 200 Boxes 10 Nails 

Purch 200 Boxes 910 Moi ls 

aay 

) i bb] 

SEES 

03/17 i 
0 1G 

. . ea 

Or: 

C, al 

02 / 15}03/ 17! 
Rak ees 
02 / 16 }03 /08| 
ee ae 

ae Me 
02 /25|03/27|Purch 200 Boxes ©10 Nails | 
|_| (Purch 200 Boxes 910 Mails 
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To record a vendor invoice: 

Type “0225” for the Invoice Date, and Tab to the next 
field. Business Sense will insert a slash between the 

month and day. 

Terms are Net 30, so type “+30" to calculate the Due 
Date (03/27) based on the Invoice Date. Tab to the nex 
field. 

Type “Purch 2x4’s - Dover” to identify the order. Tab 
to the next field. 

Type “D 780550” for the vendor’s invoice number. Tab 
to the next field. 

Type “1501° for lumber purchases, and Tab to the next 
field. 

Type “3300” for the line-item amount. Press the Return 
key to start a new line. Most of the information is 

copied automatically into this new line. The amount to 

balance the transaction is proposed as the Invoice 
Amount. 

Tab twice to the Account #. 

To look up the account number for Dover, type “dov” 
and Tab to the next field. Business Sense will search th 
Chart Of Accts, Customers and Vendors lists. It will find 

Dover in the Vendors list, will translate the abbreviation 

to the account number (2050/0350), and will show the 

vendor name in the window header so you can check 

the translation: 

iC} ee Purchases (2? === ee SS 

Dover Lumber Milling LEARNED LUMBER co. 
| i the month add ; 
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The invoice is complete. Click on the close box to 
return to the Main window. 



Business Sense provides two versions of the AP Aging 

report: one to forecast due dates and the other to survey 
past due amounts. 

EMPLOYEES 
e Click on the Employees icon. The Employees list 
window appears: 

e Click on the “More” tab. The Wages information for the 
selected employee appears: 

Wage No. Name | Brown, John J. iD 

Expense Account |6045/01 

Wages 1 

Wages 2 

Wages 3 

Other Reimbursements 

Account Number 

Wages 4 

Wages 5 

Account Number Wages ? 

Wages 8 
Tips 

mage? Fringe Benefits 

© 

O 

O 

‘e) 

O 

Wages6 © Other Reimbursements 

oO 

O 

© 

Oo 
Personal information 

There are 10 categories of earnings, so you can itemize 

overtime and incentives. 
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e Click on the Withholding button: 

Withholding Neme | Brown, John J. T 3 

Federal @ Withholding Acct * | 2018/0001 

rice © Amt(228.00  jor{ ‘| % withheta 
Stete © NET Men To withhold ies oe (newt ) 

CD Use Tax Table lec! 0 
Other! QO = ------------- Employer Portion-------------- 
Other 2 © CJ Withhold From Employer 

others amt[ —__—ior Ca F 

Other 4 O NET Men To Withhold 

Other 5S O Expense Account a 

Other 6 O Liability Account 

Wage information Personal information 

Ten withholding deductions can be recorded for each 
employee. Tax Tables are available for progressive taxes. 
Matching employer contributions can be posted automati- 

cally. 

e Click on the Personal Information button: 

Tex Teble informetion 

Federal Stete Locei 

Marital Stetus ($,™,U) 

Payroll Period (,8,$,™,D) 

Allowances (0,1,...,10) 

Withholding 

Employee address and filing status for the Tax Table taxes 

are shown. 

e Click on the DONE button to return to the Employees 
window. 



PAYROLL 
To produce itemized paychecks for just hourly employees: 

e Select Find Name or Number in the Edit menu. A 
dialog box appears: 

String/Number To Locate aaa 

{J Search From Top of List 

(CJ Search Only This Column 

(C) Underline Matching 

CJ Search All Open Windows 

e Click on the Underline Matching check box. 

e Type “hour” into the Sting/Number To Locate edit box: 

String/Number To Locate 

{J Search From Top of List 

(CJ Search Only This Column 

J Undertine Matching 

CD Search All Open Windows 

e Click on the Find String button. The hourly employees 
will be underlined in the Employees window. To keep 

the underlining active, leave the Employees window 
open. 

Employees 

LEARNED LUMBER CO. 
For the month of Feb 1967 

sae # g Setaezscssdsbogsesdogapagegeestesststessess 38 r po 
SEES by 
Sh ee Pa RE TRH Bit 

si Petes BS 3! iat Employee teciitetniceieteie Be 
tisstte: ao voses es Fess ses wecetetashssssstelstiger sss im: 1 Securit 
tists tEStsh3r thts ba sl : + oS 3} tik 

‘Many functions and reports let you use underlining to 
focus on the most important accounts. 
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e Click on the exposed right-hand side of the Main 
window (the one with the icons), to bring it to the top. 

e Click on the Cash Disbursements Journal icon to 
open the Cash Disbursements Journal window. 

e Select Generate Payroll from the Function menu. 

e You will be asked if you’re ready. Click on the Yes 
button. The payroll entries are created in the Cash 
Disbursements Journal: 

‘ 

LEARNED LUMBER CO. Total this Batch 
1245.70 For the month of Feb 

Lia 

20 18/0002 
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e Close the Cash Disbursements Journal (“Checking - 

CDJ”) window by clicking on the Close box. Business 
Sense offers to print the paychecks. 

e Click on the NO button. The General Journal, contain- 
ing the employer FICA contributions is revealed: 

LEARNED LUMBER CO. 
For the month of Feb 1 

February Cost of Goods Sold iF 
February Cost of Goods Sold 

Sam R. David/FICA 

Pete W. Marvin/FICA 

e Close the General Journal window by clicking on the 

close box. 

e Close the Employee list by clicking on the close box. 

CASH RECEIPTS 
Cash sales are recorded in the Cash Receipts Journal. 
Because the cash register at Learned Lumber produces nine 

totals, a shorthand method for entering cash register 
receipts is used. 

e Click on the Recurring Entries icon. The Recurring 
Entries window appears with homemade shortcuts. 

LEARNED LUMBER CO. Ceeer) 
For the month of Feb 1987 Entries 

Taxable = Bidg Materials 

| ___|Taxab! 

Taxable - Plywood 

| {Taxable - Returns & Voids 
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In the menu bar, a new menu Index has appeared to 
locate these shortcuts quickly by name. The Hermosa 

Beach Register is selected. 

e Click on the Generate Entries button. The Macintosh 
beeps. The Cash Receipts Journal is opened, and nine 
lines of entries are created for the nine register totals: 

1400 . 00 Longy iew Dev. Pai 
woreeee eee ee Pee foe wocecece. 

e If you like, you can enter the totals from the register: 

Total Amt of Deposit 
(replaces the $1.00 entry) 

Taxable Lumber 

Taxable Bldg Materials......................0.. 

Taxable Returns & Voids 

Resale Building Materials 

Sales Tax 

eeereseeeeeseeeseoeeee 

The completed entry looks like this: 

e Close the Cash Receipts window by clicking on the 

close box. 



The full version of Business Sense would check this 

transaction to make sure the debits and credits balance. 

Business Sense never lets your books get out of balance. 

CASH DISBURSEMENTS 
You can distribute the amount of a check, deposit, sale or 

purchase to multiple accounts. When you make a multiple 
account transaction regularly, you can automate it with the 

Recurring Entries feature, which should be visible now. 

e Select Monthly Checks from the Index menu to jump 
to the right place in the Recurring Entries window. 

Hermosa Beach Register 

Santa Monica Register 
Depreciation 

Monthly Checks a | 

Subscriber Billing *% 9B 

e Click anywhere on the American Express entry to 
select just that transaction: 

~ 

1 : 
8 

- natn 

Cs ER DRIES 
coos | 72.0) 
Ses Rees! 

ri ee TE 

4100 PEE 

esa 
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e Click on the Generate Entries button. The Macintosh 
beeps, the Cash Disbursements Journal window is 
opened, and the draft check is created: 

LEARNED LUMBER CO. 
For the month of For 1987 

. Marvin/State 

. Marvin/sol 

e Enter the amounts: 

AMOUNT OF CHECK 25st Wooo 238 

(on the left, replaces the 1.00) 

Entertainment #6018 |... 6ec66 su 110 

aS Ge Oil FOO 20 ee cee nck 12 

MN tAVEL TOOUO er eee, 116 “A 

LEARNED LUMBER CO. Total this Batch 
Stelle mdb, 1987 238 .00 

e Click on the Close box. Business Sense will offer to 

print the check. a) 

e Click on the NO button to return to the Main window. 

e Click on the Recurring Entries Close box. 
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REPORTS 
Business Sense produces 52 reports to analyze your 

accounts and manage your company. You can produce 
any of these reports at any time. Reports are generally 
produced on the screen. To print a report, choose Print 
from the File menu. 

e Select Income Statement from the GL Report menu. 
Click on the Include Budget Information button. Click 
on the OK button. After viewing the report, click on the 
close box. 

PSH RC EH Bo a da et 
peta nett i $ f petit gi3s8 

rhe 2 

tHBH ty 

Total Cost of Goods Sold 

Gross Profit 

e Select Department Income from the GL Report 
menu. Scroll with the arrows to department number “1° 
for the Hermosa Beach store, or to “2” for the Santa 

Monica store. For a current month report, click on the 

Feb month button. For year-to-date comparative figures, 
click on the Include Year to Date radio button. Click 
on the OK button. After viewing the report, click on the 
close box. 

Hermose Beach Store 

Total Cost of Goods Sold 

Gross Profit 
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e Select Balance Sheet from the GL Report menu. For a 
year-to-date report, click on the OK button. After 
viewing the report, click on the Close box. 

Accounts Receivable 

Total Current Assets 

Purchases - Luaber 

e Select Financial Ratios from the GL Report menu. 
Click on the OK button. After viewing the report, click 
on the Close box. 

Financial Ratios 

Quick Assets Ratio 

Cash Ratio 

B:0'0:8:wioioio i! 

Return on Assets (in 8) 

Return on Ec 
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e Select Sales Tax from the AR/AP/Payroll Report 
menu. Click on the OK button. The Sales Tax report 
tabulates 10 categories of taxable and non-taxable sales. 

After viewing the report, click on the close box. 

e Select Customer Analysis from the AR/AP/Payroll 
Report menu. Click on the Show Cash Sales activity 
check box. Click on the OK button. Customers are 
listed in order of sales volume. For a pie chart of the 

top customers, choose Graphs in the File menu. After 
viewing the report, click on the close box. 

Customer Analysis 
For 3 months ending 3/31/1987 

Total Customers $52052.00 = 100.00% 

Cash Sales $20687.00 = 39.74% 

Tall Pines Estates $16356.00 = 31.42% 

Allen Contr actors $6700.00 = 12. 87% 

Ocean Front Sales $3900.00 = 7.49% 

O 

a 

# 

| 

ne 
YG All Others $4409.00 = 8.47% 

Feel free to experiment with any of the reports. 

e Help is available by clicking on the Help icon in the 
Main window. 

e To conclude the test drive, choose Quit from the File 
menu. If Quit is dimmed, close the lists, journals and 

reports. 
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DEMO DATA 
The Demo Data and the Demo Program are ideal for 
learning more about Business Sense. Chapter 6: Main 
Window Icons contains step-by-step examples keyed to the 

Demo Data, showing how to post entries in the five 

journals. It’s also a good idea to experiment with the 
Business Sense Demo Program while you study this “ 
manual. = 

You can use the Demo Data with the full version of 

Business Sense, but back up the disk before you do. As 
you pay off invoices, you will be closing them and “using 

up” the data. 



Icons 

Account Numbers 

CHAPTER 3: 
TIPS FOR USERS 

BASIC CONCEPTS 
To get the most out of Business Sense, you should try to 
understand what's going on, rather than memorizing lists 

of instructions by rote. Business Sense has been designed 
to reveal its functions clearly. As you read this manual and 

experiment with the Demo Data, you will start to under- 
stand how Business Sense works. This section presents the 
objects and processes designed into Business Sense. 
Understanding them will give you confidence in using the 
program. 

Business Sense icons represent accounting data. To use the 

data, open the icon by clicking on it. The icon will become 
a window. Close a window by clicking in the close box in 

the upper left corner. 

You can have several windows open at a time. Jump from 
window to window by clicking on a window to activate it. 
For example, if you’re entering invoices into the Sales/AR 
Journal, you can open the Customers window to add a 
new customer without closing the Sales/AR Journal. 

Account numbers come in five flavors: 

: ' Looks lil S ificati 

Vanilla AAAA four-digit number. 

Department AAAA/DD four-digit master account 
/ two-digit department 
number. Always an 

Income Statement ac- 

count. Used for profit and 
cost centers or for job 

costing. 

Customer AAAA/CCCC four-digit master accounts 
receivable / four-digit 
customer sequence 
number. A Current Asset. 
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Customers and 

Vendors 

Lists 

Journals 

3-2 Business Sense 

Vendor AAAA/VVVV four-digit master accounts 

payable / four-digit 
vendor sequence number. 

A Current Liability. 

Sub-Account AAAA/SSSS four-digit summary 
account / four-digit sub- 

account. Used for ac- “ 

counting purposes only, 

to segregate amounts that 

will be summarized in the 
Balance Sheet or Income 

Statement. 

For any account with a slash, create a master or summary 

or “collapse” account with the same first four digits for 
reports. Post only to the sub-accounts, so they can be 
totalled to the summary accounts. 

Customers and Vendors are extensions of the Chart of 

Accts. The accounts listed in the Chart of Accts, Customers 

and Vendors windows are all part of the complete chart of 
accounts. That’s why all three lists have the same icon. 

There are three lists of accounts: Chart Of Accts, customer 

and Vendors, plus lists of Employees, Departments and 
Tax Tables. The lists are manipulated by the same program 
modules, so they behave similarly. Consistency between 

lists means that what you learn about the behavior of one 

list can be leveraged to all of them. Most lists store addi- 

tional data for each line, accessible through a “More” tab. 
Add new lines at the end of the list, and Business Sense 

will sort the lines into sequence. 

There are five journals. All transactions are recorded in 

journals. 

Jourmal Used For 
Sales/AR Charge sales 

Cash Receipts Cash sales | 

Purchases/AP Charge purchases a) 

Cash Disbursements Cash purchases and expenses 

General Depreciation, transfers, misc. 



Transactions 

Single-entry 
Transactions 

A transaction or entry consists of one or more lines in a 

journal window. The date appears only on the first line of 
a transaction and marks the beginning of that transaction. 
Each transaction is checked for balance, and unbalanced 

transactions are rejected. Each new line starts with a 

proposed amount that will balance the transaction. 

The cash journals are single-entry. The Cash Disbursements 

Journal credits the Cash account and the Cash Receipts 
Journal debits Cash. The cash journals use an abbreviated 
format that simplifies cash transactions. A simple transac- 
tion will fit on one line. With multiple lines you can distri- 
bute a transaction to as many accounts as necessary. If you 
use multiple lines for a transaction, date only the first line. 

LEARNED LUMBER gee Total this Batch 
ror = es = = 87.00 

Record the total cash amount on the first transaction line 

on the left side of the journal window. Distribute this 
amount to one or many Income Statement accounts and 
amounts on the right side of the window. Discounts 

deducted from the cash amount are flagged in a separate 
column with a pound sign, or you can enclose the amount 

in parentheses. 

Chapter 3: Tips 3-3 



Double-entry 
Transactions 

Multiple-Line 
Transactions 

3-4 Business Sense 

The other three journals, Sales/AR, Purchases/AP and the 
General Journal, record the debits and the credits on 

separate lines. 

General Journal 

In the Sales/AR Journal, the first line debits the customer 

accounts receivable account for the invoice total. The 

following lines credit revenue accounts for the line items. 

In the Purchases/AP Journal, the starting lines debit 
expense accounts for invoice line items. The last line 
credits the vendor accounts payable account for the “A 
invoice total. 

In the General Journal, you can debit and credit any 

accounts. 

These non-cash journals always have two or more lines per 

transaction. Remember to date only the first line of a 
transaction. In the non-cash journals, you enter debits and 
credits in side-by-side columns. You can enter a debit or 
credit in any line. Since there’s one account per line in a 
non-cash journal, you can’t have both a debit and a credit 

on the same line. Enter a negative number in parentheses, 
or put it in the other amount column. . 

Business Sense uses the date as a code to mark transaction 

boundaries. If you date every line, you’ll be told that your 

transactions don’t balance. “y 

Sometimes you need more than one line of description. 
You can generate another line by pressing the Return key. 

Enter the continued description on that line. Use the same 
account number so the continued description will follow 



Posting 

the line above everywhere it goes, and zero the amount in 

the all lines but the last: 

| Seite ee. : ' = Sg Si ee Se 

Capital Stook LEARNED LUMBER CO. Total this Batch 
For the month of Feb 1967 1000 .00 : 

[iDate, vet Amt of, 1 Recetved From /Desoription, GE [Account © POT | Amount | 

Business Sense allows you to modify or delete new 

transactions while the journal window containing them is 
still open. When you close the window, the new transac- 
tions are posted and become permanent. If you watch 
closely, you can see the ruling line under each entry get 
darker as it’s posted. 

Sales/AR 

igeteieS 

EE EE ee 

oe 

eee e- 

Peers Cee eee eee eee reer ee eee eres POPC eee ere SEPeeeeeereeee SICCeCeeTeereees Pee eee TT Te 

ec eee See eee ee eee ee eee eee eee OPO eee e ees COUCeUSCESLOeY (See erereerereee Serer r ee eee ere 

Peers Cee eee eee eee eee eee eee ee ec oes OCC eOCEeeI ee SEePeereereres SECC eeeereererey (errr eer eer errs 

ere errr reer rere ree ee eee ee eee eee eS COPE Cereerers COUCU ELEC e TOES Pee ere eee eereee Pere ee ee ree er ee 

ers Coe ee eee ee eee eee eer ees COUT e eee eee SESEEECOECCSES SECC eereeey ere rer rere eres 

Toe eeee See eee eee eee eee eee eee eee POPPE reer ees Cee ee eeeeCees) CeCe ere eeeerees, Serer r ee eee eee es 

You cannot modify or delete a transaction after it is posted. 
To adjust a transaction after it has been posted, click on it 
to select it, then use Fix/Adjust Entry from the Function 
menu to generate an adjustment. 
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Closing the Books 

Reports 

3-6 Business Sense 

In the bad old days, computer accounting programs 
required you to close the books at the end of each month. 

Business Sense keeps the books open all year for all 

months, so you can begin entering data for a new month 

before you’ve finished adjusting the prior month. If a 
revision appears, you can enter it and reprint the Income 
Statement, Balance Sheet and other reports to reflect the ‘a 
change. “3 

At the end of the year, you do have to close the books. At 

the end of the calendar year, payroll, sales tax, customer 

history and vendor history data will be reset for a new 

year. At the end of the fiscal year, journals are cleared, and 

a new trial balance is automatically brought forward into 
the General Journal. These processes preserve information 

about open customer and vendor invoices. 

To close the calendar or fiscal year, prepare by bringing 
your transactions up-to-date. At the end of the year, stop 

entering new transactions until you have completed work 
with the old year’s data. Collect last minute transactions, 

post adjusting and periodic entries and print reports. Check 
the reports for accuracy and completeness. Copy your data 

disk twice to make a backup and a disk for the new year. 
After you run the new year process on the copy, you can “ry 

begin entering new transactions. If your fiscal year begins 
in January, run the New Calendar Year and then immedi- 

ately the New Fiscal Year. 

Make liberal use of the reports from Business Sense. 

Besides adding efficiency in keeping the books balanced, 
computerized accounting makes essential management 

information freely available on an up-to-date basis. 

Review Appendix D: Report Catalog with management 

personnel to select relevant reports. All reports are avail- 

able at any time, so you may decide to produce some 

reports more frequently than before. You can use underlin- 
ing in lists to produce selected reports focussing on the 

most important accounts. 

Most reports offer dating options. You can select any eo) 

month or any range of months. The most interesting date 

ranges are the current month, current quarter to date, past 

three months, and year to date. 

Save monthly printouts of all five journals and the Trial 
Balance, for backup and reconstruction purposes. 



Reports are prepared by opening an icon (for example 

Sales/AR, or General Journal) or by selecting one of the GL 

Report menu or AR/AP/Payroll Report menu selections. 
The report will generally appear on the screen first. Then 

you can print it by selecting Print in the File menu. The 
report name is underlined in the menu if it can be either 

& graphic or tabular. 

Underlining You can underline multiple lines in the Chart of Accts, 
Vendors, Customers or Employees windows. Underlining is 

used to select groups of records for processing. Underlin- 
ing in the Vendors window lets you Select AP Payments for 

certain vendors. Underlining in the Employees window lets 

you Generate Payroll for selected early checks. You can 

Print Mailing Labels for a list of underlined customers. 

Functions and reports sensitive to underlining are listed 

under Find Name or Number in Chapter 7: Pull-Down 
Menu Commands. 

ERROR CHECKING 
Business Sense uses error checking to keep your records 
consistent and logical. The program detects errors when 

& you post transactions, so you can correct errors while you 

sull have the source documents at hand. This will keep 

you from having to hunt through pages of entries later to 

find an error. The books are always in balance. You are 

stopped from accidentally invalidating your data. 

Business Sense will report the following errors: 

Entry out of Balance As you enter a transaction, it will be out of balance until it 

is complete. 

When you close a journal window, Business Sense will 

check whether each transaction is in balance before 
posting that transaction. If a transaction is out of balance, 
Business Sense will stop so you can balance it before 
continuing. To find the balancing amount, Insert a Line at 
the end of the transaction and press the Return key to 

& move onto the blank line. Business Sense will show you 
the balancing amount. 
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Non-Existent Account If you try to post to an account number that does not 

appear in the Chart Of Accts, Customers or Vendors lists, 
Business Sense will stop so you can fix the problem. 
Correct the account number, or jump to the Chart Of Accts, 

Customers or Vendors list and add the new account. Then 
try to close the journal again. 

Post to Summary Summary accounts are for reporting purposes only. You “" 

Account must post to the detail accounts. 

Delete Active You may not delete an account if it has activity in this 
Account Fiscal Year. You will be able to delete it after the New 

Fiscal Year, if its balance is zero. 

Adjust Closed Invoice Fix/Adjust Entry in the Function menu will dim all radio 

buttons for an invoice that has been paid. This is intended 
to remind you to check the AR Aging or AP Aging report, 

or Customer or Vendor Ledger Card. 

Credit Limit Business Sense will warn you when a customer exceeds 
the credit limit you have established. Then you can choose 

whether to cancel the invoice or issue it anyway. “wy 

Missing Tax Tables If an employee’s earnings or filing status fall out of the Tax 
Entry Tables, you will be notified. You should delete the Cash 

Disbursements and General Journal entries for that person 
or payroll, fix the Tax Tables and regenerate the payroll. 

OPERATING TECHNIQUES 
Selecting and Editing A More tab or pointing-hand tab extends from a list or 

journal window, showing which line is current. The current 

field has reversed polarity (white characters on black) 
when first selected, indicating that the complete field 

contents are selected and replaceable. Click on the field 
again, and the field will change to normal video with a 

flashing vertical insertion point between characters. The 
insertion point lets you insert a few characters without re- 
typing the whole field. To delete characters, use the ‘a, 
Backspace key or select part of the field by dragging with 

the mouse pointer and type or backspace. 

You can edit almost anywhere. 
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Journal Entries 

& Dialog Boxes 

Default Entries 

Balancing Amount 

Expressions 

Use the Tab key to go to the next field in the same line. 

Use the Return key to go down a line. Use Shift-Tab to go 
left and Shift-Return to go up. If your keyboard has arrow 

keys, you can use them as well. 

Use the Tab key to go to the next field. Use the Return key 
to go to the next account record. You can use Command- 

digit to select radio buttons. 

SHORTCUTS 
Sometimes Business Sense is pretty sure what you'll type 

next, and guesses by filling in some fields when a new line 

is started. If the guess is wrong, typing into the field will 

replace the guess. 

Today’s date is the best guess for dating a transaction, so 
Business Sense will supply it when you Tab past the Date 

field in a journal. If you’re entering a lot of transactions 
with the same old date, use Set Date in the Function menu 

to tell Business Sense today’s that day. 

The next check number in sequence and the next invoice 

number in sequence are good guesses. Simply Tab over 

these fields to let Business Sense fill them in. You have to 
supply the starting numbers the first time you use the 
journals. Thereafter Business Sense will keep track. 

The descriptions for a double-entry transaction are often 

the same for both parts, so Business Sense generalizes this 
observation. It copies the description, check number and 
invoice number into every subsequent line of a multiple- 
line transaction. 

Sooner or later you’re going to balance your transaction, so 
Business Sense guesses it will be now. The program shows 

the balancing amount every time it generates a new line. 

In the Purchases/AP Journal, vendor terms are often given 

in days. To enter the Due Date, you can type “+30” to 

indicate 30 days after the invoice date. 

You can enter multiplication expressions, using * or @ to 
mean multiplication for money amounts. For example, type 
1.5*12.72 to calculate overtime wage rate, .02*129.95 to 
take a 2 percent discount, or 12@495 to price a dozen 

units. 
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Account Name to Type the first few letters of the account name, and Tab to 

Number the next field. Business Sense will find the first account in 
the Chart of Accts, Customers or Vendors list that matches 

your typing. The program will replace the letters with the 
account number, and will show the Account Description or 

Customer or Vendor Name in the top left corner of the 
window. Look at the name to make sure the proper 
account was found. 

Think about this feature when you name your accounts. If 

several accounts begin with “Accumulated depreciation - 

...,” you won't be able to use this lookup feature, and the 
account names will be ambiguous when they appear in 
short windows. Abbreviate at the beginning of account 

descriptions. Use “Rev-...” for revenues, “AccDepr-...” for 
accumulated depreciation, something short and sweet. 

Window Lookup To look up an account number for a journal entry, jump to 
the Chart of Accts, Customers or Vendors window. Click 

on the account to select it or use Find Name or Number 

from the Edit menu. Click on the Account To Journal 

button in the upper right-hand corner of the window, and 

the account number will be transferred to the journal. 

Keyboard Menu You can use the Command-key shortcuts listed in the 
Shortcuts menus rather than dragging the menu down to select the 

command. Photocopy Appendix B: Menu Quick Reference 
so you can have the list in front of you. 

You can type Command-key shortcuts as fast as you like. 

The most useful Command-key shortcuts are: 

e Complete Invoice Command -minus 

e Insert a Line Command-I 

e Delete a Line Command-D 

e Repeat Search Command-A 

e Close Command-W 

e Print Command-P 

Insert or delete multiple lines by counting to yourself as 

you press the keys. 

To quit the program, use Command-W several times, then 
Command-Q. Business Sense will stop on any posting 
error. Otherwise you will arrive at the Finder, ready to 

back up your data. 
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Company Data folder 

RECURRING ENTRIES 
Recurring Entries are the key to efficiency and accuracy. 
They’re ideal for frequent or complex transactions. If you 

ignore the Recurring Entries feature, you’re missing half the 
fun. You can enter long transactions with a click. You 

could do your whole subscriber monthly billing with one 

click. 

Recurring Entries allow you to customize your Business 

Sense system to your individual company’s needs. Recur- 

ring Entries are easy to create. Chapter 6: Main Window 
Icons shows how. 

When you see a laborious or repetitive transaction, print it 
out and use it to make a Recurring Entry. Layout sheets are 

printed in Appendix G. Feed in the transactions you want 
and name them. You can bang them into a journal with 
one click. 

Recurring Entries give you a chance to improve your 

procedures and to generate more comprehensive manage- 
ment data with less work. Recurring Entries and the 

modifiable Help system give you the ability to customize 

Business Sense for a chain or franchise operation. 

FILES 
The Company Data folder contains a set of ten files named 
CO DATA 01, CO DATA 02, ..., CO DATA 10. These files 

contain your accounts and journals, and are tightly linked 

together. They are designed to be a set of compatible files, 

and you shouldn’t mix files from one set with files from 

another. They have generic names so you won’t be 

tempted to replace one of your files from an old backup 

copy. Replacing one of these files from another set would 
be like mixing together newspapers from two different 
days. When you would turn to page 28 to continue a story, 

you would find the wrong stories, and nothing would 

make sense. 

There are several named files in the Company Data folder 
as well. You’re told their names because it’s OK to mix and 
match these files with other sets of your company data, or 
with other branch offices or companies. The Tax Tables, 
Help and Recurring Entries files are particularly useful to 
share this way. The Reports, Cash Template and Pics files 

are also transferrable, but less interesting. 
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Extension Files 

3-12 Business Sense 

There are two programs in the Company Data folder. The 

W2-1099 Initializer and the Import D&S programs are used 

when you’re setting up your accounting system, and can 

be removed from the Company Data folder after you’re set 
up. 

When a journal accumulates more than 2,000 lines, it gets “Ye 

too cumbersome for one file, so it splits into two. The ; 
original journal spins off an extension file. Extension files 
have parenthesized numbers after their names, like “CO 
DATA 07(101)”. They are essential parts of your data file 

set. 

DATA SECURITY 
Take steps to prevent unauthorized modifications to your 

data. The best way to assure this is to keep your Business 
Sense data on a floppy disk which is put away when not in 
use and locked up at night. 

If your data resides on a hard disk, then protect it with 
passwords. Hard disk data can be accidentally erased even 

without the password, so you must make backups regu- 
larly. Passwords have drawbacks: forgetting the password 
could render your data inaccessible, and disclosing it could > 
lead to misuse. 



Installing with Two 
Floppy Disks 

CHAPTER 4: 
STARTING YOUR 
ACCOUNTING SYSTEM 

BALANCE THE BOOKS 
You can’t count what you don’t know, and you can’t 

computerize it either. First, bring your books up to date 
and resolve questions. You can fix the problems later, but 
retroactive adjustments are complex and tedious. Experi- 

enced users say that cleaning up the books before convert- 
ing to the computer is easier. 

The Trial Balance report will be your basic starting point 
for installing Business Sense. 

ORDER PRINTED FORMS 
Turn-around time for printing your checks, invoices and 
Statements will dictate that you order them immediately. 
For information on ordering, refer to Appendix A: Source 

for Pre-Printed Forms. 

INSTALL BUSINESS SENSE 
Installing the software is a simple process of making 

working copies of the Business Sense program and the 

Company Data folder. You will be working with the 
Macintosh Finder program. Start the computer, and wait for 

the Finder, also known as the Desktop, to appear. If your 
computer has a hard disk, skip to the next heading “Install- 
ing with a Hard Disk.” 

e Insert the Business Sense Master Program disk. 

e Turn on the computer. 

e Obtain two floppy disks. 

e Label the first “Business Sense Working Program,” and 

the second “Business Sense Working Data.” 

e Insert the Business Sense Working Program disk. 

e Change its volume name to “Business Sense Program.” 

e Copy the Business Sense Master Program disk onto the 
Business Sense Working Program disk by dragging the 
Master disk icon to the Working disk icon. The Finder 
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Installing with 
a Hard Disk 

4-2 Business Sense 

will ask if you want to completely replace the contents 

of the working disk with the contents of the master disk. 
You do. 

Eject both disks with Command-Shift-1 and Command- 
Shift-2. 

Insert the Business Sense Master Data disk. 

Insert the Business Sense Working Data disk. 

Change its volume name to “Business Sense Data.” 

Copy the Business Sense Master Data disk onto the 
Business Sense Working Data disk by dragging the 

Master disk icon to the Working disk icon. The Finder 
will ask if you want to completely replace the Working 

disk with the contents of the Master disk. Click on the 
Yes button. 

Put the Master disks away for safekeeping. 

If you have a hard disk, you already have a System and 
Finder. It would be a mistake to copy the System folder 
from Business Sense to your hard disk. 

Turn on the computer. 

Insert the Business Sense Master Program disk. 

Copy the Business Sense program onto your hard disk 

by dragging the program icon from the floppy disk 
window to the hard disk icon. 

The Business Sense program should be in the “root” 
directory of your hard disk, the one you see when you 

open the hard disk icon. 

Open the hard disk icon to see if it’s there. 

Decide whether to keep your data on the hard disk or a 
floppy disk. If you keep your data on a floppy disk, you 
have more security and privacy. If you keep your data on a 

hard disk, you get more speed and capacity. If you’re 

undecided, use a floppy disk. 

If you decide to keep your data on a floppy disk: 

Eject the program disk with Command-Shift-1. 

Insert the Business Sense Working Data disk. 

Change its volume name to “Business Sense Data.” 

Insert the Business Sense Master Data disk. 

Copy the Business Sense Master Data disk onto the 
Business Sense Working Data disk by dragging the 
Master disk icon to the Working disk icon. The Finder 



Assign Account 

Numbers 

will ask if you want to completely replace the working 

disk with the contents of the master disk. Click on the 

Yes button. 

e Put the master disks away for safekeeping. 

If you decide to keep your data on the hard disk: 

e Eject the program disk with Command-Shift-1. 

e Insert the Business Sense Master Data disk. 

e Copy the Company Data folder to the hard disk by 

dragging the folder icon from the floppy disk window to 
the hard disk icon. 

e Your Company Data folder should be in the “root” 
directory of your hard disk. 

e You may rename this folder, but do not change any file 

names inside the folder. 

e Put the master disks away for safekeeping. 

e Later, set passwords according to the instructions in the 
Company Info Section of Chapter 6: Main Window 
Icons. 

e If you intend to keep books for multiple companies on 
your hard disk, see the Multiple Companies Section of 
Chapter 8: Tips for Advanced Users. 

COMPANY INFO 
Start the Business Sense program. Open the Company Info 
icon. Enter your company name, address and federal and 

State employer identification numbers. 

Be sure to enter the first month of your fiscal year before 
you Start posting transactions. 

GENERAL LEDGER. 
You can assign the same account numbers that you are 

already using. Accounts are stored and printed for the 
Income Statement and Balance Sheet in sequence by 
Account Type and then Account Number. If you assign 

account numbers in Account Type sequence, then your 
Income Statement and Balance Sheet will be printed in 
Account Number sequence. 
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Departments and 
Cost/Profit Centers 

4-4 Business Sense 

Here’s a numbering scheme that corresponds to the 
accounts on the Demo Disk: 

Number 

Range ___itypeCode_ Accounttype sss AppearsOn 
1010 Cash Cash (checking account) Balance Sheet 

1011 to 1499 CA Current Assets Balance Sheet 

1500 to 1599 Inventory Inventory Balance Sheet “ey 

1600 to 1899 FA Fixed Assets Balance Sheet —3 

1900 to 1999 OA Other Assets Balance Sheet 

2000 to 2499 CL Current Liabilities Balance Sheet 

2500 to 2899 LL Long Term Liabilities Balance Sheet 

2900 to 2999 OL Other Liabilities Balance Sheet 

3000 to 3099 Equity Equity (Capital) Balance Sheet 

3100 Close Close Account Balance Sheet 

4000 to 4499 Revenue Revenues Income Statement 

4500 to 4999 Returns Returns and Allowances Income Statement 

5000 to 5999 CGS Cost Of Goods Sold Income Statement 

6000 to 6999 Expense . Expenses Income Statement 

7000 to 7999 OINC Other Income/Expense Income Statement 

Any number ranges that follow the same Account Type 

sequence will work just as well. 

Departments name the parts of your business. In the Dem 
Data, the departments are store locations. Tracking their 
individual profits is an important management control 

function. 

Department numbers are used for Income Statement 
accounts only. For each major Revenue, Returns, Cost of 

Goods Sold and Expense account number, there’s a 
summary account for reporting, and detail accounts for 
posting transactions. Here are the Revenue accounts in the 
Demo Data: 

Account Number Description 

Summary 4010 Total Lumber Sales 

Detail 4010/01 Lumber Sales—Hermosa Beach Store 

Detail 4010/02 Lumber Sales—Santa Monica Store 

Summary 4020 Total Building Materials Sales 

Detail 4020/01 Bldg Mat’ls Sales-Hermosa Beach Stor 

Detail 4020/02 Bldg Mat’ls Sales—-Santa Monica Store “ 
Summary 4030 Total Plywood Sales 

Detail 4030/01 Plywood Sales—-Hermosa Beach Store 

Detail 4030/02 Plywood Sales—Santa Monica Store 

Similar sets of accounts are set up for Returns, Cost of 

Goods Sold and Expenses. 



Product Lines 

Project/Job Costing 

Product lines can be managed as if they were departments. 
The three master accounts in the Demo Data, for lumber, 

building materials and plywood, are itemized in the 
Income Statement. If there were only one store, these 

product lines could have been defined as departments 
under summary accounts. Then Department Income 
Statements would be printed to review product line 
profitability. 

Account Number Description 

Summary 4010 Total Sales 

Detail 4010/01 Lumber Sales 

Detail 4010/02 Building Materials Sales 

Detail 4010/03 Plywood Sales 

Projects and jobs come and go. The department names can 

change with them. To produce Department Income 

Statements for projects or jobs, allocate a block of depart- 
ment numbers, and create a permanent block of Revenue 
and Expense accounts with generic descriptions. After a 
job is completed, replace its name in the Departments list 
with a new job name. The accounts will already be in 

place: 

Dept No. Department Name (changes) 

01 (nactive - will be reused) 

02 Green Remodeling 

03 Black Addition 

04 White House 

05 (Inactive) 

Account __Number___ Description (stays the same) _ 
Summary 4010 Total Revenue 

Detail 4010/01 Project 1 Revenue 

Detail 4010/02 Project 2 Revenue 

Detail 4010/03 Project 3 Revenue 

Detail 4010/04 Project 4 Revenue 

Detail 4010/05 Project 5 Revenue 

It’s difficult to start using departments during the year 

because you can’t convert plain accounts to departmental 
summary accounts after posting to them. Start with a few 
departments, then add more departments and correspond- 
ing accounts as you need them. 
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Sub-Accounts You can create sub-accounts which will be summarized in 

the Income Statement or Balance Sheet. Here’s an example 

from the Demo Data: 

Account Number Description 

Summary 2018 Federal Payroll Taxes Payable 

Detail 2018/0001 Federal Tax Withheld 

Detail 2018/0002 FICA Payable 

Some users like to indent the Descriptions .of sub-accounts 

with leading spaces. 

Enter Chart Open the Chart Of Accts icon and type in your list of 
of Accounts accounts. Abbreviate the Account Type field. Make sure 

you have a master account for each group of departmental 
or sub-accounts. To have accounts sorted into sequence, 
close the window and reopen it. Print the list by choosing 
Print from the File menu. 

If you are going to have Accounts Receivable, open the 

Customers icon and look at the Accounts Receivable 
information. If you change the master Accounts Receivable 

account number, change it for all the accounts in the 
window. “wy 

If you are going to have Accounts Payable, open the 
Vendors icon and look at the Accounts Payable informa- 

tion. If you change the master Accounts Payable account 

number, change it for all the accounts in the window. 

Enter Beginning After you enter the Chart Of Accts, establish the beginning 
Balances balance in each account. Using the General Journal, enter a 

single gigantic transaction embracing the entire trial 

balance report. In this transaction, enter the total Accounts 
Receivable amount into the temporary AR account number 

1059, and the total Accounts Payable amount into the 
temporary AP account number 2059. Redistribute these 
amounts to the individual customer and vendor invoices 
when you enter the detailed receivables and payables later. 

Set Sales Tax Codes Business Sense will tabulate sales and sales taxes for cash 

and credit sales. To start using this feature immediately, 
choose Set Sales Tax Codes in the Function menu. 
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INVOICING AND ACCOUNTS RECEIVABLE 
Cash Method Option Smaller companies often keep books using the cash 

method of accounting. The cash method doesn’t use 

accounts receivable accounts. This eliminates the need for 

a Customers list and Sales/AR Journal. Delete the Custom- 

ers accounts or ignore the icon. Post customer invoices ° 

Y& when paid to the Cash Receipts Journal. 

Invoicing Option Printing invoices is offered as an option each time you 
close the Sales/AR Journal. Sales entries are very similar 

with or without invoicing. 

If you don’t print invoices, you can summarize sales line 

items, but you'll still use multiple lines to distribute a sale 

to taxable and non-taxable or to product-line Revenue 
accounts. Make a Recurring Entry to speed your work. 

You can begin printing invoices at any time by entering 

the line items instead of summary lines. Include the 
purchase order number in the first line description and 

quantities in the line item descriptions. You can invoice 
some customers with Business Sense and others manually 

by batching together the invoices which the computer will 

& print and formatting them appropriately. 

Accounts Receivable Whether you have a folder of open customer invoices, 

Listing customer ledger cards or a computer listing, you should 
comb through your accounts to verify the status of invoices 

before entering them in the computer. 

Assign Customer List your customers alphabetically and assign them four- 
Numbers digit sequence numbers. Leave gaps between numbers you 

assign, SO new customers can be added in alphabetic 
sequence. One way to do this is to assign the middle 

customer in the list to customer number 5000. Then 

progressively subdivide the customers into thousands, 
hundreds and tens. 

Chapter 4: Starting Your Accounting System 4-7 



Enter Customer Data 

Enter Open Invoices 

Cash Method Option 

Pay from Chart of 
Accts Option 

4-8 Business Sense 

The Customers icon already contains a master accounts 

receivable account and a sample customer. 

Add customers at the end of the Customers list. When you 

close the window, Business Sense rearranges the accounts 

numerically. 

Fill in the “More” information for the customers. You could 

put in all the addresses one day and the credit limits “ 
another day, since you can scroll through the More Infor- 

mation screens by clicking on the arrows or the NEXT 

button. 

Enter the open customer invoices into the Sales/AR Jour- 
nal. Use two lines per invoice. On the first line, enter the 

invoice date, the invoice number and invoice amount. 

Debit the customer account. On the second line, credit the 

temporary AR account. 

If any invoices are open from the prior fiscal year, date 

them with the first day of the current fiscal year, and enter 
a description like “Carried forward from Sep 25.” 

After you’ve entered the open invoices, reconcile the 
temporary AR account. To get a printed listing, run an 

Account History. “A 

Now you'll be able to prepare an Aged AR report, send out 

meaningful Billing Statements and apply payments prop- 

erly to the customer invoices. 

ACCOUNTS PAYABLE 
The cash method of accounting doesn’t use accounts 

payable accounts. This eliminates need for a Vendors list 
and Purchases/AP Journal. Delete the Vendors accounts or 

ignore the icon. Post vendor invoices when paid to the 

Cash Disbursements Journal. You can still have Business 

Sense print the checks. 

You can address checks directly from the Chart Of Accts 
by entering Default Address and Alternate Addresses in the 

More Information screens associated with the accounts. If “ 

you do this, you can pay a bill in one step. 

Another choice is to enter all bills into the Purchases/AP 
Journal and pay them with Select AP Payments in the 
Function menu. This helps you forecast cash requirements 

and gives you a more realistic AP Aging report. 



we Option 

Accounts Payable 
Listing 

Assign Vendor 
Qumbers 

Enter Vendors Data 

You can “go down the middle” on this choice. Pay bills 
which are due immediately using the addresses in the 

Chart Of Accts. Enter bills with a future due date into the 

Purchases/AP Journal. 

Some companies go further in forecasting their cash 

disbursements by entering purchase orders into the 
Purchases/AP Journal as soon as they’re issued. This has 
the advantage of tracking the order from start to finish. 

Overbilling, short quantities and late shipments cause 
adjusting entries that document vendor performance. Some 

companies find this method too conservative and say it 
overstates their accounts payable. 

Whether you have a folder of open vendor invoices, 
vendor ledger cards or a computer listing, you should 

comb through your accounts to verify the status of invoices 

before entering them in the computer. Reconciling with 
vendor statements is good. 

List your vendors alphabetically and assign them four-digit 

sequence numbers. Leave gaps between the numbers you 
assign, SO new vendors can be added in alphabetic se- 
quence. 

The Vendors icon already contains a master accounts 

payable account and a sample vendor. 

Add vendors at the end of the Vendors list. When you 
close the window, Business Sense rearranges the accounts 

numerically. 

Fill in the “More” information for the vendors. You could 

put in all the addresses one day and the discount terms 
another day, since you can scroll through the More Infor- 

mation screens by clicking on the arrows or the NEXT 
button. 
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Enter Open Invoices 

When to Begin 

Payroll Summary and 
W-4 Information 

Assign Employee 
Numbers 

4-10 Business Sense 

Enter the open vendor invoices into the Purchases/AP 

Journal. Post two lines per invoice. On the first line, enter 
the invoice date and due date, invoice number and 

amount. Debit the temporary AP account. On the second 
line, credit the vendor account. 

the invoice date and due date to the first day of the curre 

fiscal year, and enter a description like “Carried forward ™ 
from Sep 25.” 

If any invoices are open from the prior fiscal year, voure 

After you’ve entered the open invoices, reconcile the 
temporary AP account. To get a printed listing, run an 

Account History. 

Now you'll be able to prepare an AP Aging report and 
itemize payments by vendor invoice number. 

PAYROLL 
You can continue using your present method of preparing 

the payroll while implementing the other Business Sense 
modules, and convert payroll processing later. 

To enter a payroll service statement, consult the General 

Journal Section of Chapter 6: Main Window Icons. You 

could make similar entries in the Cash Disbursements AY 
Journal if the money comes from your checking account 
instead of from a payroll deposit account. 

If you use Business Sense to issue the individual pay- 

checks, you should start using the automatic payroll 
features immediately. 

You will need an up-to-date listing of employee wage 
rates, deductions, addresses, year-to-date earnings and 

year-to-date withholding. 

Employee ID is a four-character combination of letters and 
numbers. If you produce paychecks in more than one 

cycle, code the payroll cycle into the employee ID. 

If you assign Employee ID’s in last name sequence with 

gaps for new employees, the Employees list will be in ID 
sequence as well as in alphabetic sequence by name. 



Enter Tax Tables 

Enter Employees 
Wages Information 

Enter Employees 
Personal Information 

Enter Employees 

Withholding 
Information 

Survey the Employees data to determine what filing status 

combinations are actually used. You may not have to enter 

all the possibilities. If you overlook a tax table entry, 

Business Sense will stop and notify you. 

If you enter the Tax Tables systematically, the process is 

very fast: After you enter a line for a given filing status, 

press the Return key. The new line will nearly duplicate 

the old one, except the two columns “At Least” and “But 
Less Than” will be increased based on the range defined in 

the prior line. Use the Tab key as necessary to change 

other fields. 

To see the information in sequence, close the window and 
reopen it. Use Print from the File menu to print a review 
listing. 

Scroll through the “More” information screens with NEXT 

or the arrows to enter Wages1 pay and the payroll ex- 

pense account. Enter the total year-to-date gross wages on 

the Wages1 screen. After you enter the initial year-to-date 

earnings, that field will disappear, so check your work as 
you go. Enter the standard hours for hourly employees. 

You can use the additional Wages screens to itemize 

Overtime, premium pay and incentives. Use multiplication 

to enter the premium rate based on the regular rate, like 
this; 1:5°7.75: 

Another use for the additional Wages screens is to itemize 

departmental labor costs or job costs. Enter the expense 
account numbers now, or wait until you enter the time 

cards. 

Enter the addresses and tax table information by scrolling 
through the employees with the NEXT button or the 

arrows. 

Enter the Withholding Information for each employee. It 
will be faster to enter Federal withholding for all the 

employees, then FICA for all, and so on. 

As you enter the Withholding information, also enter the 
initial year-to-date withholding. After you enter this figure, 

the field will disappear. Print W-2 Forms on plain paper to 
review the year-to-date information. 
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W2-1099 Initializer If you need to revise year-to-date earnings or withholding, 

use the W2-1099 Initializer program, found in the Company 
Data folder. From the Finder, open the Company Data 
folder by double-clicking on it. Then start the W2-1099 
program by double-clicking on it. 

The W2-1099 Initializer does not generate accounting 

transactions. It adjusts internal year-to-date totals to reflect “ 

earnings and withholding not calculated by Business Sense. ™ 
This ensures that W-2 Forms and 1099 Forms will be 
accurate. Although the program has radio buttons for 

selecting months, the entire amount may be entered for the 
first month. 

BUDGETING 
Small and medium-sized businesses often think budgeting 
is too hard to do. Modern spreadsheet programs make it 
easier to model your business, and you may find it practi- 
cal to begin budgeting now. It’s easier to forecast overhead 
if you use a spreadsheet to break it into components such 

as rent and telephone. 

You can enter a budget anytime, or revise it anytime. You 

can produce Income Statements with or without budget 

comparisons, so you can try budgeting without embarrass- “ 
ment. See the Enter Budget Information command in 

Chapter 7: Pull-Down Menu Commands. 

If you’re not responsible for setting budgets, print a blank 

budget report for the budgeter, so you’ll get the informa- 
tion in the form you want. Budget amounts are often the 

same for every month; in that case, only the first month’s 
budget needs to be filled in. Another way to get started is 

to use Write to File in the File menu to export your Chart 
Of Accts to a spreadsheet program. 
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CHAPTER 5: 
USING BUSINESS SENSE 

STARTING BUSINESS SENSE 
If you are using floppy disks, insert the Business Sense 

Working Program disk in the internal disk drive. 

If your data is on a floppy disk, insert your data disk into 
the other drive. 

Turn the Macintosh on. After a few seconds, the Finder, or 

Desktop, will appear: 

" & File Edit View Special : 

Business Sense™ Master Prog 

Business Sense™ Maste 

The two icons of interest are: 

e Business Sense. the program icon. 

e Company Data, the folder of data files. . 

Double-click on the Business Sense program icon, or select 

it and choose Open from the File menu. Business Sense 
will start, will locate the Company Data folder, and will 

display the title screen, as shown on page 5-2, for a few 
seconds. 
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5-2 Business Sense 

Click the mouse to proceed immediately. In any case, in a 
few seconds the title screen will be replaced with either 
the password dialog or the Main window. 

If you have set passwords, a dialog box will appear: 

Please Enter Your Password and hit return 

aaa 

Type in a password and press the Return key. You will get 
a second try if you make a mistake. If the second attempt 

fails, the program will return to the Finder. 

When you have entered the password, you will see the 
Main window and the pull-down menus: 

é@ File Edit Function Gl Report AR/AP/Payroll Report 

LEARNED LUMBER CO. 

Og £ & ©. 
a & 

Reourr ing Entries General Journal 



Control Log 

When the Main window appears, you can begin working 

with your data. Chapter 6: Main Window Icons explains 
how to use each icon. Chapter 7: Pull-Down Menu Com- 

mands discusses each of the menu choices. 

ENDING A SESSION 
Don’t shut off your computer while Business Sense is still 
running! Some new transactions might be lost. Worse, your 

data files could be left partially updated, forcing you to 

restore the data from your backup files. 

Before you stop, check your results. You should keep track 
of total checks and deposits and total receivables and 
payables. Keep a control log showing the status of the data 

and which batches of entries have been made, to be sure 

nothing has been lost, overlooked, entered with the wrong 

amount or posted twice. If anything should go seriously 

wrong with your data, the control log will show which 

backup disks were created when, and which transactions 

should be entered again to re-establish current and consis- 

tent files. 

Using a control log is like auditing as you go: 

e Run a tape of the vendor checks and a tape of other 
checks. 

e Run tapes of today’s customer invoices and vendor 
invoices, or choose Hash Totals from the Function menu 

before closing the Sales/AR or Purchases/AP window. 

e Allocate your deposit ticket total into receipts on 

account and other cash received. 

e Post these batch totals to the control log. On separate 
lines, enter the batch totals: 

Accounts Accounts 

Type of transaction Deposits Checks Recelvable Payable 

Cash received on account + _ 
Cash sales + 

Other cash received + 
Checks to vendors + = 

Other checks + 

Sales on account + 

Purchases on account + 
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e Calculate total checks and deposits since the beginning 

of the month. 

e Calculate total accounts receivable and accounts pay- 
able. 

Now check your figures. 

e¢ Confirm these totals with Business Sense. 

e Close any journals first, to post new transactions. “ 

° Choose Account History in the GL Report menu. a 

e Click on the current month. 

e Enter the number of the Cash account. 

e Click on the SHOW button. 

e Click on the OK button. 

e Scroll to the bottom of the report, and look at the total 
checks and deposits. 

e If the figures match your control sheet, close the report 
window. 

e Choose Balance Sheet from the GL Report menu. 

e Click on the OK button. 

e Compare the accounts receivable and accounts payable 
totals with your control log. 

e Close the Balance Sheet window. “a 

Here are three methods of keeping control sheets: 

e Journal Printouts 

If you print all five journals often, you have what you 
need in the printouts. Indicate the corresponding 
backup disk on the reports. 

¢ Manual control log is photocopied from Appendix H 
and the account totals are maintained like a personal 
checkbook register: 

Business Sense Control Sheet 

Receivable] Payable : 

2] _30327.18] 8227.61] __ Yellow 
Bills #1229-1233 1202. 50) TT 2: en Re aS 

[2/28 | RSH [Received on Acct 2/27 2558.07, are cc; i ae a 
aan BO ree ae 

2/28 | RSH |Payables Checks # 1234-1241 | 7472.51] Green __ 
(2/28 | ASH [Payroll #1242-1246 | Blue a) 

a eee ae eed 
Ge eS ere eee, as, 
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2/28 

|_RSH | 
| RSH | 
| RSH | 

2/28 | RSH | 

ame 
ae 
cs ol 
am 

2/27 | RSH [Beginning Balances ———“—s—s*s@YCi5S 2052.00 17759.62 30327.18 8227.61 
2/28 | RSH [Pay Bills #1229-1233 eee A) eee eee eee 

Received on Acct 2/27 2558.07) -2558.07) sf 
fe te rae Sea 

ense Contro | Spreadsheet 

Accounts Accounts 

° Receivable Payable 5 

Sales Invoices #23133-41 ae eee. 
Payables Checks #1234-1241 aes 

Payroll #1242-1246 ae 

aa eee SSE: 

Fh we ee a ee 

e Spreadsheet control log is an electronic spreadsheet 
file. Annotate the control log printout in pencil daily. 

Weekly, transfer the figures to the spreadsheet, print the 
revised control log and compare the totals to screen 

reports. 

Archive Transactions For the first month you use Business Sense, consider 
printing lists and journals each day they are modified. If 

you made some General Journal entries today, click on the 
General Journal window to bring it to the top, and choose 

Print from the File menu. 

It’s a good idea to hold daily work for one day in a manila 

folder. When you put today’s daily work into the manila 

folder, file yesterday’s. 

It’s smart to back up transactions for longer than a day, if 

you can. Rather than throw out data entry papers and 
printouts not needed for other purposes, put them in a 

desk drawer. When the drawer gets full, throw out the 

bottom half of the drawer’s contents. 

Close Windows The proper way to end a session with Business Sense is to 

and Quit close all lists, journals and reports and choose Quit from 

the File menu. 

If the Quit command is dimmed, you must close some- 

thing. Closing a window posts the changes and updates 

the interlinked files. 

When you choose Quit, the program will terminate, and 

you will be returned to the Finder, or Desktop. 
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Back Up You’re not done until you protect your company’s financial 

Company Data Files records with a backup copy. This is absolutely essential. 

The more experience people get with computers, the more 

systematic they become about backing up their work. 

People learn the hard way, but maybe you'll be lucky and 

benefit from their experience. A thunderstorm or a glitch in 
the machine could make your current data disks stop 

working. If that happens, you need to be able to re- 

establish your company’s financial records from backup 
disks and recent transaction information. 

Here’s the plan: Back up your Company Data folder at 
least every day. Label disks with color codes or numbers or 

days of the week to distinguish the disks. Cycle through 
five or 10 backup disks. Make month-end and year-end 

archive disks. 

lf you keep the e Eject the program disk, if necessary. 

Company Data folder | . select a backup disk. Don’t use the same backup disk 
on a floppy disk every time. Rotate five to 10 disks so that you have 
system, here's a step- many backup disks. The first time you use a disk to 
by-step procedure for back up your Business Sense files, initialize it or choose 
making a backup Erase Disk from the Special menu. 
co 

PY e Insert the backup disk. 

e Drag the Company Data disk icon to the backup disk 

icon. Make sure the backup disk has the word 
“BACKUP” or “BAK” in its disk name. You don’t want to 
make the mistake of dragging the wrong way, which 

would copy your backup disk to your data disk! 

e You will be asked if you want to completely replace the 

backup disk with the contents of the data disk. You do. 

e Wait for the files to be copied. Now your backup disk 
contains the same information that your working disk 

contains. 

e Eject the backup disk and the data disk. 

e Put the backup disk in a safe place. Monthly, take a 
backup disk to another site. 

e Put the data disk in a safe place. Lock it up. 

e Keep track of which backup disk was made on which “a 
day. 
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If you keep the e Select a backup disk. Don’t use the same backup disk 
Company Data folder every time. Rotate five to 10 disks so that you have 
on a hard disk, here’s many backup disks. The first time you use a disk to 
a step-by-step back- back up your Business Sense files, initialize it or choose 
up procedure Erase Disk from the Special menu. 

e Insert the backup disk. 

oe e Drag the Company Data folder to the backup disk icon. 

e You will be asked if you want to replace files with the 

same names. You do. 

e Wait for the files to be copied. 

e Eject the backup disk. 

e Put the backup disk in a safe place. Monthly, take a 

backup disk to another site. 

e Keep track of which backup disk was made on which 
day. 

If your Company Data If you keep your data on a hard disk, your data files may 

folder exceeds 800K get too big for one floppy disk. When you try to make a 
backup copy, the Finder will complain that the files won't 
fit. Do this: 

& e Select the backup disk and choose Erase Disk from the 
Special menu. Maybe some extra, unneeded files were 
on that disk. Now try to copy the Company Data folder 

to the backup disk again. If it works, continue your 
usual procedure. If your files still won’t fit, then do the 
following: 

¢ Open the Company Data folder by double-clicking on it 

or by selecting it and choosing Open in the File menu. 

e Choose By Size or By Name from the View menu. 

e Add up the sizes of the files, and divide by two. 

e Allocate the files into two groups, “A” and “B,” roughly 

equal in total size. 

e Write down the names of the files in Group A and the 

names of the files in Group B. Keep this list. Count the 
files to make sure you haven’t missed any. 

& e Choose By Icon from the View menu. 

e Drag the files around in the window until the files for 

Group A are in one rectangular area, and the files for 
Group B are in another rectangular area. 

e Choose Clean Up in the Special menu. 
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Thereafter, do this to make backups: 

Open the Company Data folder. 

Always back up Group A files onto disk A and Group B 
files onto disk B. Consult your list of files if the files are 

jumbled in the folder window. 

Select a pair of backup disks. Use many pairs of disks. 
Mark them carefully on the outside and in the disk 

name. Initialize them or choose Erase Disk from the 

Special menu. Mark the fifth set of backups like this 
“ACCTS BAK 5A” and “ACCTS BAK 5B.” You must keep 

the disks in coherent pairs. If you jumble the pairs, they 
will be useless. 

Insert Backup Disk A. 

Select the data files in Group A, by dragging a rectangle 
around them or by holding the Shift key while clicking 
on their icons. 

Drag one of the selected files to the backup disk icon. 
The rest will follow. 

You will be asked if you want to replace files with the 
same names. You do. 

Wait for the files to be copied. 

Eject Backup Disk A. 

Insert Backup Disk B. 

Select the data files in Group B. 

Drag one of the selected files to the backup disk icon. 

Answer Yes; you want to replace files with the same 
names. 

Wait for the files to be copied. 

Eject Backup Disk B. 

Keep the pairs of backup disks together in a safe place. 



CHAPTER 6: MAIN 
WINDOW ICONS 

Fourteen icons appear in the Main window: 

¢@ File Edit Function GL Report AR/AP/Payroll Report 

LEARNED LUMBER CO. 

0 Gf Ff F&F © 
sone Info Chart Of Accts Customers Depar tments 

e 9 & 
oN Tax Tables Help Reourring Entries General Journal 

moe A io) 
Sales /AR Purchases / AP 

The icons represent lists and journals containing your 

accounting data. This is the story of each icon: 

ICON NAME CONTAINS 

Company tax ID numbers, 
[— address, fiscal year date and 

passwords. 

Company Info 

List of chart of accounts, with 
optional addresses. 

88 

Chart Of Accts 

List of master and detail accounts 
receivable accounts, with bill-to 

YS addresses and multiple ship-to 
Customers addresses, terms and discounts, 

commission assignments and rules 
for assessing finance charges. 
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Departments 

Employees 

$0 

ay 
Tax Tables 

General Journal 

Sales/AR 

List of master and detail accounts 

payable accounts, with addresses 
and discount rules. 

List of departments, profit/cost 
centers or projects/jobs. “ 

List of employees, with addresses, 
wage rates, year-to-date earnings 

and withholding information. 

List of withholding amounts for 
federal, state and local taxes, by 

pay period, filing status, number 

of exemptions and gross pay 
range. Used only for taxes with 

progressive rates. 

Instructions for using the vvopran 

“Canned” transactions used to 

speed entries. 

Journal for non-cash entries, such 
as depreciation and account 
transfers. 

Journal for charge sales invoices. “Me 
Open and closed invoices are 
kept here. 



Journal for credit purchases 
invoices. Open and closed 

ap : ; 
invoices are kept here. 

Purchases / AP 

Journal for checks. 

Cash Disbursements 

Journal for deposits. 

Cash Receipts 

In addition to these 14 icons, there will be an additional 

Cash Disbursements Journal icon and Cash Receipts 

Journal icon for each additional Cash (checking) account in 
the Chart Of Accts list. 

Opening Icons To open a Main window icon, position the mouse pointer 
& on the icon and click the mouse button. This will open a 

window for entering and viewing the icon’s information. 

Since Business Sense icons don’t move, you only have to 

click once to open them. 

You can have more than one icon open at a time. To open 

more icons, uncover the Main window: either click on an 

exposed corner of the Main window, or choose Open Main 
Window from the File menu. 

Scroll A scroll bar on the right side of the window allows you to 
move toward the beginning or end of the information. 

Click the mouse pointer on the arrows to scroll one line at 
a time. Click in the “elevator shaft” to scroll one window at 

a time. Drag the elevator to go anywhere. 
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LEARNED LUMBER CO. 
For the month of February , 1987 

Resize You can make a window taller or shorter by dragging the 

size box in the lower right corner of the window. As you 
drag, an outline of the proposed window will follow your 
movement. When you release the mouse button, the re- 

sized window will be redrawn. Each Business Sense list or 
journal window has its width fixed to show an entire line. 

Move You can move a window by dragging its tite bar. An 

outline of the window will follow your movement. When 

you release the mouse button, the window will be redraw 

in its new location. Business Sense tries to organize 

multiple windows in a practical way, but you can adjust 

them to your own preferences. 

Closing Windows Just like any Macintosh window, Business Sense windows 

can be put away when you don’t need them. 

When a journal window is closed, its new transactions are 

posted and become permanent. 

You must close all lists, journals and reports before choos- 
ing Quit in the File menu. 
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COMPANY INFO The Company Info icon stores the Company’s tax ID 
numbers, address, fiscal year date and passwords. 

~ When you open the Company Info icon, a dialog box will 

appear. A dialog box is different from a window: you must 
finish your work here before you can use another window: 

Co. Name 
Addr 1 6700 Hermosa Way 

re a 
City,State 
ZipCode = [90415 
Federal ID# 

State ioe = [111-2222 
First Month of Fiscal Year 

if you enter a password, please 

write it down in case you forget it! 

Unrestricted Password 

Restricted Password 

To edit this information, use the Tab key to advance from 

field to field, or click on a field with the mouse pointer to 
select it. 

The fields in the Company Info dialog box are: 

e Co. Name will appear at the top of the Main Window, 
and on reports. 

e Addr 1 and the next five fields are used for printing 
1099 and W-2 Forms. 

e Addr 2 

e City, State 

e Zip Code 

e Federal ID# 

e State ID # 

e First Month of Fiscal Year (01 = January) sets the order 
of months in the dialog boxes for report dates. 

e Unrestricted Password if not blank, is required to start 
& Business Sense with all its features available. 

e Restricted Password if not blank, is required to start 
Business Sense for data entry. The restricted user can’t 

open the Company Info or Employees icons, can’t 
produce the Income Statement, Balance Sheet, Ratio 
Report, Customer Analysis, Vendor Analysis or Payroll 

Report, and can’t Generate Payroll. 
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Passwords The passwords are initially blank. If you leave them blank, 

the title screen will automatically switch to the Main 

window. If you set the passwords, a dialog box will 

require you to type either the unrestricted password or the 
restricted password to get from the title screen to the Main 
window. If you type the restricted password, you will have 

access to only the less sensitive features of the program. 

Don’t use passwords if you keep your data on floppy 
disks. Lock up your data disks instead. 

To set the passwords, choose two short secret words and 

type them into the edit boxes. To change or remove the 
passwords, start the program with the unrestricted pass- 
word, then edit the passwords. Set both passwords if you 

set one. Otherwise, you’re locking the front door, but not 
the back door. Passwords are case-sensitive, so use lower- 

case letters. Don’t forget your passwords! 

Click on the OK button to close the Company Info, or click 
on the Cancel button to leave the Company Info un- 

changed. 

If you have entered new passwords, a dialog box will 
appear requesting that you confirm the new passwords by 

typing them again: “yy 

A new password has been 

entered. Please retype here 

to verify. 

Unrestricted Password {| 

Restricted Password [] 

6-6 Business Sense 



CHART OF ACCTS This list contains the chart of accounts with optional 
addresses. 

When you click on the icon, the Chart Of Accts window 

NS will appear: 

LEARNED LUMBER CO. Account to 
For the month of February , 1987 

lrwentory/Purchase Discounts 

The fields in the Chart Of Accts window are: 

e Account No. can appear in any of these three forms: 
. : Looks lil ¢ ificati 

Ordinary AAAA four-digit number. 

Department AAAA/DD four-digit master account 

/two-digit department 
number. Always an 

Income Statement 

account. 

Sub-Acct AAAA/SSSS four-digit master account 

/four-digit sub-account. 

Consult Chapter 4: Starting Your Accounting System for 

advice about numbering your chart of accounts. 
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e Account Type categorizes accounts for the Income 
Statement and Balance Sheet. 

The Balance Sheet Account Types are: 

Code Name 
Cash Cash 

CA Current Asset 

Inventory Inventory 

FA Fixed Asset 

OA Other Asset 

CL Current Liability 

id; Long Term Liability 

OL Other Liability 

Equity Equity (Capital) 
Close Close (Retained Earnings) 

The Income Statement Account Types are: 

Code Name 
Revenue Revenue 

Returns Returns and Allowances 

CGS Cost of Goods Sold 

Expense Expense 

OINC Other Income/Expense A“ 

e Description is the account name. 

The Chart of Accts list is maintained in Account No. 
sequence within Account Type sequence. If you have 

assigned account numbers in Account Type sequence, the 
Chart Of Accts will be in Account No. sequence as well. 

Add an Account To add an account, enter it at the end of the list. Business 

Sense will rearrange the accounts by account type and 

then account number when you close the window. The 

next time you open this window, the accounts will be in 

sequence. 

Change an Account Don’t change the Account No. or Account Type of an 
account after you have used it for transactions. You can 

change the Description anytime. Rather than change the 

Account No. or Account Type, change the Description to 

“Old ...” and create a new account with the desired 

Account No. and Account Type. 
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Delete an Account You will not be allowed to delete an account if there has 

been any activity to it, even if the account balance is now 

zero. This is done so you won’t accidentally delete impor- 

tant financial history. 

To delete an unused account, click on the account to be 

"oe deleted. Then select Delete a Line from the Edit menu. 

Extending from the left side of the window, a small “More” 

tab points to the current account. This tab can be used to 
call up additional information about the account. Click on 
the More tab with the mouse, and a dialog box will 

appear: 

Account Name |Telephone-Hermosa | Acct*| 6065/01 = 

General Telephone 

PO Box 4392 

Los Angeles, CA 

92588 

@ Default Address 

Name 

Address 1 

Address 2 

City,State 

Zip Code 

© Address 1 © Address 4 © Address 7 

© Address 2 © Address 5 © Address 8 

© Address 3 © Address 6 © Address 9 

To edit this information, use the Tab key to advance from 

field to field, or click on a field with the mouse pointer to 
select it. | 

The dialog box contains payee names and addresses. The 

payee name and address will be printed on checks whose 
first line is posted to this account. 

e Account Name and Acct# are already filled in for this 
account. 

e Name is the payee name. 

e Address | is either a street address or an Attention: 

line. 

e Address 2 is a street address, post office box, suite 
& number, mail station or blank. 

e City,State is part of the payee address. 

e Zip Code can be up to 10 characters. 

e Radio buttons: Default Address, Address], ..., 
Address9 let you select 10 different payee names and 
addresses for this account. For example, you might issue 
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Control buttons 

CUSTOMERS LIST 
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checks from the Telephone Expense account to the 
phone company, long distance carrier, answering 

service and equipment supplier. You can store names 
and addresses for each of these payees in one account. 

To add another address, click on a radio button and the 

dialog box for this address will be replaced with a 
similar one for another address. 

When you post the first line of a Cash Disbursements “ 

Journal entry to this account, use the AD field in the 
journal to specify which name and address to print on 
the check. If you leave the AD field blank, the Default 
payee name and address for the account will appear on 

the check. 

When you choose Print Mailing Labels from the File 
menu, Business Sense will make mailing labels for all of 

these addresses. 

You can enter payee addresses for other accounts without 

going back to the Chart Of Accts window: 

SHOW is used for the name to number lookup shortcut 
described in the Shortcuts Section of Chapter 3: Tips for 
Users: change the Account Name edit box to the first 

few letters of the new account name, and click on the “ 

SHOW button, then fine-tune with the arrows. 

NEXT moves to the next account in sequence, or you 
can press the Return key or click on the down arrow. 

Clicking on the up arrow takes you backwards to the 
previous account in sequence. 

DONE returns you to the Chart Of Accts window. 

These lookup and scrolling controls work the same for 
all lists. 

This list contains the master accounts receivable account 

and detail accounts for each customer. Each customer has 
a bill-to address and multiple ship-to addresses, shipping 

information, credit limit, rules for assessing finance 

charges, terms and commission assignments. “ 

When you click on the icon, the Customers window will 

appear as shown on the following page. 



LEARNED LUMBER CO. 
For the month of February , 1987 

The fields in the Customers window are: 

e Customer No. is in the form “AAAA/CCCC,” a four-digit 
master accounts receivable account number, followed 

by a four-digit customer sequence number. The first line 
in the window is the master accounts receivable ac- 

count. See Chapter 4: Starting Your Accounting System 

about assigning customer numbers. 

e Age By is a toggle switch for Billing Statements and the 
AR Aging Report. New customers get the same aging 

method you’re using for the preceding account. To 

change the Age By value, click the mouse on the field. 

The value will toggle between INV (Open Invoice) and 

BAL (Balance Forward). 

e Customer Name is the customer company name. 

The Customers list is maintained in Customer No. se- 
quence. If you have assigned customer numbers in 

alphabetic sequence, the Customers will be in alphabetic 
sequence as well. 

call up additional information about the customer. Click on 

the More tab, and a dialog box will appear as shown on 
\& the next page. 

Extending from the left side of the window, a small “More” 

tab points to the current account. This tab can be used to 
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Bill/Ship 

BilTo §=@ ( suow } 

ShipTo! ©  City,State|Long Beach, CA (neu) 

ShipTto2 © ZipCode |96881 

ShipTo3 © Contact |Ralph Miller 

Ship To 4. Phone* [213-778-5500 ee 

ShipTo5 © FOB Discount Acct# BE a. Net 

Ship Via Ship To 6 O . Sales Person ID | 1000 | 

ShipTo? © Credit Limit [15000.00 Commission |7.00 | 
Ship To 8 

‘ © sinence Charges {1.00 | % Over Days 
ship To. © sinimum charge{ _] Revenue aeet# [4200] 

To edit this information, use the Tab key to advance from 

field to field, or click on a field with the mouse pointer to 
select it. 

The dialog box contains addresses, credit and commission 

information: 

e Name and Acct# are already filled in for this cus- 
tomer. 

e Addrl might be “Attn: Accounts Payable”. 

e Addr2 a 

e City,State 

e Zip Code 

e Contact is the name of your accounts payable contact 
person. 

e Phone# is that person’s phone number, which appears 
on the AR Aging report. 

e FOB will appear on invoices. 

e Ship Via will appear on invoices. 

e Credit Limit if exceeded, will generate a reminder 
asking you whether you want to issue the invoice 
anyway. Zero here means no reminders. 

e Finance Charges is the percentage of the overdue 
balance that will be assessed each time you invoke 
Apply Finance Charges in the Function menu. “ 

e Over vc Days defines when an invoice is overdue and 
subject to Finance Charges. This is not the same as 
Terms. 

e Minimum Charge will be applied if a smaller finance 
charge is calculated, unless no invoices are overdue. 
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e Revenue Acct# receives finance charges. 

e Terms will appear on invoices. 

e Discount Acct# receives discounts you credit when 
you Apply AR Payments in the Function menu. 

e Sales Person ID identifies the employee who is respon- 
sible for this customer, using the employee ID Number 
from the Employees list. Entering this information allows 

you to print a Sales Commissions report. 

e Commission is the percentage of the invoice amount 
that will be tabulated in the Sales Commissions report. 

e Radio buttons: Bill To, Ship To 1, ..., Ship To 9 let you 
store 10 different addresses for this customer. To add 
another address, click on a radio button and the dialog 

box for this address will be replaced with a similar one 
for another address. 

When you post the first line of a Sales/AR Journal entry to 
this account, use the ST field to specify which name and 

address to print as the Ship-To address on the invoice. The 
invoice will also show the Bill-To address. If you leave the 

ST field blank, the Ship-To address will be the same as the 
Bill-To address. 

Credit Limit, Finance Charges, Over 0 Days, Minimum 

Charge, Revenue Acct*¥, Terms, Discount Acct#, Sales 

Person and Commission fields have the same values for all 

addresses. 

Business Sense can make mailing labels for all of these 

addresses. 

Clicking the DONE button returns you to the Customers 
window. 
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VENDORS LIST 
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This list contains the master accounts payable account and 

detail accounts for each vendor. Each vendor has an 

address for checks. 

When you click on the icon, the Vendors window will 

appear: 

LEARN 

The fields in the Vendors window are: 

e Vendor No. is in the form “AAAA/VVVV,” a four-digit 
master accounts payable account number, followed by a 
four-digit vendor sequence number. The first line in the “Ye 

window is the master accounts payable account. See 
Chapter 4: Starting Your Accounting System about 

assigning vendor numbers. 

e 1099 Type to identify the type of compensation on 
Form 1099. If the vendor is not an individual, leave this 

field blank. The following values are allowed: 

1099 TYPE DESCRIPTION 

(blank) (no 1099, not an individual) 

Rents Rents 

Royalty Royalties 

Prizes Prizes and Awards 

Fishing Fishing Boat Proceeds 

Nonempl Non Employee Compensation 

Medical Medical and Health Care 

Subpay Substitute Payments “Ye 

e Vendor Name is a company or individual name. 

e Recipients 1099 ID # if 1099 Type is not blank, enter 
the Social Security number or Employer Identification 
number. 



The Vendors list is maintained in Vendor No. sequence. 
If you have assigned vendor numbers in alphabetic 
sequence, the Vendors will be in alphabetic sequence 

as well. 

Extending from the left side of the window, a small “More” 

tab points to the current account. This tab can be used to 
call up additional information about the vendor. Click on 
the More tab, and a dialog box will appear: 

Name lAcme Sash 0 Frame Acct#/ 2050/0150; & 

Rddri 788 Forrest Lane 

City,State| Mendicino, CA 

Zip Code |96659 

Discount Terms: 

Discount [2.00 | before|10 | Days (pone } 

Discount Acct# 

To edit this information, use the Tab key to advance from 

& field to field, or click on a field with the mouse pointer to 

select it. 

The dialog box contains address and discount data: 

e Name and Acct# are already filled in for this vendor. 

e Addr] will be printed on vendor checks, and appears 
in the envelope window. Business Sense can make 
mailing labels for vendors. 

e Addr2 

e City,State 

e Zip Code 

e Discount (01% before CJ Days is the percentage dis- 
count and the maximum number of days after the 

invoice date to take the discount. In Select AP Payments 

in the Function menu, Business Sense provides an 

& option to Select All Discountable invoices. When you 

click the Select All Discountable check box, eligible 
invoices will be selected and discounts will automati- 
cally be taken. 
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e Discount Acct# is the account number to which 
discounts will be posted. This field is used for discounts 
taken automatically as above and also for discounts 
typed into the Vendor Ledger Card when you select Pay 

Individual Invoices in the Select AP Payments command. 

Clicking the DONE button returns you to the Vendors 

window. fy 

DEPARTMENTS LIST This list contains the names of the departments, cost 

centers, projects or jobs. It is maintained in sequence by 

( oF department number. 

When you click on the icon, the Departments window will 
appear: 

The fields in the Departments window are: 

e Dept No. is a two-digit number, from 01 to 99. 

e Department Name will appear on the Department 
Income report. 

The Departments list is maintained in Dept No. sequence. 
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EMPLOYEES LIST The Employees list contains payroll information including 

employee address, multiple wage rates, year-to-date 

earnings, deductions and filing status. 

When you click on the icon, the Employees window will 

appear: 

2 Pete W. 

The fields in the Employees window are: 

e ID is the employee identification code, which can be 
any combination of up to four letters and numbers. This 
is the same as the Sales Person ID for commission 

assignments in the Customers window. If you need to 

run separate payrolls for groups of employees, make the 
group code part of the ID. Then you can Find Name or 
Number in the Edit menu to underline groups of 

employees for separate payroll runs. 

e Pay Type is either hourly or salaried. When entering 
new employees, this field is skipped and assigned from 

the line above. If you click on this field, it will toggle 
between HOUR and SALR. If the Pay Type is HOUR, 
enter both Pay per Hour and hours in the Wage Infor- 

mation More pages. If the Pay Type is SALR, enter only 

the Pay, which is for one pay period. 

e Employee Name should be in the form “Lastname, 
Firstname” so you can find employees easily by last 

name. 

e Social Security # with hyphens. 

The Employees list is maintained in Employee Name 

sequence. If you enter employee names as “Lastname, 

Firstname” the employees will be in sequence by their last 

names. When checks are printed, if the name contains a 
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Wage Information 
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comma, the parts of the name before and after the comma 

will be interchanged. If there is no comma, the name will 

be printed without change. Enter middle initials last, and 

trailers before the comma. For “Fuller Jr., Richard B.” the 

paycheck will show “Richard B. Fuller Jr.” 

Extending from the left side of the window, a small Morel 

tab points to the current employee. This tab can be used to 
call up three screens of additional information. Click on the 
More tab, and the first dialog box will appear: 

Wage No. Name | Brown, John J. iD 

Expense Account |6045/01 Wages 2 

Wages 3 

Wages 4 Other Reimbursements 

Wages 5 Account Number 

Wages 7 Account Number 

pocorn 
nonce 

range benema -——] 
Personal Information 

© 

© 

©) 

O 

.@) 

Wages6 © Other Reimbursements 

© 

Wages 8 © 

Wages 9 © 

Wages 10 © 

To edit this information, use the Tab key to advance from 

field to field, or click on a field with the mouse pointer to 
select it. 

The dialog box contains information to calculate gross 

wages: 

e Radio buttons: Wages1, Wages2, ..., Wages10 give 
you the ability to pre-set 10 pages of wages. For an 
hourly employee, Wages1 would be regular earnings, 

Wages2 would be overtime earnings, and so on. You 

may establish wages pages for commissions, holiday 
pay, bonuses and sick pay. Each wage category will be 

itemized by number on the paychecks. 

e Name and ID# are already filled in for this employee. 

e Pay) Per hour, (1) hours is used to calculate gross 
pay. For hourly employees, enter both figures. For 
salaried employees, enter the salary for the pay period 

in the first box. All of the wage calculations for this 
employee are hourly or salaried, controlled by Pay Type 

in the Employees window. 



e Expense Account is the Chart Of Accts account for 
payroll expense. 

e Initial YTD Gross is the amount of earnings already 
received before starting the Business Sense payroll func- 
tion. After this amount has been entered and added to 

YTD earnings for W-2 reporting, the field will disappear. 

e Other Reimbursements is a miscellaneous non-taxable 
amount to be paid. 

e Account Number is the account to which the Other 
Reimbursement is to be charged. 

e Other Reimbursements is a second miscellaneous 
non-taxable amount. 

e Account Number is the account charged for the 
second Other Reimbursement. 

e Tips are reported for income tax purposes, but not paid 
by payroll check. 

e Fringe Benefits are reported for income tax purposes, 
but not paid by payroll check. 

There are two more types of More information for each 

employee, in addition to this Wage Information. You can 

click on the Withholding button to edit the tax rates and 

deductions pages, or on the Personal Information button to 

edit the employee address and filing status page: 

Reker aes 

Wage 
Information 

Personal 

Information 
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Withholding 

6-20 Business Sense 

You can enter wages and hours for other employees by 

clicking on the arrows. 

From any of these three additional information screens, 

click on the DONE button to return to the Employees list. 

The Withholding dialog box contains information to “ 
calculate deductions: 

Withholding Name [Brown, John J. in[1000] ¢ 

Federal © Withholding Acct * | 2018/0001 

FICA Amt/228.00 {Or} — | % Withheld 
ee NET Max To Withhold| = 

(CJ Use Tax Table 
Local 

Other 1 © 

Other 2 © CJ Withhold From Employer 

Others O Amt[ or % Withheld 
Other 4 O NET Max To Withhold 

OtherS O Expense Account |---| 

Other 6 O Liability Account 

Wage Information Personal information 

e Radio Buttons: Federal, FICA, State, Local, Other1, 
..., Other6 let you calculate up to 10 payroll deduc- 
tions. Each withholding screen has its own rules, rates 

and accounts. 

e Name and ID# are already filled in for this employee. 

e Withholding Acct # is often a sub-account of payroll 
taxes payable. This is the account which receives the 

withholding. It is a current liability. 

e Amt o Oro % Withheld either a dollar amount ora 
percentage may be specified. Do not enter both an 

amount and a percentage. 

e NET Max To Withhold for taxes such as FICA, enter the 
maximum annual tax. Zero means no limit. 

e Use Tax Table is an option for Federal, State and Local 
taxes. For other deductions, this check box will be 

dimmed. If you turn this check box on, the amount 

withheld will depend on the filing status entered in the 
Personal Information and on the Tax Tables values. 

e Initial YTD Balance is the amount already withheld for 
this tax. 



Personal Information 

e Withhold From Employer is a check box which 
enables matching deductions for FICA taxes, stock 

purchase plans, or charitable donations. When you 
generate the payroll, a separate two-line entry will be 

made into the General Journal for the employer contri- 

bution for each employee. 

e Amt() Or()% Withheld should be the same as the 
employee rate for FICA. For other deductions, it can be 
any rate. 

e NET Max To Withhold is the maximum amount of the 
employer contribution in one year. Zero means no limit. 

e Expense Account is usually payroll expense or payroll 
taxes expense. 

e Liability Account is often a sub-account of payroll 
taxes payable. It may be the same as the Withholding 

Acct above. It is a current liability. 

You can click on the Wage Information button to go to the 

wages pages, or on the Personal Information button to go 

to the address and filing status page. You can enter 

deductions for other employees by clicking on the arrows. 

Click on the DONE button to return to the Employees list. 

Name Brown, John J. iD 

Addrst 2598 West Hill St. 

Addrs2 

City,State | Gardena, CA 

Zip code 

Tax Table Information 

Federal State Local 

Marital Status ($,M,U) 

Payroll Period (W,B,S,M,D) 

Allowances (0,1,...,10) 

The dialog box contains employee mailing address and 

filing status: 

e Name and ID# are already filled-in for this employee. 

e Addrs1 and the next three fields will appear on the 
paycheck and W-2. 

e Addrs2 
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Prepare Payroll 

New Hire 

Termination 
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e City,State 

e Zip code 

e Tax Table Information gives the filing status for 
Federal, State and Local Tax Tables. The information is 

specified for each of these taxes. Omit these entries for 

taxes which don’t use the Tax Tables. 

e Marital Status (S,M,U) is Single, Married, or Unmarried * 
Head of Household. 

e Payroll Period (W,B,S,M,D) is Weekly, Bi-weekly, 
Semi-monthly, Monthly, or Daily. 

e Allowances (0,1,...,10) is the number of deductions or 
exemptions allowed. 

You can click on the Wage Information button to go to the 

wages pages, or on the Withholding button to go to the tax 

rates and deductions pages. You can enter addresses and 

filing status for other employees by clicking on the arrows. 

Click on the DONE button to return to the Employees list. 

Business Sense will calculate the gross pay, withholding 

and net pay for all employees or selected employees, 

based on hours, pay rates and withholding information “A 

stored in the Employees list. The program also creates 

General Journal entries for the employer FICA contribution. 
You can then print paychecks with itemized deductions. 

The procedure for running a payroll is shown under the 
Generate Payroll command in the Function menu, in 

Chapter 7: Pull-Down Menu Commands. 

When an employee is hired, assign an ID code, enter the 

Wage, Withholding Information and Personal Information 

screens, and verify that the Tax Tables cover this person’s 

filing status. 

When an employee leaves, zero the Pay field and zero any 

fixed withholding amounts. Keep the Personal Information 

so a W-2 Form can be mailed. “Y 



TAX TABLES The Tax Tables contain information for progressive-rate 
taxes. There can be Federal, State, and Local tables. The 

E i E3 Tax Tables are not linked to the other files in the company 

¥ data folder, so you may copy them independently of other 

files. 

| When you click on the icon, the Tax Tables window will 

appear: 

The fields in the Tax Tables window are: 

e Table is Federal, State, or Local. You can abbreviate F,S 
or L, and Business Sense will convert the entry to its 
standard format. 

e Marital Status is Single, Married or Unmarried Head of 
Household. You can abbreviate as S, M or U. 

e Payroll Period is Weekly, Bi-weekly, Semi-monthly, 
Monthly or Daily. You can abbreviate W, B, S, M or D. 

e Wh AIT is the number of withholding allowances, 0, 1, 
oes 0 2 

e At Least is the minimum gross earnings for this line to 
apply. 

e But Less Than is the top of the range. 

e Amount to Withhold per pay period. 

The Tax Tables are maintained in sequence by fields from 

& left to right in the window. All the Federal entries come 
first. Within these, the lines are listed in order of Marital 

Status, Payroll Period, Wh Al and At Least. 
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Enter Tax Tables Add new tax table entries for Federal, State or Local 

withholding for employees whose withholding window has 
Use Tax Tables checked. Since Tax Tables are like lists, 

add new lines at the end of the list. If you enter these lines 

systematically, the process is very fast. After you enter a 
line for a given filing status, press the Return key. The new 

line will nearly duplicate the old one, except the two 

columns “At Least” and “But Less Than” will be increased 

based on the range defined in the prior line. Use the Tab 
key as necessary to change other fields. When you close 

the window, Business Sense will re-sequence the tax tables 
according to Table, Marital Status, Payroll Period, Wh Al 

and At Least. 

HELP The Help file contains information about using Business 
Sense. You can customize the text to your particular 

» practices and accounts. 

When you click on the icon, the Help window will appear: 

name, customer name, or vendor name. 

Tab to the next field. 

Vendors list. 

2 Click anywhere on the proper account. 

When the Help window appears, the Index menu will be 
added to the menu bar at the top of the screen. “Aw 
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Using Help 

Modifying Help 

Editing Lines 

Scroll up and down through the window to review the 
information, or select a topic in the Index menu to jump to 

that topic. Close the Help window when you are through. 

Help topics are indexed with a pound sign in the first field. 
Text on these lines appears in the Index menu when the 

Help window is opened. 

You can change the text of a topic by editing the lines. 

The Help file is not linked to your other files, so you can 

copy your modified Help file for use in other company 
locations. 

To add an index topic, insert some blank lines, type in the 

name of the entry, and enter the pound sign in the first 

field. There is a limit of 18 index entries. 

To delete an index topic, delete the line with the pound 
sign and the text lines following. 

The Help window uses the built-in Macintosh text editor. 
Change lines by selecting text with the mouse pointer and 

typing the new text. If you click twice on a line before 
typing, a flashing vertical insertion bar will appear. When 

you see the insertion bar, you can type to insert text, or 

backspace to delete text. 

To insert a line in the Help file, click on the line which will 

follow the blank line. Then choose Insert a Line from the 

Edit menu, and the selected line will move down to make 

room for a blank line. You can add several lines quickly by 

using the Command-key shortcut, Command-I, and count- 

ing to yourself as you type the command. 

To delete a line from the Help file, click on the line and 
choose Delete a Line from the Edit menu. You can delete 

several lines quickly by using Command-D and counting to 

yourself as you delete lines. 
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RECURRING ENTRIES Recurring Entries customize and streamline Business Sense 

for your company. This streamlining is not only efficient, 

it’s more accurate. You can store templates of periodic or 

frequent transactions in Recurring Entries, and generate 
many transactions with a single click. Typical topics for 

Recurring Entries are: 

e Billing subscribers for monthly service. “ 

e Paying monthly bills. a 

e Entering complex daily transactions, such as cash sales 
for multiple departments and multiple product lines. 

e Entering depreciation. 

e Posting month-end adjustments and transfers. 

e Paying quarterly payroll taxes. 

When you click on the icon, the Recurring Entries window 
will appear: 

a} | Recurring Entries | 9 Entries : : 

LEARNED LUMBER CO. 
For the month of Fet 

+ Had 8 
Bie & ih H itt iH 

HSH SHitH 

When the Recurring Entries window appears, the Index 
menu will be added to the menu bar at the top of the 

screen. 
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Generate Entries 

Create Entries 

Scroll up and down through the window and select the 

group of entries to be generated, or select a topic in the 

Index menu to jump to that topic. | 

When you click the Generate Entries button, you transfer 

entries to various journals. The Macintosh will beep, open 

the needed journals, and will type in the entries for you. 

Close the Recurring Entries window when you are through. 

Transferring a Set 
To transfer a whole set of entries, click on an Index 

header line or select a name from the Index menu, then 

click on the Generate Entries button. All of the entries in 

that Index entry will be transferred to the journals. 

Transferring one Transaction 
Click to select a transaction line, then click on the 

Generate Entries button. Only that transaction will be 

transferred. 

To create your Own recurring entries: 

Design the entries. Photocopy the layout sheets in 

Appendix G: Recurring Entries Layout Sheets. Write a 

transaction on the layout sheet. Circle the information 

that will change from time to time. 

Open the Recurring Entries window, and enter the 

transactions you have laid out. Leave out the variable 
information you have circled. Don’t forget the index 

entry with the pound sign at the beginning. 

Test your work by clicking on the Generate Entries 

button. Business Sense will create the entries. Check 

whether the data found its way into the right fields. If 

you are generating transactions with blank amounts, 

look at the date column to check whether new transac- 

tions begin on the right lines. If too many lines have 
dates, enter a $1 amount at the beginning of a transac- 

tion to keep Business Sense from starting a new transac- 

tion each time the debits and credits balance. You can 

delete the test transactions with Delete a Line from the 
Edit menu before closing the window. 

Distribute your Recurring Entries. The Recurring Entries 

file is not linked to your other files, so you can copy 

your custom file for use in other company locations. 

To insert a line, click on the line which will follow the 

blank line. Then choose Insert a Line from the Edit menu, 

and the selected line will move down to make room for a 
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blank line. You can add several lines quickly by using the 

Command-key shortcut, Command-I, and counting to 

yourself as you type the command. 

To delete a line, click on the line and choose Delete a Line 

from the Edit menu. You can delete several lines quickly 

by using Command-D and counting to yourself as you 

delete lines. “ 

The Recurring Entries window begins with a field called 

Jrn that can be filled in three ways: 

e Index line: enter a pound sign in the Jrn field to mark 
the beginning of a group of transactions. After entering 

the pound sign, Tab to the next field. The heading will 

be labelled Recurring Entries Index. Enter a name for 
this set of entries. The next time you open the Recurring 
Entries, the name you have given will appear in the 
Index menu. If you follow the Index name with a slash 

and a letter, you can have a Command-key shortcut for 

the Index entry. This technique is illustrated in the 
Demo Data. 

e First line of a transaction: the Jrn field identifies the 
journal that will receive the transactions when you 

Generate Entries. The journal codes are: A“ 

Jm _ Journal 

CD1 Cash Disbursements Journal #1 

CR1 Cash Receipts Journal #1 

GEN General Journal 

PUR Purchases/AP Journal 

SLS Sales/AR Journal 

To create more than one transaction in a set of entries, 

label the first line of each transaction with the Jrn code. 

e Additional line of a transaction: a blank Jrn field is a 
continuation line going into the same journal. 

When you type a journal code into the Jrn column, the 
Recurring Entries window headings will change. Headings 

corresponding to the headings in the journal will appear 
over the columns to guide you in entering the correct 

information. You can click in an entry anytime to see the “Me 

appropriate headings. 
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GENERAL JOURNAL The General Journal is used to record transactions that will 

not appear in the Sales/AR, Purchases/AP, Cash Disburse- 
ments or Cash Receipts Journals. It is used to open the 
books at the beginning of the year, and to post non-cash 

transactions such as depreciation, adjustments to prepaid 
expenses, and end-of-month and end-of-quarter transfers. 

When you click on the icon, the General Journal window 

will appear: 

= = General Journal Sasi 

ebruary 

_.../February Cost of Goods Sold |FEB CGS }50- 

The fields in the General Journal window are: 

Date of transaction, with leading zeros for month and 
day. “0301” will be converted by Business Sense to “03/ 
01”. 

Description 

Ref is additional description or a cross-reference. 

Account# 

Debit Amt 

Credit Amt 
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Example — 

Depreciation 

Example - Payroll 
Statement 
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Here is the step-by-step procedure to enter General Journal 

transactions: 

Open the General Journal window. 

Date: Tab to the next field for today’s date. 

Description: enter “Deprec - ’86 Ford Van” and Tab to 

the next field. 

Ref: enter “Feb” and Tab to the next field. “ 

Account#: enter “6500” for truck depreciation expense, 
and Tab to the next field. 

Debit Amt: enter “272” and press Return. A new line will 

be generated with most of the information already 

complete. Tab to the account number. 

Account#: enter “1701” for accumulated depreciation. 
The balancing amount is already correct. 

The completed entry looks like this: 

LEARNED LUMBER CO. 
For the month of Feb 1987 

Sara 8. Roberts/FICA 
02/28|February Cost of Goods Sold 

ebruary Cost of Goods Soild 

To enter a statement from a payroll service company, the 

gross payroll amount is debited to payrcll expense. The 
payroll taxes are credited to payroll taxes payable, and the 

payroll deposit account is credited with the net amount of 

the checks. Here’s a step-by-step procedure using the 
Demo Data: 

Open the General Journal window. 

Date: enter “0227” for the payroll date, and Tab to the a) 
next field. Business Sense will fill-in the Slash. 

Description: enter “Payroll Service” and Tab to the next 

field. 

Ref: enter “Gross” and Tab to the next field. 



e Account#: enter “604501” for Payroll Expense, and Tab 
to Debit Amt. The Slash will be inserted in the account 

number. 

e Debit Amt: enter “3100” and press Return. A new line 

will be generated with most of the information already 
complete. Tab to the Ref field. 

e Ref: enter “Federal”. Tab to account number. 

e Account#: enter “20180001”. Tab twice to Credit Amt. 

e Credit Amt: enter “474.5” and press the Return key. Tab 
to Ref. 

e Ref: enter “FICA” and Tab to the next field. 

e Account#: enter “20180002” and Tab twice to Credit 

Amt. 

e Credit Amt: enter “221.65” and press the Return key. Tab 
to Ref. 

e Ref: enter “State” and Tab to the next field. 

e Account#: enter “20190001” and Tab twice to Credit 

Amt. 

e Credit Amt: enter “248” and press the Return key. Tab to 
Ref. 

& e Ref: enter “SDI” and Tab to the next field. 

e Account#: enter “20190002” and Tab twice to Credit 

Amt. 

e Credit Amt: enter “37.2” and press the Return key. Tab 
to Ref. 

e Ref: enter “Net” and Tab to the next field. 

e Account#: enter “1025” for the payroll deposit account. 
The balancing entry of 2118.65 is already calculated. 

The completed entry looks like this: 

General Journal 

Be q 

18 Peliists teases teats tt 

F Cost o 

kid PoE 
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SALES/AR JOURNAL The Sales/AR Journal is used to record sales on account. 

Record cash sales in the Cash Receipts Journal. Open 
invoices and paid invoices are kept here in the Sales/AR 

rs] Journal. 

When you click on the icon, the Sales/AR Journal window 

will appear: 

First Line of The first line of a Sales/AR transaction is an invoice 

an Invoice summary line, charging the sale to a customer accounts “& 

receivable account: 

e Date of sale. 

e Description/PO Number will appear on the Invoice 
Register and on the Billing Statement. Enter description, 

then a Slash, and then the purchase order number. The 
number after the slash will be printed in the PO Number 
box on the invoice. 

e Invoice# is automatically incremented each time a new 
invoice is created. To use the automatic number, Tab 
over this field. Enter a different invoice number if 

needed. Enter the number yourself the first time you use 

this journal, to start the automatic numbering. 

e Customer Account# can be entered by the name to a) 
number shortcut: type a few letters from the beginning 
of the customer name, tab to the next field, and observe 

the account name in the top left side of the window. 
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e Invoice Amount can be left blank if you want Business 
Sense to calculate the total after all line items have been 

entered. 

e ST is the Ship-To address. If the Ship-To address is the 
same as the Bill-To address, leave this column blank. If 

the Ship-To address is different, enter the Ship-To 
& address digit from the Customers list More Info dialog. 

e TC is not used in the first line of an invoice. 

Detail Lines of an Invoice line items are entered after the first line. The line — 
Invoice items are posted to Revenue accounts. Each item is sepa- 

rately taxable or non-taxable. Freight and miscellaneous 

charges can be entered similarly. Sales tax can be calcu- 
lated automatically with the Complete Invoice command, 
or entered manually. 

e Date is not entered for a detail line. Entering a date 
here would start a new invoice, leaving the previous 
line unbalanced. 

-| @ Quantity/Description provides the line item quantity, 
& description and unit price information. If you specify a 

quantity, the Sales/Tax Amount is divided by the 

quantity to calculate the unit price. If you omit the Slash, 
the entire line is treated as the description, and the quan- 

tity and unit price fields will be left blank on the 
invoice. 

e Invoice# is automatically copied into this field from the 
line above. 

e Account# is the Revenue or Returns account for line 
items, or the sales tax payable account for sales tax. 

e Sales/Tax Amount is the line item amount. You can 
use a multiplication shortcut by entering quantity times 

unit price like this: 12*27.95. 

e ST is not used in the detail lines of an invoice. 

Set Sales Tax Codes in the Function menu and leave this 
column blank, the default sales tax code is applied. If 

you have not Set Sales Tax Codes, no tax is calculated 

for this invoice and the Sales Tax report in the 
AR/AP/Payroll Report menu will not be available. 

Y e TC is the Tax Code digit for this line item. If you have 

Chapter 6: lcon Commands 6-33 



Example — 

Sale on Account 
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After entering the line items, select Complete Invoice (type 

Command-minus) from the Edit menu. The sales tax, if 

any, will be calculated and displayed on a new line. The 
invoice will be totalled, and the total amount will be 

shown in the first line. Enter a description for the sales tax 

line, and the sales taxes payable account number. 

Enter additional invoices in the same way. When you “” 

finish, use Hash Totals in the Function menu to batch tota 

the new invoices. Then close the Sales/AR window to post 
the transactions. A dialog box will ask if you want to print 

invoices. 

Here is the step-by-step procedure to enter a charge sale, 

using the Demo Data: 

e Open the Sales/AR Journal. The first blank line will be 

selected. 

Enter the first line of the invoice: 

e Date: Tab to the next field. Today’s date is supplied 
automatically. 

e Description/PO: enter “Gross 2x4’s/AB 222" and Tab to 

the next field. 

e Invoice#: the next number in sequence, 23133, is “ 

automatically supplied. Tab to the customer account 
number. 

e Customer Account#: type “allen” and Tab to the next 
field. Look at the upper left corner of the journal 

window, the account name “Allen Contractors” appears, 

confirming that account number 1050/0100 is the proper 
one. 

e Tab twice, past the Invoice Amount. It will be left blank 
for now. 

e ST Ghip-To address code): enter the digit “1” to use 
Allen Contractors’ Ship-To address number 1, which is 
“Meadowview Homes” in Irvine. Press the Return key to 

advance to the next line. 

Enter the invoice line items: 

e Quantity /Description: enter “144/2x4’s” and Tab wi 

to account number. 

e Account#: enter “401001” the lumber revenue account 

for the Hermosa Beach store. Tab twice to the sales/tax 

amount field. Business Sense will change the account 
number to 4010/01. 



e Sales/Tax Amount: the unit price for the 2x4’s is $2.18. 
Use multiplication to enter the line item amount: 
“144*2.18”. This is a taxable sale, so the Tax Code will 

be left blank. Press Return to go to the next line. 

Enter a miscellaneous line: 

¢ Quantity/Description: type “Freight”. Since you have 
omitted the Slash, the quantity and unit price fields will 

be left blank on the invoice. Tab twice to the account 

number. 

e Account#: enter “4100” and Tab twice to the sales/tax 

amount field, skipping over the balancing entry which 

will disappear when you enter a sales/tax amount. 

e Sales/Tax Amount: type “35” and Tab twice to tax code. 

e TC: the Sales Tax Code is “4” No Tax General. Press the 
Return key to start a new line. 

Complete the invoice 

e Description: enter “6.5% Sales Tax” and Tab twice to 
account number. 

e Account#: enter “2015” Sales Tax Payable. 

e Choose the Complete Invoice command (type Com- 
mand-minus). Sales tax is calculated on the lumber but 

not on the delivery charges. The invoice total appears 

on the first transaction line. 

The completed transaction looks like this: 

a SSS SS SS 

tallation Services 

The printed invoice would look as shown on the top of 

page 6-36. 
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LEARNED LUMBER CO. INVOICE 
6700 Hermosa Way 

Hermosa Beach, CA 90415 

SAMPLE - VOID 
PORm 1300 

COmPaTIOLE ENVELOPE 1001 

Allen Contractors Meadewlew Hanes 

334 South Hill 11 Apple Tree Lane 
Long Beach, CA 96861 Irvine, CA 94221 
Attn Ralph Miller Atta: Brad Culver 

6.T% Sales Tan 

Example— On invoice #23132 in the Demo Data, the customer 

Credit Memo returned 100 of the 400 sheets of plywood, and is to 
receive a credit memo for 25 percent of that line item. 

Fix/Adjust Entry is the best way to make a new entry 

similar to an existing one. Select the original invoice in th 

Sales/AR window and choose Fix/Adjust Entry in the 
Function menu. If the credit memo is a partial credit, edit 

the amounts, or use Delete a Line from the Edit menu to 

delete line items. Typing in a credit memo works, too. 

Here is the step-by-step procedure: 

e Open the Sales/AR window. 

e Click anywhere on invoice # 23132. 

e Choose Fix/Adjust Entry in the Function menu. 

e Click on the Credit Memo radio button. Click on the OK 

button. A draft credit memo for the full invoice is 

generated. Now, edit it. 

e Change the first line amount from $8100.00 to 25 

percent of $7056.00: select the $8100.00 amount, 
overtype “.25*7056” and Return to go to the next line. 

e The next line doesn’t belong in the credit memo: cho 
Delete a Line from the Edit menu. The line disappears. 

e The next line doesn’t belong in the credit memo either: 

Delete a Line again. The line disappears. 

e The final line will balance the first one after you change 
the amount to “1764” by consulting the first line. 
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PURCHASES/AP 
JOURNAL 

Ss 

The completed transaction looks like this: 

S0/ Boxes, *10 Nails 

30/ Door Frames 

To process customer payments on account, see the Apply 
AR Payments command in the Function menu in Chapter 7: 
Pull-Down Menu Commands. 

The Purchases/AP Journal is used to record purchases on 

account from organizations listed in the Vendors list. Since 

you won't be issuing invoices from this journal, there will 

be fewer lines per transaction. There is no required order 
to the lines of a transaction, but, if you distribute a pur- 

chase to multiple accounts, you will find it more efficient 

to post the line items first and the invoice total last. This 

way Business Sense will calculate a running total for the 

invoice. You should enter one or more lines to post the 

line item costs to Expense accounts or Cost of Goods Sold 
accounts, then one line to post the invoice amount to the 
vendor accounts payable account in the Vendors list. At 

the end of a batch of invoices, use Hash Totals in the 

Function Menu to find the batch total. 

You can also issue checks with payee names and ad- 

dresses stored in the Chart Of Accts, without entering those 
invoices into the Purchases/AP Journal. Consult the Ac- 

counts Payable Section of Chapter 4: Starting Your Ac- 
counting System for a discussion about running all checks 

through Purchases/AP versus issuing some checks from the 
Chart Of Accts. 
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When you click on the icon, the Purchases/AP Journal 

window will appear: 

LEARNED LUMBER CO. 
For the month of Februar 1987 

The fields in the Purchases/AP Journal window are: 

e Inv Date is the date of the vendor invoice. 

e Due Date is calculated from the Inv Date and the 
Terms. If the Terms are “Net 30 Days” then enter “+30” 

for the Due Date, and Business Sense will calculate the 

calendar date. For prompt payment discounts, enter the 
discount days and percentage in the Vendors list. If the 
Terms are “2% 10, Net 30” enter “+30” for the Due Date. 

To take advantage of the 2 percent discount, select the 
Pay All Discountable radio button in the Select AP 

Payments command from the Function menu. 

e Description, usually PO number, can mention the items 
and the vendor to cross-reference the entries in reports. 

e Invoice Number is the vendor’s invoice number. 

e Account# for line items, enter the expense account 
number. For the last line, enter the vendor accounts 

payable account number from the Vendors list. 

e Expense Amount You can enter multiple debit 
amounts for each line item of the purchase. 

e Invoice Amount After you have entered all detail line 
items, Business Sense will have calculated the invoice 

amount for you. “ey 
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Example — Here is the step-by-step procedure to enter a vendor 

Purchase on Account invoice using the Demo Data: 

e Open the Purchases/AP Journal. 

e Inv Date: enter “0220” from the invoice, and Tab to the 

next field. Business Sense will fill in the Slash. 

e Due Date: enter “+30” for Net 30 terms, and Tab to the 

next field. The due date field shows 03/22. 

e Description: enter “Purch Doors & Frames - Acme” and 

Tab to the next field. 

e Invoice #: enter “AS 3402” from the invoice, and Tab to 

the next field. 

e Account #: enter 1511" for building materials purchases, 
and Tab to the next field. 

e Expense Amount: enter “3700” and press Return to go to 

a new line. Tab twice to the account number. 

e Account#: enter “1521” for plywood purchases, and Tab 

to the next field. 

e Expense Amount: enter “1250” and press Return. The 

proposed 3700.00 balancing entry disappeared when 

you entered another Expense Amount. The running 
invoice amount is being calculated as you go. Tab twice 

& to the account number. 

e Account#: enter “acme” and Tab to the next field. The 

Acme Sash & Frame account number turned out to be 

2050/0150. 

The completed entry looks like this: 

LEARNED LUMBER CO. 
For the month of Febru 987 

150 Sheets 3/4 
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Example — 

Purchases 

Credit Memo 

6-40 Business Sense 

We returned the #10 nails purchased on invoice 55703C to 
Clark Products for credit, minus a 20 percent restocking 
charge. 

Fix/Adjust Entry is the best way to make a new entry 
similar to an existing one. Select the original invoice in the 
Purchases/AP window and choose Fix/Adjust Entry in the 
Function menu. If the credit memo is a partial credit, edit “ 
the amounts or use Delete a Line from the Edit menu to 
delete line items. Typing in a credit memo works, too. 

Here’s the step-by-step procedure to enter the credit 
memo: 

e Open the Purchases/AP Journal. 

e Click anywhere on invoice # 55703C. 

e Choose Fix/Adjust Entry in the Function menu. 

e Click on the Credit Memo radio button. Click on the OK 

button. A draft credit memo for the full amount is 

generated. Now, edit it: 

e Change the amount from $242.86 to 80 percent of that 
amount: Tab six times to the first line amount, overtype 
“.8*242.86” and press Return to go to the next line. 

e The final line must balance the first one, so change the 

amount to “194.29” by consulting the first line. 

The completed entry looks like this: 

Purchases/AP 

Clark Pr LEARNED LUMBER CO. Dedi ts Credits 
For the month o ; 194. 194.29 a 

To pay vendor invoices, see the Select AP Payments “” 
command in the Function menu in Chapter 7: Pull-Down 
Menu Commands. 



CASH DISBURSEMENTS The Cash Disbursements Journal is used to record checks 

JOURNAL written from the checking account. A transaction consists 
of one or more balanced lines. You can type entries into 
this journal, or generate them with Select AP Payments or 

Generate Payroll in the Function menu, or with Recurring 

Entries. When you close the Cash Disbursements Journal 

window, Business Sense will offer to print the checks. 

When you click on the icon, the Cash Disbursements 

Journal (CDJ) window will appear: 

. Marvin/State 

. Marvin/sol 

Roberts /Payrolt eoecooooe 

The fields in the Cash Disbursements Journal window are: 

e Date of the transaction. 

e Net Amt of Check will balance to the total of the line 
item amounts on the right side. This amount is entered 

only on the first line of the transaction. 

e Paid to/Description up to the Slash will appear as the 
payee name if the Chart Of Accts list or Vendors list 
account has no address. If the account has an address, 

the payee name and address will come from the ac- 
count. 

e Check# will be automatically incremented from the 
previous check. If this is an unnumbered debit, such as 
a bank service charge, enter an asterisk (*) in the check 

number. Enter a check number the first time you use 
& this journal. 

e Account# from the Chart Of Accts list or Vendors list. 

e Cr indicates a credit line deducted from the check, as a 
pound sign. You can toggle the pound sign on and off 
by clicking on it with the mouse pointer. 

e Amount of this line item. Business Sense will propose 
the amount that will balance the transaction. Type over 
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the proposed amount if there will be more lines to this 
check. Enter negative amounts in parentheses, or click 
the Cr field to a pound sign. 

e AD is the alternate payee name and address code digit 
from the More Info pages of the Chart Of Accts. AD is 
not used for checks written to Vendors or Employees. ‘a, 

Example — Here’s the step-by-step procedure to write a check: 

Write a Check e Open the Cash Disbursements Journal window. 

e Date: Tab to the next field for today’s date. 

e Net Amt of Check: enter “87” and Tab to the next field. 

e Paid to/Description: enter “Hermosa Ford/Tune-up & 
LOF” and Tab twice to the account number. The next 

check number, 1254, will be filled in. 

e Account#: enter “6075” for Truck Maintenance. Since 

account 6075 has no addresses, the payee will be 
“Hermosa Ford.” The amount is already correct. 

The completed entry looks like this: 

LEARNED LUMBER CO. 
For the month of February , 1987 

ereerers Cece ee eeeeeeeere (CeCe eC errr eee eVreeeeeer eee Cee eee SEE) Pee 

eee See eee eeeeeee) COC e eee eee eee eee Cee Cee eee eee ees CO eee reer eee eee eee eee es Coe Cee eee eee eee ee 

Coe eeees Cee eee eee eee eee eee eee ee eee ee eee eee eee eee 

Teeeeeee See ee eee eee) Pee ee eee eee eee ee eee eee eee eee eee eee ees CCPC eee (CPPCC ee eeeeees Oe Cee eee ee ee eee) 

When you close the Cash Disbursements Journal window, 

you will be asked if you want the computer to print the 
check. The procedure given above works the same for 
manual checks and computer checks. 

The computer check would look as shown at the top of 

the next page. 
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LEARNED LUMBER CO. 

02/28/87 87.00 Hermosa Ford/Tune-up & LOF 1254 6075 

LEARNED LUMBER CO. 
6700 Hermosa Way 

Hermosa Beach. CA 90415 

#0987 Dollars and 00 Cents AMOUNT 
02/26/1937 $87.00 

Hermosa Ford 

SAMPLE - VOID 
FORM 091013 

COmPaTiOlE ENVELOPE O91Se8 - o81tes 

POOb2S&"@ #OOO00C7TEWGNE 225455 76" 

Example — To distribute a check amount to more than one account, 
Multiple Disbursement you will need as many lines as accounts. 

Check 
Here’s the step-by-step procedure to split the answering 

service expense between two accounts: 

& e Open the Cash Disbursements Journal window. 

e Date: Tab to the next field for today’s date. 

e Net Amt of Check: enter “116” and Tab to the next field. 

e Paid to/Description: enter “Answering Service” and Tab 
twice to the account number. The next check number 

will be filled in. 

e Account#: enter “606501” for Hermosa Beach Telephone 
Expense, and Tab to the next field. Business Sense will 

change the account to 6065/01. 

e Amount: enter “.5*116” to charge $58.00 of the check to 
the Hermosa Beach store. Tab to the next field. 

e AD: enter “1” to use the first alternate payee name and 

address from the Telephone Expense account in account 

6065/01. Press the Return key and Tab twice to the 
account number. 

& - e Account#: enter “606502” for Santa Monica Telephone 
Expense. The amount is already correct. 
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The completed entry looks like this: 

The computer check would look like this: 

LEARNED LUMBER CO. 

02/28/87 116.00 Answering Service 1255 606570! 
Y Answering Service 1253 6063/02 

LEARNED LUMBER CO. MATIOMAL STATE BANK 
6700 Hermosa Way DOWNTOWN OF FICE 

YOUR City, STate 12345 Hermosa Beach, CA 90415 payee 

#80116 Dollars and 00 Cents 

$116.00 

id 
To Tre ABC Answering Serv. 

ORDER 12235 Washington Biva. 
oF: SAMPLE - VOIO 

Marina del Rey, CA 90292 sani aaiese 

COMPATIOLE ENVELOPE Ouleee . oeieee 

#00382SS" OO00OG7H89KH £24456 768 

Example — This is just like a regular check, except the debit account is 
Prepay Expenses a Current Asset instead of an Expense account. Here’s the 

step-by-step procedure: 

e Open the Cash Disbursements Journal window. 

e Date: Tab to the next field for today’s date. 

e Net Amt of Check: enter “227.8” and Tab to the next 

field. 

e Paid to/Description: enter “State Farm Insurance Com- 

pany” and Tab twice to the account number. The next 

check number will be filled in. 

e Account #: enter “1031” for Prepaid Insurance - Trucks. 

The amount is already correct. 

The completed entry looks like the figure at the top of 
page 6-45. 
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CASH RECEIPTS 
JOURNAL 

=== —SSSSSSSSSSSS=_ Checki Cw —SSSeSeeeeSee== 

LEARNED LUMBER CO. Total this Batch 
Re 

The Cash Receipts Journal is used to record deposits to the 

checking account. A transaction consists of one or more 

balanced lines. You can type entries into this journal, or 

generate them with Apply AR Payments in the Function 
menu or with Recurring Entries. 

When you click on the icon, the Cash Receipts Journal 

(CRJ) window will appear: 

: WB - ——----—- —= -— Checkina-CRJ Sass 

LEARNED LUMBER CO Total this Batch 
For the month of F , 1987 

weceee 

8103.16 

1400 .00 Longy i ew Dev. - Paid Irn. r4 
eee e conor e oe 

The fields in the Cash Receipts Journal window are: 

e Date of deposit or date of sale. 

e Net Amt of Deposit will balance to the total of the line 
item amounts on the right side. This amount is entered 

on the first line only. 

e Received From/Description is reference information. 

e Ref should be your invoice number, if this is to be 
credited to a customer account. If you use Apply AR 
Payments in the Function menu, the generated entries 

will have the proper invoice numbers and customer 

account numbers. 

e Account# this is the customer account number for 
receipts on account, or a Revenue account for cash 

sales. 
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Example— 

Cash Sales 

6-46 Business Sense 

e Db is left blank for ordinary items. Debit items will have 
a pound sign here and will be deducted from the 
deposit. Click on the field to toggle it between a blank 

and a pound sign. 

e Amount of this line item. Business Sense will propose 
the amount that will balance the transaction. Debits can 

be entered in parentheses, or marked with a pound ie 
in the Db field. 

e TC is the Tax Code digit for this line item. If you have 
Set Sales Tax Codes in the Function menu and leave this 

column blank, the default sales tax code is applied. 
Business Sense tabulates cash sales and sales on account 

by Sales Tax Code. If you have not Set Sales Tax Codes, 

the Sales Tax report in the AR/AP/Payroll Report menu 
will not be available. 

Here is the step-by-step procedure to record cash sales, 

including taxable and non-taxable sales and sales tax 

collected: 

e Open the Cash Receipts Journal. 

e Date: Tab to the next field for today’s date. 

e Net Amt of Deposit: enter “3818.8” and Tab to the next 
field. 

e Received From/Description: enter “Cash Sales” and Tab “ 
to the next field. 

e Ref: enter “Feb Wk 5” and Tab to the next field. 

e Account#: enter “402001” for Hermosa Beach lumber 

sales, and Tab to the amount field. 

e Amount: enter “2200” and Tab to the next field. 

e TC: enter “1” to indicate sales for resale. Press Return to 

generate a new line. Tab twice to the account number. 

e Account#: enter “402001” and Tab to the amount field. 

e Amount: enter “1520” and tab to TC. 

e TC: press the Space Bar to use the default Sales Tax 

Code. Press Return to generate a new line. Tab twice to 

the account number. | 
e Account#: enter “2015” for Sales Tax Payable. The 

amount remaining to balance the deposit, $98.80, is 

already shown. “ 

The completed entry is shown on the top of the next page 



Example — 

Capital Contribution 

Total this Batch 

Here is the step-by-step procedure to record a capital 

contribution: 

e Open the Cash Receipts Journal. 

e Date: Tab to the next field for today’s date. 

e Net Amt of Deposit: enter “10,000”. The comma will be 
deleted. Tab to the next field. 

e Received From/Description: enter “Capital Contribution”. 
Tab to the next field. 

e Ref: enter “Ck #3407”. Tab to the next field. 

e Account#: enter “3000”, the Capital Stock account. 

e Amount is already filled in. 

The completed entry looks like this: 

LEARNED LUMBER Co. Total this Batch 
For the month of February , 1987 10000 .00 

ees Coe eee Peter reer ree reer eee eee eee eee reece eee eee SPCC rerrenl) Sere eCrrrrrrrre £2 errr ee rer ree re 

eee See eee eee Pee eee ee ee eee eee eee ee eee eee eee ee eee ees CC eee eee eee! Pee eee ee eee es ed Se 

ees Cee eee eee eee eee eee eee eee eee eee eee eee Sere eee ee! Se ee ee ee 

ee Cee eee eee) Cee eee eee eee ee eee eee ee eee eee eee eee eee! Cee eee eee eee Ce ere’ ee) See 

ee Cee eee ee ee eee ee eee ee eee eee eee eee See eee eee) See eee eee eee ee Pe ee 

eee See ee eee Pe ee eee eee eee ees Cee eee eee eee Pee ees Od Se ee 2 es 
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CHAPTER 7: 
PULL-DOWN MENU 
COMMANDS 

THE MENU BAR 
Chapter 7 contains step-by-step instructions for using each 

of the pull-down menus in the Business Sense menu bar. 

Six permanent and two occasional pull-down menus 
appear in the menu bar. When you reach the Main win- 

dow after starting the program, the menu bar appears at 

the top of the screen: 

& File Edit Function GL Report anise eeurels peor 

Tax Tables Recurring Entries 

ay Z oy 
Purchases / AP 

The following menus are displayed in the menu bar: 

é Contains typical Macintosh 
desk accessories, such as the 

Scrapbook, Note Pad and 

Calculator. 

close windows, set up page 
format for printing, print a list 
or journal or report, print 
mailing labels, export data to 

another program, choose 

between tabular reports and 
graphs, or quit the program. 

" File To uncover the Main window, 
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Edit To cut, copy or paste fields, 
insert or delete lines, find or 

underline lines, or calculate the 

balancing entry to complete an 

invoice. 

Function To set the date, calculate 
account balances, process year 

end, correct posted entries, — 

post payments to accounts re- 
ceivable, post customer finance 

charges, print billing state- 
ments, code sales tax catego- 

ries, select accounts payable 

invoices for payment, calculate 

payroll and enter budgets. 

GL Report To produce general ledger 
reports. 

AR/AP/Payroll Report To produce accounts receiv- 
able, accounts payable or 

payroll reports. 

Month Appears only when you have a 
data entry journal open. The 
Month menu allows you to 

select which month of journal 
entries will be displayed. 

index Appears only when the Help 
window or the Recurring 

Entries window is active. Lets 

you jump quickly to a named 

topic. 

To use the menus, move the mouse pointer to one of the 
titles in the menu bar and press the mouse button. Then 
drag the pointer down to the desired function and release 
the mouse button. Command-key shortcuts, shown beside 
the function name, provide the same result as dragging the 

pointer through the menu. To invoke a function via the 
Command-key shortcut, hold down the Command key 3§ 
and press the indicated character key. 

Depending on which window is active, some of the pull- 

down menu selections may be dimmed because they are 

not available. You can’t spend money unless the Cash 
Disbursements Journal window is open, so the Select AP 
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O 

~ 
pen Main Window 

ommand-O 

Payments and Generate Payroll commands in the Function 

menu will be dimmed. If you have selected a posted entry 

in a journal, or if no list or journal is open, you can’t 

Delete a Line or Insert a Line with the Edit menu. If the 

menu selection you want is dimmed, try opening another 

window or clicking in a different window to make it active, 

or select a different line in the window. 

THE & MENU 
The Apple menu contains standard Macintosh desk acces- 

sories that are part of the System file. For information 
about installing and using desk accessories, consult the 

Macintosh owner’s guide. 

THE FILE MENU 
The File menu contains commands to uncover the Main 

window, close windows, set up page format for printing, 

print a list or journal or report, print mailing labels, export 

data to another program, choose between tabular reports 
and graphs, or quit the program. 

The File menu looks like this: 

Open Main Window 

Page Setup 

Print 

Reprint Entry 

Print Mailing Labels 

Write to File 

If you have closed the Main window or covered it with 

other windows, you can open it and uncover it by select- 
ing this command. Then, you can click on an icon in the 

Main window to open its list or journal. You can also 

uncover the Main window by clicking on an exposed 

corner of it to activate and display it. Chapter 6: Main 
Window Icons discusses the functions and uses of the Main 

window icons. — 

Chapter 7: Menu Commands = 7-3 



Close 

Command-W 

Page Setup 

Print 

Command-P 

Reprint Entry 
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To close a window, select this function and the window 

will be removed from the screen. You can accomplish the 

same result by clicking on the square white “close box” in 
the upper left corner of a window. If you close the Main 
window, you can open it again with the Open Main 

Window function. ” 

When you select Page Setup, a dialog box will appear 
allowing you to specify how you want reports printed: 

ImageWriter (Standard or Wide) 

Paper: @US Letter © A4 Letter 
© US Legal © International Fanfold 
© Computer Paper 

Orientation: © Tall © Tall Adjusted O Wide 

Pagination: @Normal pages © No breaks between pages 

Reduction: @ None © 50 percent 

You can specify the paper size, print orientation, pagina- 

tion and reduction. See the Macintosh owner’s guide for 

additional information about these printer options. Click 
on the OK button to save the new settings, or click on the 

Cancel button to leave them unchanged. 

Whenever you have an active window showing a list, 

journal, report or graph, you can print the information by 

choosing Print. 

When you select Print, Business Sense will display the 
standard Macintosh printer dialog box asking you to 
specify print oe page range, number of copies and 
paper feed: 

ImageWriter (Standard or Wide) { 

Quality: © High @ Standard O Draft 

Page Range: = O From: [] To: [ 

Copies: 

Paper Feed: @ Continuous © Cut Sheet 

Click on the OK button to begin printing. “e 

You may reprint a check from the Cash Disbursements 

Journal, or an invoice from the Sales/AR Journal. Before 

choosing this menu function, open either the Cash Dis- 
bursements Journal or the Sales/AR Journal. Click to select 

the entry to be reprinted. 



Print Mailing 
Labels 

Two dialog boxes will appear. The first dialog box will ask 
you whether you want to print the special forms. Click on 
the OK button to proceed. Then a dialog box will ask you 

to prepare the printer. Put the proper forms into the printer 

and align them. Click on the OK button to begin printing. 

You can print mailing labels or prepare a print merge file 
when the Chart Of Accounts, Customers, Vendors or 

Employees window is active. 

When you choose this command, the program will display 

a dialog box: 

Generate Mailing List 

@ Send Mailing List to Printer. 

© Create Print Merge File. 

To print mailing labels, click on the Send Mailing List to 
Printer button. To prepare a text file containing the names 

and addresses, click on the Create Print Merge File button. 

If you choose label printing, the program will display a 

dialog box asking you to put labels into the printer. 

Business Sense prints on standard one-up 3.5-inch by 15/ 

16-inch mailing labels. 

Load the labels into the printer. Click on the OK button to 

Start the printer. 

If the labels are not aligned correctly, hold down the 
command key and press the period key (Command-.) to 

cancel printing. Advance the platen roller to the next label, 
adjust the label alignment and choose Print Mailing Labels 

again. 

CAUTION: Take care not to roll or slide the labels back- 
wards, as they will stick to the printer platen! 

If you Create Print Merge File, the program will generate 

an ASCII text file containing name, address1, address2, 

city/state, zip and attention for each record in the list. 
Fields are separated by tab characters and records are 

separated by carriage-return characters. 
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Write to File Business Sense data can be sent to other programs. You 
carf send lists, journals or reports to spreadsheets, graphing 
programs, data base managers, text editors and communi- 
cations programs. 

Open the list, journal or report you want to export. Then 
select Write to File. Business Sense will display a dialog 
box asking you to choose the format of the output file: 

Click a radio button to choose between Text, Multiplan/ “ 
Excel/Works or Jazz file formats. Selecting Text will pro- 
duce a tabular file of ASCII characters, with one line of text 
for each line in the selected list, journal or report. Selecting 
Multiplan/Excel/Works creates a file in “SYLK” format 
which can be read by many programs. Selecting Jazz 
creates a Jazz spreadsheet. 

Click on the OK button to create the file. 

@ Write to Text File 

© Write to Multiplan™/Excel™/Works™ 

© Write to Jazz™ Spreadsheet 

Tabular Reports Tabular Reports and Graphs (below) are alternatives to 
Commana-T each other. Reports whose names are underlined in the 

menu window can be displayed and printed in either 

Tabular or Graphs format. When you start Business Sense, 

a check mark will appear beside the Tabular Reports 
selection in the File menu. Reports will appear with names 

and numbers arranged in rows and columns. 

Here is an example of a Tabular report: 
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Graphs 
Command-G 

Quit 

Command-@ 

If Graphs has been selected, you can return to Tabular 

Reports format with this command. The check mark will 

move to Tabular Reports. The current report will change to 
Tabular format, and new reports will be created in Tabular 

format. 

Several Business Sense reports offer a Graphs version, so 

you can better visualize the significance of the information. 

Examples of the graphic reports are shown in Appendix D. 

To show you which reports can be displayed as Graphs, 

names of these reports are underlined in the menus. 

When you choose the Graphs command, the check mark 
in the File menu will move to Graphs. The current report 
will change to Graphs format if it can, and new reports will 

appear in Graphs format if they can. Reports not available 
in Graphs format will be unaffected by this command. 

Here is the same report with Graphs selected: 

=e Customer Anoalusis Sas ee 
4 N a U “Ide 

Customer Analysis 
For 3 months ending 3/31/1987 

Total Customers $31365.00 = 100 00% 

Tall Pines Estates $16356.00 = 52.14% 

Allen Contractors $6700.00 = 21.36% 

Ocean Front Sales $3900.00 = 12.43% 

Longview Dev. $3200.00 = 10.20% 

oO 

me 

% 

is 

a 

%; All Others $1209.00 = 3.85% 

When you have completed work with Business Sense, 
select Quit. Quit is dimmed until you Close all lists, 

journals and reports. When you select Quit, the program 

will terminate. Then, you should copy the company data 

folder onto a backup disk. You can then work with 

another program, or you can change data disks and restart 

Business Sense with another company’s data. Quitting the 

program is the proper way to finish your work, and assures 

that all changes and transactions will be recorded properly. 
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Cut 

Command-xX 

Copy 
Command-C 

Paste 

Command-V 

Clear 

7-8 Business Sense 

THE EDIT MENU 

The Edit menu contains commands to cut, copy, paste, 

insert or delete lines, find or underline lines, or calculate 

the balancing entry to complete an invoice. 

nip 

Delete a Line 

Insert a Line 

Find Name or Number 

Repeat Search 

Unselect All 

Complete Invoice 

First, select all or part of an entry field in a window. “ 

Selected text will appear in reverse-image (white on black). 
Choose Cut and the selected text is removed and put on 
the Macintosh Clipboard. You may Paste the selection into 

other fields until you change the Clipboard again with Cut 
or Copy. Cut and Paste allow you to move text from one 

field to another. 

Copy is used in exactly the same way as Cut, but the Copy 
command puts the selected text on the Clipboard without 
removing it. Copy and Paste allow you to duplicate text 
from one field to another. 

If you have Cut or Copied text on the Clipboard, you can 
Paste the text into another list or journal field by clicking 

where you want the text to go and then selecting Paste. If 

you select the entire field before choosing Paste, you will “Ye 

replace the field contents. If you have clicked twice and 
see a flashing insertion point in the field, Pasting will insert 

the Clipboard contents at this insertion point. 

Clear removes selected text without storing it on the 
Clipboard. It is not possible to Paste text that has been 
Cleared. 



Delete a Line Unposted entries in a journal or unused accounts in a list 

Commanad-D may be deleted with this menu function. You may not 

delete a journal entry after posting it. You may not delete 

an account after posting transactions to it. Click anywhere 

in the line that is to be deleted and then choose this menu 

command. The window will be re-drawn without that line. 

YY To delete more than one line: 

e Click the first line to be deleted. 

e Select Delete a Line, or press Command-D. 

e The next line of data will move up to where the first 
line was, and will be selected. 

e Select Delete a Line again as many times as necessary. 

You don’t have to wait for the screen to react. You can 

type the Command-key shortcut, Command-D, as fast as 

you like. : 

Insert a Line When you are working with a journal, you may Insert a 

Line anywhere among the unposted entries. In the Recur- 

ring Entries window or Help window, you may Insert a 
Line anywhere. 

Click to select a line in the window, then choose Insert a 

Line. The selected line will move down to make room for a 

& blank line. 

Insert a Line isn’t used with the Chart Of Accts, Customers, 

Vendors, Departments or Employees windows, because 
these lists are automatically kept in sequence by the 
program. To add a line to one of these windows, just type 

the new information into a blank line at the end of the list. 

When you close and reopen the window, the program will 

automatically sort the information into account number, 

department number or employee name sequence. 

More Info The list windows (Chart Of Accts, Vendors, Customers and 

Command-M Employees) display a More tab on the left side of the 
window to indicate which line is active. This tab is also 

used to call up additional information about that line. 

To view or modify this additional information, you can 

& click on the More tab. You can also pull down the Edit 
menu and select More Info. In either case, a dialog box 

containing the additional information will appear. Chapter 
6: Main Window Icons shows the additional information 
for each list. 

Click on the DONE button to return to the list window. 
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Find Name or Number If you can’t find an entry in a long list, journal or report, 

Commana-E Find Name or Number will search for a sequence of letters 
or numbers. This sequence does not have to be a complete 
name or account number. It might be a few letters or digits 

from the middle of a word. You can search either in the 

active window or in all open windows. 

Find Name or Number can also be used to underline lines “” 

in a list to prepare payables checks for selected Vendors or 

mailing labels for selected Customers. 

When you select Find Name or Number, a dialog box will 

appear: 

String/Number To Locate [ 

& Search From Top of List 

(J Search Only This Column 

J Underline Matching 

(| Search All Open Windows 

The following information is entered into this dialog box: “ 

e String/Number To Locate 
Enter letters or digits that appear in the entry you are 

looking for. You can search any open list, journal or 
report. 

You can search for: 

© An account number, such as 1050/0100. 

© An account name, such as FICA. 

o An employee name starting with Bak. 

© An employee ID number ending with the number 56. 

° A transaction amount of 1246.82. 

If you want to search only at the beginning or ending of 

a field, use the Vertical Bar key (|) to indicate the edge 

of the field. To find a match on the first few characters 
in a field, enter a Vertical Bar followed by the search “ 

characters, for example, “|bak”. If you want to search 

only at the end of a field, enter the characters followed 

by a Vertical Bar, for example, “561”. The Vertical Bar 
key is located either above the Return key or to the right 

of the Space Bar. 
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The Find Name or Number command is not case- 

sensitive. Corresponding capital letters and lowercase 
letters will match. 

Search options are controlled with check boxes. You 
can select combinations of these options: 

o Search From Top of List 
If you’re not sure where the name or number may be 

found in the document, leave this check box 
checked. If you click this check box off, the search 
will start from the currently selected field in the 
document. 

o Search Only This Column 
If you know which column contains the name or 

number, click anywhere in the appropriate column to 
be searched before you select the Find Name or 
Number command. 

co Underline Matching 
Underlining is a method of selecting multiple lines in 
a list of Employees, Customers, Vendors or Chart Of 
Accts. This allows selective processing for many 
Functions, selective Reports and selective printing of 
mailing labels. Underlining works with the following 
commands: 

File menu 

Print Mailing Labels 

Function menu 

Apply Finance Charges 
Billing Statements 

Select AP Payments 

Generate Payroll 

GL Report menu 

General Ledger (Selected Chart of Accts, Customers 

and/or Vendors) 
AR/AP/Payroll Report menu 

AR Aging 

Sales Commissions (selected Employees) 
Customer Analysis 

AP Aging 

Vendor Analysis 

1099 Forms 
Payroll 

W-2 Forms 

If any records are underlined in an open window, 
then only those records will be processed by the 
command. If no records are underlined, or if the list 

window is closed, then all records will be processed. 
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Underline Matching will be dimmed if you have only 
a journal or report window open, since it requires 
lists. Underline lines in a list and then invoke the 

selective Function or Report. 

When you search with Underline Matching turned on, 

all lines matching the String/Number To Locate will 

be underlined. If you invoke Find Name or Number 

again, you can underline additional lines. Find Name 

or Number only turns underlining on, never off. This 
means you can combine the results of several 

searches to underline lines satisfying any of several 

criteria. 

To turn underlining off, choose the Unselect All com- 

mand in the Edit menu. You can also toggle underlin- 

ing off and on by holding the Command key down 

while clicking on a line in the list. 

o Search All Open Windows 
If this option is checked, then all open windows will 

be searched; otherwise only the active, topmost 
window will be searched. 

Click on the Find String button to start searching. 

You will discover many ways to use Find Name or Num- “ 

ber. Here are four examples: 

Example 1 — Find the Telephone account in the Chart 
Of Accts. 

e Open the Chart Of Accts window. 

e Select Find Name or Number from the Edit menu. 

e Enter “tele” in the String/Number To Locate edit box. 

This will match with “...Telephone...” 

e Click on the Find String button. 

e If you are using the Demo Data files, Business Sense 
will find a match at account no. 6065, “ Telephone,” and 
will scroll the Chart Of Accts window to the account. 

Example 2 — Find check #1238 in the Cash Disburse- 
ments Journal. 

e Open the Cash Disbursements Journal window. “ 

e Select Find Name or Number from the Edit menu. 

e Enter “1238” in the String/Number To Locate edit box. 

e Click on the Find String button. 

e In the Demo Data files, check #1238 was a payroll 
check for John Brown, written February 15th. 
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Example 3 — Find a transaction for 3408.00. It might be 
in the Cash Receipts Journal, the Sales/AR Journal or the 
General Journal. 

e Open the Cash Receipts Journal window. 

e Open the Sales/AR Journal window. 

e Open the General Journal window. 

e Select Find Name or Number from the Edit menu. 

e Enter “3408.00” in the String/Number To Locate edit 

box. 

e Click on the Search All Open Windows check box to 

search all three journals. 

e Click on the Find String button. 

e In the Demo Data files, this is the amount of Invoice 

#23127 in the Sales/AR Journal. Business Sense will 

expose the Sales/AR Journal and scroll it to the match- 
ing entry. 

Example 4 — Run payroll for only the hourly employees. 

e Open the Employees window. 

e Select Find Name or Number from the Edit menu. 

e Click on the Underline Matching check box to underline 

' e Enter “hour” in the String/Number To Locate edit box. 

all hourly employees. 

e Click on the Find String button to start the search. 

e All hourly employees are now underlined in the Em- 

ployees window. 

e Open the Cash Disbursements Journal icon from the 
Main window. 

e Select Generate Payroll from the Function menu. 

e Payroll journal entries have been generated into the 

Cash Disbursements Journal window. The General 

Journal window has been opened and contains addi- 

tional payroll journal entries. 

e Review the journal entries for correctness. To adjust data 

values such as hours worked, or to fix a deduction, use 

Delete a Line from the Edit menu repeatedly to erase 

& the payroll entries from both journals before generating 
the payroll again. 

¢ Close the Cash Disbursements Journal window. Business 
Sense will ask if you want to print the paychecks. 

Chapter 7: Menu Commands 7-13 



Repeat Search 

Command-A 

Unselect All 

Command-U 

Complete Invoice 

Command-minus 
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If Underline Matching is not checked, Business Sense stops 

on the first matching entry, selects it and scrolls the 
window to display the match. If you want to find another 

line containing the same string, select Repeat Search. You 

can repeat this command until all matches have been 
found. 

List lines stay underlined until you turn underlining off “ 

with this command. This means you can underline addi- 

tional records by repeating the Find Name or Number 

command with different search criteria. Underlining is 

temporarily turned off by closing the window, but it comes 

back when the window is opened again. Accidental 

underlining in an open window causes records that aren’t 

underlined to be overlooked. Use Unselect All to ensure 
that you generate Billing Statements for all Customers and 

Generate Payroll for all Employees. 

If you are preparing invoices in the Sales/AR Journal, 

Business Sense can calculate sales tax and total the line 

items for you. 

The first line of an invoice debits the total invoice amount 

to the customer account number. Enter the customer “ 
account number, but leave the total invoice amount blank 

for now. Then, enter detail lines crediting the invoice line 

items to Revenue accounts. As you enter each line, enter 

the appropriate Sales Tax Code. Sales Tax Codes and tax 
rates are entered via the Set Sales Tax Codes command in 

the Function menu. A typical invoice is shown below, 

before Complete Invoice is chosen: 



After you have entered this information, choose the 

Complete Invoice command. If the last line of the invoice 
does not refer to a Revenue account, the calculated tax will 

be placed in the credit column of that line. If the last line 
refers to a Revenue account, then a new line will be 

created containing the total sales tax amount. The total 

amount of the invoice will be calculated and displayed in 

the first line. If you have not filled in the Sales Tax Codes 

list, only the total amount of the invoice will be calculated. 

After choosing the Complete Invoice command, the same 

invoice would look like this: 

Now, after you fill in the description and account number 

for sales tax, you’re done: 
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THE FUNCTION MENU 
The Function menu is used for setting the date, calculating 
total activity to an account, year-end processing, correcting 
posted entries, posting payments to accounts receivable, 
posting customer finance charges, printing billing state- 
ments, coding sales tax categories, selecting accounts 

payable invoices for payment, calculating payroll and 
entering budgets. 

The Function menu looks like this: 

Function 

New Date 

Account Balance 

New Fiscal Year 

New Calendar Year 

New Data Disk 

Fix/Adjust Entry 
Hash Totals 

Apply AR Payments 

Apply Finance Charges 

Billing Statements 

Set Sales Tax Codes 

Enter Budget Information 

New Date Although the Macintosh keeps track of today’s date auto- 
Command-N matically, there are occasions when you must use an 

artificial date. Before you choose the New Fiscal Year 
command, you must set the date back to the last day of 
your old fiscal year. Use it to run the payroll a day early, or 
use it for automatic transaction dating of yesterday’s sales. 

The new date will be known only to Business Sense and 
will not disturb the calendar in your Macintosh. When you 
select New Date, a dialog box will appear: 

Type in new date. “ 

Month: 02 | 

Day: 28 | 
Year: 
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Account Balance 

Command -L 

Use the Tab key to move from box to box. Enter leading 
zeros for months before October and days before the tenth 

of the month. Click on the OK button when the date is 

correct, or click on the Cancel button to leave the date 

unchanged. Don’t forget to come back to today’s date for 

today’s work. 

When transferring balances between accounts, use this 

command to check the balance. It works for any account 

in the Chart of Accts, Vendors or Customers lists: 

¢ Select this command and a dialog box will appear: 

Account name 

Account number [ 

Account balance 

Choose either one month 

or a period of months. 

@© Jan © July 

@ Feb © Aug 

O Mar O Sept 

O April © Oct 

O May O Nov 

© June O Dec 

e Select the account number: 

© If you know the account number, Tab to the Account 
number edit box. Enter the Account number and 

click on the Show button. 

© If you don’t remember the account number, use the 
name lookup shortcut explained in the Operating 
Techniques Section of Chapter 3: Tips for Users: type 

the first few letters of the name, click on the Show 

button and fine-tune with the arrows. 

e Choose either an individual month or a series of 

months. To select a series of months, click the starting 

month and then the ending month. 
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e Click on the Show button. The account balance for the 

indicated time period based on entries in all journals 
will be calculated and displayed: 

Account balance 45164.32 

Choose either one month 

or a period of months. 

@® Jan © July 

@ Feb © Aug 

O Mar © Sept 

© April O Oct 

© May © Nov 

© June © Dec 

e Click on the Show Graph button to see a time line of 
the account balance: 

Account number [1010] 
Account Balances by month. Show Text 

From the Graph window, click on the Show Text button to 
change the time period or to see the dollars and cents 
amount. 

From either window, click on the Done button to end the 
command, or click on the Show button to look up anoth 
account, or click on the arrows to scroll through the “ 
accounts. 
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New Fiscal Year When you have completed all of the entries for your 
present fiscal year and are ready to close the books and 

begin a new year, this is it. It’s time to close the books. 

Earlier accounting software forced users to close the books 

every month. With Business Sense, the books stay open 

for all months all year long. Until you close the fiscal year, 

you can’t enter transactions for the new year, and after you 

close the fiscal year, you can’t make any more entries for 

the old year. 

New Fiscal Year has the following effects: 

e Closed invoices are eliminated. Open invoices are 

individually brought forward. 

e Income Statement accounts (Revenue, Returns, CGS, 

Expenses and OINC accounts) are used to calculate the 

net profit, which is posted to the Close account. Corpo- 

rations typically name the Close account “Retained 

Earnings.” Proprietorships and partnerships usually 

distribute the Close account immediately into the equity 

account(s). 

e After the profit is posted to the Close account, the 

Income Statement accounts are zeroed. 

e Balance Sheet accounts will forget their old activity. 
Opening balance entries will be generated in the 

General Journal. 

To start a New Fiscal Year: 

e Run the General Ledger report from the GL Reports 
menu. Before printing it, make sure you have enough 

paper for this massive report. 

e Make two copies of the data disk containing the old 
year’s information. Keep your original data disk in a safe 

place and keep the copy off-site. Use the second copy 
to run the New Fiscal Year. 

e If today is already part of the new fiscal year, choose 

the New Date command from the Function menu. 

Change the date back to the last day of the old fiscal 

year. For example, if your fiscal year begins July 1, 

change the date to June 30th. 

e Choose New Fiscal Year from the Function menu. A 

dialog box will remind you to set the date and will ask 

if you want to close the books. Click on the I'VE MADE 

SURE button to proceed. 
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New Calendar Year 
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e Business Sense will ask you again to confirm your 

request, because after you close the year you can’t make 

any more entries or corrections for that year. 

e Click on the YES button to proceed. Business Sense will 

calculate the net profit and will post this amount to the 

Close account. Income Statement accounts will be reset 

to zero. Then, for Balance Sheet accounts, Business 

Sense will generate opening-balance journal entries in 

the General Journal, like these: 

General Journal 

LEARNED LUMBER CO. 
For the month of Janu. 1967 

«Open Books 01/01» 

«Open Books 01/01» 

«Open Books 01/01» 

«Open Books 01/01» 

«Open Books 01/01» 

«Open Books 01/01» 

«Open Books 01/01» 

Use this command to delete payroll, sales tax, customer 

history and vendor history information for the prior 
calendar year. 

After the new year starts, until you issue this command, 
Business Sense will display an alert box when you open 

the Main window. 

At the New Calendar Year, you have to close the payroll 
and sales tax records. Until you close the calendar year, 

you shouldn’t enter sales or run payroll for the new year, 

and after you close the fiscal year, you shouldn’t change 

payroll or sales records for the old year. 

If your Fiscal Year is the same as the calendar year, you 
should run New Calendar Year first and then run New 

Fiscal Year immediately afterward. 

To start a New Calendar Year: “ey 

e Run the Sales Tax, Sales Commissions, Customer 

Analysis, Vendor Analysis, 1099 Forms, W-2 Forms and 

Payroll reports from the AR/AP/Payroll Reports menu. 

e Make two copies of the old year’s information. Keep the 
original data disk and one copy for future reference. 



e Use the second copy disk to make the New Calendar 

Year disk. 

e Choose the New Calendar Year command. The program 

will ask if you want to continue. 

e Click on the YES button to confirm your command. The 

program will ask you to reconfirm your intention. 

Y e Click on the YES button. Business Sense will zero year- 
to-date amounts for data maintained on a calendar year 

basis. 

New Data Disk An alert box will warn you when you have nearly filled up 

your data disk. Use the New Data Disk command to 

summarize the journals, to make space for more transac- 

tions. New Data Disk will also make Business Sense run 

faster. New Data Disk does not change account balances. 

The summary data includes enough information to run 

financial reports for any month. Open invoices will be 
retained in the Sales/AR and Purchases/AP journals. 

To make a New Data Disk: 

e Run a copy of the General Ledger report from the GL 

Reports menu. Have plenty of paper in the printer. 

e Make a copy of your present data disk. Save the original 

data disk and use the copy to make the New Data Disk. 

e Choose New Data Disk. 

e An alert box will appear asking you if you want to 

continue the year on a new disk. Click on the YES 

button to proceed. 

e Another alert box will ask you to reconfirm your choice. 

Click on the YES button and your data disk will be 
summarized and updated to give space for more 
transactions. 
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Fix/Adjust Entry 
Commanda-F 
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4 Fix/Adjust Entry is used to correct errors in posted transac- 

tions. Since Business Sense forbids deleting or modifying 

posted transactions, Fix/Adjust Entry works by generating 
new journal entries citing the original entries. 

Open the journal containing the error and click anywhere 

on the line of the entry that you are going to correct. Now 

choose Fix/Adjust Entry and a dialog box will appear: | 

@® Posted to wrong account 

© Debits and credits reversed 

© Void a Check 

© Uoid a Deposit 

© Reverse Entry 

© Credit Memo 

Depending upon which journal you are correcting, some 

selections will be dimmed. If an invoice has already been 

paid, Posted to wrong account will be the only choice. 

Choose the type of adjustment with a radio button and 

Business Sense will automatically generate the adjusting 
entry. 

There are six kinds of adjusting entries. 

e Posted to wrong account corrects a single line of a 
multiple-line entry. All other choices fix a complete 

entry. Since you will be adjusting a single line, make 

sure you have selected the exact line which was mis- 

posted before choosing Fix/Adjust Entry. 

In the Cash Receipts Journal or Cash Disbursements 
Journal, one entry is always cash. To correct wrong 

accounts in Cash Receipts or Cash Disbursements, you 

must first open the General Journal window and then 

the journal containing the error. Business Sense will 

make the correcting entry in the General Journal. “oy 

An additional dialog box will appear asking you for the 
account number to which the line should have been 
posted: 



Correct Account No. 

Account number [ —t 

[acs 
The program will then generate a two-line entry, one to 

reverse the error account and the other to post the 

correct account. Here is a Purchases/AP invoice which 
was posted to account 1510 instead of 1511, followed 

by the correction generated to fix the error: 

e Debits and credits reversed generates a reversing 
transaction for twice the amount of the error transaction. 

Here is a Purchases/AP transaction and its correction: 

e Void a Check generates copies of the lines that 
appeared in the original check, with negative amounts. 
Here is a multiple-line Cash Disbursements Journal entry 
and its voiding entry: 

iC Z ' 

02/15|__1119.22|Sara 8. Rober ts/Poyro!! [1242 |eoes/o1 | | 1650.00] 
__...[__.......-__ |Sara_8._ Rober ts/Freseral__11242_ [2018/0001 |s] 261.00 
aes naa ~{|Sore 8. Rober ts/FICA 1242 [2018/0002] | ____117. 90 

ik ees {Sora 8. Roberts/Stote {1242 |2019/0001|*] 132.001. 
‘Jsora 8. Roberts/so!______{1242_ [2o19ro002}e]__19..80| 

Fr NORA «1119.22 >|Yold Check of 02719 [izaz Jeossvo1 | T <1es0 00> 
Fe DNase wold Check of 02/15» _..11242__|201@70001/] | <261.00> 
ae Penner wold Check of 02/ 15m... | 1242. |2018/0002|#| | <117 98 
anid Some = wold Check of 02/15»... 11242. |20197000; 8] 132,00 , 

«oid Check of 02/15» 1242 |2019/0002/|* €19.80> 

Chapter 7; Menu Commands 7-23 



Hash Totals 

Command-= 
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e Void a Deposit generates copies of the lines that 
_ appeared in the original cash receipt, with negative 

amounts. Here is a multiple-line Cash Receipts Journal 

entry and its voiding entry: 

“'|«Woid Deposit of 02/23» 

‘'l«VYoid Deposit of 02/23» 

e Reverse Enfry generates a mirror-image transaction to 
eliminate the effect of the error transaction. Here is a 

Purchases/AP transaction with its reversing entry: 

Le 

e Credit Memo works the same as Reverse Entry, but it 
generates a “Credit Memo” description suitable for 

itemized accounts payable checks and Billing State- “ 

ments. Here is the same Purchases/AP entry reversed 

with a credit memo: 

200 Boxes #10 Nails 

“|Purch 200 Boxes *10 Nails |s5703c |20s0/02s0]_—s«|——=sia2. 

If you are working with the General Journal, Sales/AR 
Journal or the Purchases/AP Journal, you can use this 

command to see the total unposted debits and credits in 
the window. Use Hash Totals to calculate the total value of 
a batch of invoices for your control log. If you haven’t 

entered any new transactions, the command will be 

dimmed in the menu. This command is always dimmed in 

the Business Sense Demo Program. . 



When you select this command, the Hash Totals will 

appear in a dialog box: 

Hash Totals: 

Debits 1065.00 

Credits 1000.00 

Click on the OK button to return to the journal. 

Apply AR Payments To post cash receipts from your charge customers, use 
Commanad-R Apply AR Payments. If you post the money directly into 

the Cash Receipts Journal, open invoices might not be 
properly matched and closed. 

This is the process: 

e Open the Cash Receipts Journal, to receive the payment 

entries. 

e Select Apply AR Payments and this dialog box will 

& appear: 

Apply AR Payments 

> Account Number [ i 

e Select the customer account: 

© If you know the account number, Tab to the 
Account number edit box. Enter the Account 

number and click on the Show button. If the right 

number appears, click on the OK button. 

© If you don’t remember the account number, use the 
name lookup shortcut explained in the Operating 
Techniques Section of Chapter 3: Tips for Users: 
type the first few letters of the name, click on the 
Show button and fine-tune with the arrows. Click 
on the OK button when you reach the right ac- 

count. 
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e The Customer Ledger Card, showing one line for each 

open invoice for this customer, will appear: 

e To pay off an invoice: 

© To apply the full invoice amount, click on the invoice 
and click on the Pay Off Invoice button in the upper 
right-hand corner of the window. Repeat this process 
for each invoice you want to pay off. 

© To apply a partial payment, type in the Amount Paid 
and click on the Pay Off Invoice button. 

© To credit discounts taken, type in the Discount Taken 
and click on the Pay Off Invoice button. After paying 

off the invoices, the window looks like this: 

Total this Batoh LEARNED LUMBER CO. 
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e Close the Customer Ledger Card window. The invoices 

that you have paid off will now appear as entries in the 
Cash Receipts Journal: 

e Process additional customers the same way. 

e Close the Cash Receipts Journal. 

Apply At the end of the month, you can calculate finance charges 

Finance Charges on overdue invoices. Business Sense will automatically 

generate entries for these charges, and they can be printed 

as invoices. 

To use this command: 

e Open the Sales/AR Journal. 

e Select Apply Finance Charges. 

e Business Sense will scan open invoices, checking the 

invoice date. For each customer, the rules for days 

allowed, percentage charge and minimum charge are 

Y consulted in the Customers list. 

e The Sales/AR journal will reappear with finance charge 
entries added: 

e Review these charges. Delete pairs of lines if you decide 
to eliminate a finance charge. The Invoice # shown is 

the number of the overdue invoice. 

e Close the window. You will be asked if you want to 

print invoices. 
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Billing Statements You can print Billing Statements for customers at any time. 

To prepare Billing Statements: 

e To print statements for selected customers, underline 

their names in the Customers window. 

e To print statements for all customers, close the Custom- 

ers window or Deselect All in the Edit menu. 

e Select Billing Statements and a dialog box will appear: 

CustomerName[ 
Account Number fee ot = 

CJ Do Statement for Selected Customer 

e To print a statement for a single customer, enter the 

customer account number or use the name lookup 

shortcut from the Operating Techniques Section of 

Chapter 3: Tips for Users. 

e To print statements for multiple customers, leave the 
Customer Name and Account Number edit boxes bank @® 

or click off the Do Statement for Selected Customer 

check box. 

e Click on the OK button to proceed. 

e A dialog box will remind you to put Billing Statement 

forms into the Printer. Align the Billing Statement forms 
about 1/4" from the left edge of the printer and locate 
the top of the form just above the print head. 

e Click on the OK button to print the statements. 
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Set Sales Tax Codes To track sales taxes and tax-exempt sales, use Sales Tax 

Codes in the Sales/AR Journal and Cash Receipts Journal. 

To enter or change these codes and tax rates, use the Set 

Sales Tax Codes command. A dialog box will appear: 

Set Sales Tax Codes 

Sales for Resale 

Out of State Sales 

No Tax General 

Tax Rate 1 [6.50 |% 

Tax Rate 2 [6.00 |% 

Tax Rate 3 [ _|z 

TaxRate4 [ —|% 
Tax Rate 5 | |% 

Tax Rate 6 [| _|z 

TaxRate? [| —— |% 

Use one-digit codes for different sales tax rates and to 

distinguish non-taxable sales categories. 

Assign a digit to every code but one. Leave the most 

frequently used code blank, as the default code. When you 

make entries in the Sales/AR and Cash Receipts Journals, if 

you leave the code blank, the default tax rate will be 

applied automatically to any line containing a Revenue 
account. 

You should leave only gne code blank. Number the others 

from 1 to 9, even if you don’t intend to use them. 

Click on the OK button to save the new codes and rates, 

or click on the Cancel button to leave them unchanged. 

Chapter 7; Menu Commands 7-29 



Select AP Payments To pay vendor charge invoices, use Select AP Payments. If 

Commana-S you write the checks directly from the Cash Disbursements 

Journal, open invoices won't be properly matched and 

closed. 

To pay groups To pay groups of invoices according to due dates or 

of invoices discount dates: 

e To process specific vendors, select vendor accounts with 

underlining in the Vendors window. 

e To process all vendors, close the Vendors window or 

choose Unselect All in the Edit menu. 

e Open the Cash Disbursements Journal, for the payment 
entries. 

e Choose Select AP Payments. This dialog box will 
appear: 

Account Number & 
4 

[] Select Individual Vendor (snow | 

C] Preview As A Report L SHOW | 

© Pay Individual Invoices “y 

@ Pay All Invoices 

© Pay All Discountable 

© Pay All Due Through[ | CANCEL 

e To pay multiple vendors, leave the Vendor Name and 

Account Number edit boxes empty. 

e To see which invoices will be paid, click on the Preview 
As A Report check box. 

e Choose one of these three radio-buttons only: 

© Pay All Invoices. 

© Pay All Discountable. 

© Pay All Due Through a specified date, and fill-in the 
date. 

e Click on the OK button. Business Sense will scan the 

Purchases/AP Journal and will pay invoices meeting the 
specifications. The proposed payments will be shown in 
the Cash Disbursements Journal. 

e Review the entries. These checks have not yet been 
posted, so you can edit them. 
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e You can Delete a Line with Command-D or by choosing 
Delete a Line in the Edit menu. If the check had mul- 

tiple lines, adjust the check amount. To delete a check, 

delete all its lines. If you delete a check, the appropriate 

invoices will remain open in the Purchases/AP Journal. 

e Close the Cash Disbursements Journal. Business Sense 

will ask if you want to print checks. 

To pay individual To select and pay invoices on an invoice-by-invoice basis: 
invoices 

e Open the Cash Disbursements Journal, for the payment 

entries. 

e Choose Select AP Payments and a dialog box will 

appear. 

e Select a vendor: 

© If you know the vendor account number, Tab to the 
Account Number edit box. Enter the Account Number 

and click on the Show button. 

© If you don’t remember the account number, use the 
name lookup shortcut explained in the Operating 

Techniques Section of Chapter 3: Tips for Users: type 
the first few letters of the name, click on the SHOW 

Y button and fine-tune with the arrows. 

e Click on the Pay Individual Invoices radio button. Here 

is the dialog box when you are ready to consult the 
invoices: 

Vendor Name |fAcme Sash & Frame 

Account Number | 2050/0150 at 

XX] Select Individual Vendor 

(] Preview As A Report 

@ Pay Individual Invoices 

© Pay All Invoices 

© Pay All Discountable 

© Pay All Due Through [| CANCEL 

e Click on the OK button. 

e The Vendor Ledger Card, showing one line for each 

open invoice for this vendor, will appear as shown at 
the top of page 7-31. 
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e To pay off an invoice: 

© To pay the full amount, click on the line to be paid 
and then click on the Pay Off Invoice button in the 

upper right-hand corner of the window. Repeat this 

process for each invoice you want to pay Off. 

© To make a partial payment, type in the Amount To 
Pay and click on the Pay Off Invoice button. 

© To take discounts, type in the Discount Taken, then 
click on the Pay Off Invoice button. After taking a 2 

percent discount and paying off the invoices, the “ 

window looks like this: 

Total this Batch LEARNED LUMBER CO. 



e Close the Vendor Ledger Card window. The invoices 

that you have paid off will now appear as entries in the 

Cash Disbursements Journal: 

e Process additional vendors the same way. 

e Review the checks proposed. These checks have not yet 

been posted, so you can edit them. 

e You can Delete a Line with Command-D. If the check 

had multiple lines, adjust the check amount. To delete a 
check, delete all its lines. If you delete a check, the 

appropriate invoices will remain open in the Purchases/ 
AP Journal. 

e Close the Cash Disbursements Journal. Business Sense 

will ask if you want to print checks. 

QD cenerate Payroll Business Sense will calculate the gross pay, withholding 

and net pay for all employees or selected employees, 

based on hours, pay rates and withholding information 

stored in the Employees list. The program also creates 

General Journal entries for the employer FICA contribution. 
You can then print paychecks with itemized deductions. 

Here’s how to run a payroll: 

e Adjust hours worked, pay rates and employee withhold- 

ing in the Employees window. 

e If you want to pay selected employees, you can under- 
line their names in the Employees window with the 

Find Name or Number command from the Edit menu, or 

command-click on their names. Leave the window open 
while you Generate Payroll to process only underlined 

employees. 

e If you want to pay all employees, turn off underlining in 

the Employees window, or close the Employees win- 
dow. 

¢ Open the Cash Disbursements Journal. 

e Select Generate Payroll. A Dialog box will ask you to 

confirm your choice. 
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e Click on the YES button. 

e The Cash Disbursements Journal will reappear with the 

amounts of withholding and the net wages displayed: 

. David/Federal 

. David/FICA 

. Daid/State 

. David/sol 

, Pete:80 x 10.00/Hr 

. Marvin/Federal 

. Marvin/FICA 

. Marvin/State 

a . Marvin/Sol 

1119.22 

a0 . Rober ts /Federa!l 

a . Roberts /FICAR 

. Rober ts/State 

. Rober ts/SOI 

e Behind it, the General Journal contains employer FICA 

contributions: 

. Brown /Payrol! Tax 

e Before running the checks, review the enties. If you 

discover an error, you can Delete a Line with Com- 

mand-D multiple times to delete a check or delete the 
whole payroll. Don’t forget to delete the corresponding 

employer FICA withholding entries in the General 

Journal as well. 

Enter Budget Budget comparisons can appear on Income Statements and 
Information Departmental Income Statements. After you use this 

command to enter budget data, you can click on the radio 

button “Include Budget Information” when you choose 
Income Statement or Department Income in the GL “"—@ 

menu. 
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To enter or revise budget data: 

e Select Enter Budget Information. 

e A wide window containing Income Statement accounts 

will appear. There are 12 monthly budget fields for each 
account. 

e Enter the first month budget amount for each account, 

using the Return key to advance to the next account. 

Since most budget items are the same for every month, 

Business Sense will immediately copy the first month’s 

budget amount into all subsequent months. 

e For budget items that change from month to month, 

enter the monthly amounts from left to right, using the 

Tab key to advance through the months. 

e Enter budget amounts for master accounts, such as 

4010, as well as for sub-accounts, such as 4010/01 

and 4010/02. 

e Here is the window for the Demo Data files, with 

budgets already filled in: 

di” heeds btthccbdee dando 

e To scroll through the months, either drag the window 

title bar right or left, or use the Tab key to go from 

month to month. 

e To scroll through the accounts, either use the scroll bar 

on the right side of the window, or use the Return key 

to move the cursor down. 

e Before you print the Budget Information, use Page 

Setup in the File menu to select Wide (sideways) 
printing and 50 percent reduction. 
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THE GL REPORT MENU 
The GL Report menu contains a list of the general ledger 

reports. 

You can view a report on the screen by selecting it in the 

menu. Then you can print it by choosing Print from the 

File menu. Business Sense displays one report at a time, ‘a. 

so you should close your report before requesting another 

one. 

Examples of all reports are shown in Appendix D. 

The GL Report menu looks like this: 

GL Report 

income Statement 

Department income 

Balance Sheet 

Trial Balance 

Financial Ratios 

Check Register 

Cash Flow Analysis 

Account History 

General Ledger 

If the report name is underlined, the report is available in 

both Tabular and Graphs format. Choose the format in the 
File menu. 

If you find a report selection dimmed in the menu, open a 
Cash Disbursements or Cash Receipts Journal window. 

All reports except the General Ledger report are first 

displayed on the screen. 



income Statement 

Department Income 

The Income Statement can be generated as a tabular 

statement or pie chart. 

When you select the Income Statement, a dialog box will 

appear: 

income Statement 

@© Normal Income Statement 

© Include Year to Date 

© Include Budget Information 

Choose either one month 

or 8 period of months. 

@ Jan O July 

@ Feb © Aug 

O Mar O Sept 

O April O Oct 

© May O Nov 

© June O Dec 

By clicking on the radio buttons you can add year-to-date 

figures or budget and variance comparisons to the Tabular 

version of the report. 

Select one month, or select a series of months by clicking 
the first month and the last month. 

Click on the OK button and the report will appear. 

This report is similar to the Income Statement except that 

the information is for a single department, profit/cost 
center or project. The report is available in either tabular or 

pie chart form. To change the format, select Tabular 
Reports or Graphs in the File menu. 

When you select Department Income, a dialog box will 

appear: 

Departmental income 

& Department number [| —! 

@ Normal income Statement 

O Include Year to Date 

© Include Budget Information 

@ Jan O July 

@ Feb © Aug 

O Mar O Sept 

© April © Oct 

© May O Nov 

© June O Dec 
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Select a department: 

e If you know the department number, Tab to the Depart- 
ment number edit box. Enter the department number 

and click on the Show button. 

e If you don’t remember the department number, use the 

name lookup shortcut explained in the Operating 

Techniques Section of Chapter 3: Tips for Users: type 

the first few letters of the name, click on the Show 

button and fine-tune with the arrows. 

By clicking on the radio buttons you can add year-to-date 

figures or budget and variance comparisons to the Tabular 

version of the report. 

Select one month, or select a series of months by clicking 

the first month and the last month. 

Click on the OK button and the report will appear. 

Balance Sheet When you select the Balance Sheet, a dialog box will 

appear where you may choose a month for the report: 

Balance Sheet 

Choose one month. 

Quan Oduly “wy 
@ Feb © Aug 

O Mar © Sept 
O April O Oct 

© May © Nov 

O June O Dec 

Click on the OK button to generate the report. 

Trial Balance When you select Trial Balance, a dialog box will appear: 

Trial Balance 

Choose either one month 

or a period of months. 

(CJ Show zero balance accounts. 

CD Show Individual Customers. 

OCD Show Individual Vendors. 

@ Jan O July 
@ Feb 

O Mar 

O April 

O May 
O June 
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If the check box is turned on: 

e Show zero balance accounts prints the entire Chart 
of Accts including the accounts with zero balances. 

e Show Individual Customers appends the Customers 
list with balances due instead of a summary receivables 

total. 

Y e Show Individual Vendors appends the Vendors list 
with balances due instead of a summary payables total. 

Select one month, or select a series of months by clicking 

the first month and the last month. 

Click on the OK button and the report will appear. 

Financial Ratios This report calculates a list of business financial ratios used 

by banks, managers and investors to measure the strength 
of a company. The formulas used are given in Appendix E. 

When you select Financial Ratios, a dialog box will appear: 

Financial Ratios 

Choose either one month 

or a period of months. 

& @ Jan O July 

@ Feb © Aug 

O Mar © Sept 

O April © Oct 

O May O Nov 

© June © Dec 

Select one month, or select a series of months by clicking 

the first month and the last month. 

Click on the OK button and the report will appear. 

Check Register To produce a Check Register, first open the Cash Disburse- 
ments Journal, then choose Check Register from the menu. 

A pound sign (#) in the first column indicates a check 
& number sequence break. An asterisk in the check number 

column indicates an unnumbered item, such as a service 

charge. 
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Cash Flow Analysis To obtain a Cash Flow Analysis report, first open the Cash 

Disbursements Journal or the Cash Receipts Journal. Then, 

choose this report from the menu. The report is available 

in Tabular or Graphs format. 

Account History This report presents every line posted to a specified 

account. Any account from the Chart Of Accts, Customers 

or Vendors lists is accepted. | 

When Account History is selected, a dialog box will 

appear: 

Account History 

& Account number aaa > 

Choose either one month 

or a period of months. 

@ Jan O July 

@ Feb © flug 

© Mar © Sept 
O April © Oct 

© May O Nov 

O June O Dec “a 

Select an account: 

e If you know the account number, Tab to the Account 

number edit box. Enter the Account number and click 

on the Show button. 

e If you don’t remember the account number, use the 

name lookup shortcut explained in the Operating 
Techniques Section of Chapter 3: Tips for Users: type 
the first few letters of the name, click on the Show 

button and fine-tune with the arrows. 

Select one month, or select a series of months by clicking 
the first month and the last month. 

Click on the OK button and the report will appear. 
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General Ledger The General Ledger report gives a complete account 
history for each account. This is a long report. It shows 

date, description, journal name, reference, debit and credit 

amounts and a running balance. Because this report is so 
lengthy, it is printed directly on the printer. To see similar 

information on the screen, use the Account History report 
for a specific account. 

This report is a valuable reference document, and should 

be printed before closing the books at the end of the fiscal 
year. 

When the General Ledger report is selected, a dialog box 

will appear: 

General Ledger 

Choose either one month 

or 8 period of months. 

CJ Print one account per Page. 

CJ Print the Cash accounts. 

CJ Print Individual Customers. 

CJ Print individual Vendors. 

@ Jan © July 

@® Feb © Aug 

O Mar © Sept 

O April © Oct 

O May © Nov 

© June © Dec 

If the check box is turned on: 

e Print one account per Page causes the printer to start 
a new page for each account. 

e Print the Cash accounts limits the report to just the 
Cash account(s). 

e Print Individual Customers appends the detailed 
accounts in the Customers list instead of the summary 

accounts receivable account. 

e Print Individual Vendors appends the detailed ac- 
counts in the Vendors list instead of the summary 

accounts payable account. 

Select one month, or select a series of months by clicking 

on the starting and the ending months. 

Click on the OK button and the report will be printed. 
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THE AR/AP/PAYROLL REPORT MENU 
The AR/AP/Payroll Report menu contains a list of reports 

about sales, purchases and payroll. 

You can view a report on the screen by selecting it in the 

menu. Then you can print it by choosing Print from the 

File menu. Business Sense displays one report at a time, 

so you should close your report before requesting another “ 

one. 

Examples of all reports are shown in Appendix D. 

AR/AP/Payroll Report 

AR Aging 

Invoice Register 

Sales Tax 

Sales Commissions 

Customer Analysis 
|e POR RO eee SEER EOS OC OEOEOO ESOS OOSES OOS OS SEED ESES ES EEEESESESSOESEE SES 

AP Aging 

Vendor Analysis 

1099 Forms 

Payroll 

W-2 Forms “a 

The AR/AP/Payroll Report menu looks like this: 

If the report name is underlined, the report is available in 
both Tabular and Graphs format. Choose the format in the 
File menu. 

If the Invoice Register selection is dimmed in the menu, 

open the Sales/AR Journal window. 

All reports except the 1099 Forms and W-2 Forms are first 
displayed on the screen. 
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AR Aging This report produces an aged listing of the accounts 
receivable. Separate reports are produced for Open Invoice 
Customers and for Balance Forward Customers. The 

Customers list shows the customer aging method. You can 

change between Open Invoice and Balance Forward aging 

for a customer by clicking on the Age By field in the 

Customers list. 

To prepare an accounts receivable aging report: 

e To report on selected customers, underline their names 

in the Customers window. 

e To report on all customers, close the Customers win- 

dow or Deselect All in the Edit menu. 

e Select AR Aging. A dialog box will appear: 

Customer Name 

Account Number[ - 

CZ) Age Selected Customer (snow } 

CJ include Credit Memos 

@® Open Invoice 

© Balance Forward CANCEL 

Select Aging Period 

@ 0-30 Days @ 61-90 Days 

@ 31-60 Days @ 91+ Days 

e To age a single customer, enter the customer account 

number or use the name lookup shortcut explained in 

the Operating Techniques Section of Chapter 3: Tips for 
Users: type the first few letters of the name, click on the 

Show button and fine-tune with the arrows. 

e To age multiple customers, leave the Customer Name 

and Account Number boxes blank, or click off the Age 
Selected Customer check box. 

e To include credit memos, click on the Include Credit 

Memos check box. 

e Choose Open Invoice Customers or Balance Forward 

Customers with the radio buttons. 

e Select one aging period, or select a series of aging 

periods by clicking the first period and the last period. If 
you turn off recent invoices, you get a shorter report so 

you can focus on the older invoices. 

e Click on the OK button and the report will appear. 
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Invoice Register To produce an Invoice Register, you must first open the 

Sales/AR journal, then choose this menu command. 

Sales Tax | The Sales Tax report shows the sales for each Sales Tax 
Code and the taxes collected in the Sales/AR and Cash 

Receipts Journals. When you select this report, a dialog 

box will appear: 

Sales Tax Report 

@ First Quarter © Third Quarter 

O Second Quarter © Fourth Quarter 

Select a report for the first, second, third or fourth quarter. 

Click on the OK button and the report will be displayed. 

Sales Commissions You can produce this report if you have entered Sales 
Person ID and Commission percentage in the Customers 

list. 

To prepare a Sales Commissions report: “ 

e To report on specific employees, underline their names 
in the Employees window with the Find Name or 

Number command from the Edit menu, or command- 

click on their names. Leave the window open while you 
run the report to select underlined employees. 

To report on all employees, close the Employees 

window or choose Unselect All in the Edit menu. 

Select the Sales Commissions report. A dialog box will 

appear: 

Employee Name (SS | 

Employee ID a] = 

CJ Do Report for Selected Employee 

@ Jan © July 

@ Feb O fug 

O Mar O Sept 

O April O Oct 

© May © Nov 

© June O Dec 
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e To report on multiple employees, leave the edit boxes 

empty, or click off the Do Report for Selected Employee 
check box. 

e To report on a single employee: 

© If you know the ID number, Tab to the Employee ID 
edit box. Enter the ID number and click on the 

SHOW button. 

© If you don’t remember the ID number, use the name 
lookup shortcut explained in the Operating Tech- 

niques Section of Chapter 3: Tips for Users: type the 

first few letters of the name, click on the SHOW 

button and fine-tune with the arrows. 

e Select one month, or select a series of months by 

clicking the first month and the last month. 

e Click on the OK button and the report will appear. 

Customer Analysis To compare customer sales volumes, run a Customer 

Analysis report. It shows the selected customers in de- 

scending order of sales volume. It is available in pie chart 
as well as tabular format. 

oe To prepare a customer analysis: 

e To report on specific customers, underline their names 
in the Customers window with the Find Name or 

Number command from the Edit menu, or command- 

click on their names. Leave the window open while you 

run the report to select underlined customers. 

e To report on all customers, close the Customers window 

or choose Unselect All in the Edit menu. 

e When you select this report, a dialog box will appear: 

Customer Named 
» Account Number[ | 

CJ Activity for Selected Customer 

CJ Show Customer with no activity. 

CD Show Cash Sales activity. 

Select Period 

@ ist Quarter © 3rd Quarter 

© 2nd Quarter © 4th Quarter 

e To select multiple customers, leave the edit boxes 

empty, or click off the Activity for Selected Customer 

check box. 
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AP Aging 

7-46 Business Sense 

| 

e To select a single customer: 

© If you know the customer account number, Tab to 
the Account Number edit box. Enter the Account 

Number and click on the SHOW button. 

© If you don’t remember the customer account number, 
use the name lookup shortcut explained in the “Y 
Operating Techniques Section of Chapter 3: Tips tor 

Users: type the first few letters of the name, click on 

the SHOW button and fine-tune with the arrows. 

e If the check box is turned on: 

o Show Customer with no activity includes inactive 
customers. 

o Show Cash Sales activity includes cash sales 
volume for comparison. 

e Select one quarter, or select a series of quarters by 

clicking the first quarter and the last quarter. 

e Click on the OK button and the report will appear. 

This report produces an aged listing of the accounts 

payable. Two separate reports are produced: Accounts 

Payable Days Until Due and Accounts Payable Days Past 

ie “ Accounts Payable Days Until Due shows all open invoices, 

including past due invoices. Accounts Payable Days Past 

Due shows only invoices which have already become due. 

To prepare an accounts payable aging report: 

e To report on specific vendors, underline their names in 

the Vendors window with the Find Name or Number 

command from the Edit menu, or command-click on 

their names. Leave the window open while you run the 

report to select underlined vendors. 

e To report on all vendors, close the Vendors window or 

choose Unselect All in the Edit menu. 

e Select AP Aging. A dialog box will appear: 

Vendor Name 

Account Number [ 

CJ Age Selected Vendor 

CJ include Credit Memos 

@ Age Days Until Due 

© Age Days Past Due 

Select Aging Period 

@0-7 Days @15-30 Days 

@©8-14Days @31+ Days 



Vendor Analysis 

e To age multiple vendors, leave the Vendor Name and 

Account Number boxes blank, or click off the Age 

Selected Vendor check box. 

e To age a single vendor: 

o If you know the vendor account number, Tab to the 

Account Number edit box. Enter the Account Number 

and click on the SHOW button. 

© If you don’t remember the vendor account number, 

use the name lookup shortcut explained in the 
Operating Techniques Section of Chapter 3: Tips for 
Users: type the first few letters of the name, click on 

the SHOW button and fine-tune with the arrows. 

e To include credit memos, click on the Include Credit 

Memos check box. 

e Choose Age Days Until Due or Age Days Past Due with 

the radio buttons. 

e Select one aging period, or select a series of aging 

periods by clicking the first period and the last period. 
With the Accounts Payable Days Past Due report, if you 

turn off recent invoices the report will be shorter so you 
can focus on the older invoices. 

e Click on the OK button and the report will appear. 

To compare vendors, produce a Vendor Analysis report. It 

shows the selected vendors in descending order of 

amounts paid. The Vendor Analysis is based on disburse- 

ments rather than invoices for compatibility with 1099 
reporting requirements. This report is available in pie chart 
format as well as tabular format. 

To prepare a vendor analysis: 

e To report on specific vendors, underline their names in 
the Vendors window with the Find Name or Number 
command from the Edit menu, or command-click on 

their names. Leave the window open while you run the 
report to select underlined vendors. 

e To report on all vendors, close the Vendors window or 
choose Unselect All in the Edit menu. 
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e When you select this report, a dialog box will appear: 

» Account Number[ | se 

CJ Activity for Selected Vendor 

() Show Vendor with no activity. 

CL) Show Cash Expenses activity. 

Select Period 

@ Ist Quarter © 3rd Quarter 

© 2nd Quarter © 4th Quarter 

e To select multiple vendors, leave the edit boxes empty, 

or click off the Activity for Selected Vendor check box 

to clear the edit boxes. 

e To select a single vendor: 7 

© If you know the vendor account number, Tab to the 
Account Number edit box. Enter the Account Number 

and click on the SHOW button. 

° If you don’t remember the vendor account number, 

use the name lookup shortcut explained in the 
Operating Techniques Section of Chapter 3: Tips for 

Users: type the first few letters of the name, click on 

the SHOW button and fine-tune with the arrows. “A 

e If the check box is turned on: 

o Show Vendor with no activity includes inactive 
vendors. 

o Show Cash Expenses activity includes disburse- 
ments from Expense accounts in the Chart Of Accts 

for comparison. 

e Select one quarter, or select a series of quarters by 

clicking the first quarter and the last quarter. 

e Click on the OK button and the report will appear. 

1099 Forms Use this command to print 1099 Forms for vendors who 
are individuals. 

To prepare 1099 Forms: 

e To report on specific vendors, you can underline their a) 
names in the Vendors window with the Find Name or 

Number command from the Edit menu, or command- 

click on their names. Leave the window open while you 

run the report to show only underlined vendors. 

e To report on all vendors, close the Vendors window or 
choose Unselect All in the Edit menu. 
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e Select the command and a dialog box will appear: 

Print 1099 for vendors with 

Ere 
or more activity this year 

e Enter the minimum compensation that will trigger a 

1099 Form. 

e Click on the OK button. You will be reminded to put 
the pre-printed forms into the printer. 

e Click on the OK button and the 1099 Forms will be 

printed. 

Payroll The Payroll report shows monthly or quarterly wages and 
withholding for employees. Company totals appear at the 

end of the report. 

To run the Payroll report: 

& e To report on specific employees, you can underline 

their names in the Employees window with the Find 
Name or Number command from the Edit menu, or 

command-click on their names. Leave the window open 

while you run the report to show only underlined 

employees. 

e To report on all employees, close the Employees 

window or choose Unselect All in the Edit menu. 

e Select the command and a dialog box will appear: 

Employee Name ee eee rs 

Employee ID ieee > 

CJ Do Report for Selected Employee 

Select Either one Quarter or a range of 

Quarters 

@ ist Quarter © 3rd Quarter 

© 2nd Quarter O 4th Quarter 
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e To select multiple employees, leave the edit boxes 

empty. 

e To select a single employee: 

© If you know the employee ID, Tab to the Employee 
ID edit box. Enter the ID number and click on the 

SHOW button. 

© If you don’t remember the Employee ID, use the “Me 
name lookup shortcut explained in the Operating : 
Techniques Section of Chapter 3: Tips for Users: type 

the first few letters of the name, click on the SHOW 

button and fine-tune with the arrows. 

e Select one quarter, or select a series of quarters by 

clicking the first quarter and the last quarter. If you 
select one quarter, the report will show monthly pay 
and withholding. If you select multiple quarters, the 

report will show quarterly pay and withholding. 

e Click on the OK button and the report will appear. 

W-2 Forms At the end of the calendar year, prepare W-2 Forms with 
this command. 

To run the W-2 Forms: 

e To report on specific employees, you can underline “ 
their names in the Employees window with the Find 

Name or Number command from the Edit menu, or 

command-click on their names. Leave the window open 
while you run the report to show only underlined 

employees. 

e To report on all employees, close the Employees 

window or choose Unselect All in the Edit menu. 

e A dialog box will appear: 

Enter Information Needed to Print W-2 Forms. 

Maximum FICA Wages (#13) SS 

Name of State (#19) 

Maximum Local Wages (#21) a 

Neme of Locality (#22) free tl 
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The information asked for in the dialog box will appear on 

the W-2 Forms. The numbers following each entry refer to 
the box numbers on Form W-2.. 

e Maximum FICA Wages #13: enter the maximum 
amount of wages subject to FICA withholding and press 

the Tab key to advance to the next edit box. 

e Name Of State #19: enter the abbreviated name of the 
State, such as: “CALIF” and press the Tab key to advance 

to the next edit box. 

e Maximum Local Wages #21: enter the maximum 
amount of wages subject to local withholding. In 

California, enter the maximum wages for Sickness and 

Disability Insurance (SDI) withholding. 

e Name Of Locality #22: enter the name of the local tax, 
for example; “CA SDI”. 

Click on the OK button. You will be reminded to put the 

forms into the printer. 

Click on the OK button to print the W-2 Forms. 

THE MONTH MENU 
If a journal window is active, an additional menu, the 

Month menu, will appear in the menu bar. This menu 

contains the names of the months of the year. 

January 

“February 

March 

April 

May 

June 

July 

August 

September 

October 

November 

December 

To use this menu, select the month desired in the Month 

menu. That month’s journal entries will appear in the 
window. The elevator in the scroll bar will stay within that 

month. You can scroll into other months with the scroll 

arrows, or you can choose another month from the Month 
menu. 
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THE INDEX MENU 
If the Recurring Entries or Help window is active, an 

additional menu, the Index menu, will appear in the menu 
bar. This menu contains a list of topics. 

To use the Index menu, open the Help or Recurring 
Entries window. The Index menu will appear in the menu 

bar. When you select a name from the Index menu, the 

Help or Recurring Entries window will scroll to that topic. | 

You can change the topics in the Index menu. The 
procedure is explained in the Help Section and the Recur- 

ring Entries Section of Chapter 6: Main Window Icons. 
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CHAPTER 8: | 
TIPS FOR 
ADVANCED USERS 

As your business grows, you'll be able to use Business 

Sense for more complex business operations. Here are 

some examples of techniques to streamline complexity. 

UNDERLINING 
Underlining is used to select groups of customers, vendors, 
employees or accounts for processing. 

Activate and deactivate underlining by opening and closing 
the list window. 

Underline major customers so you can produce mailing 

labels for them. Underline problem customers so you can 
selectively Apply Finance Charges. 

Underline vendors whose invoices are to be paid by the 
due date. Leave the Vendors window open while you 
Select AP Payments from the Function menu. Click on the 

Pay All Due Through LC) radio button, and fill in the date. 
Click on the Preview As A Report button and the OK 
button to see how much will be paid to each vendor. 

Close the report window, adjust underlining and choose 
Select AP Payments again until the spending meets your 

plan. To generate the checks, choose Select AP Payments 

again without clicking on the Preview As A Report button. 

Underline employees who are paid every pay period. 

Open the Employees window to pay the selected em- 
ployees. Close the window to pay everybody. 
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MULTIPLE COMPANIES 
Business Sense handles accounting for multiple companies. 

CPA’s and free-lance bookkeepers will want to use Busi- 
ness Sense to keep books for several clients. 

Maintain one complete set of data files for each company. 

Be careful not to tangle these files. “ 

Floppy Disk The best way to maintain these files is to have one data 

disk for each company. Never change data disks while 
Business Sense is running. Always Quit and go back to the 

Finder to change company data disks. Back up the data 

disk, then insert a new company data disk and restart 
Business Sense. 

Hard Disk Even if the program is on a hard disk, keeping the compa- 
nies on separate floppy disks simplifies operations and 
protects the integrity of the data files. 

If you have multiple companies on your hard disk, keep 

each set of company data in its own folder inside another 
folder called “Clients” or “Companies.” Putting the com- 
pany data folders inside another folder hides them from 
the Business Sense program, so they won't be accidentally 

changed. Change the Company Data folder name to the 

name of the company. Drag one company folder to the 
root directory before starting Business Sense. Make sure the 

Main window shows the name of the right company! After 
finishing work for that company, choose Quit from the File 

menu. Back up the company folder. Drag the company 
folder back to where it came from before dragging another 
company folder to the root directory. 

MULTIPLE CHECKING ACCOUNTS 
Business Sense can handle up to five checking accounts. 
Active checking accounts should have the Account Type 
“Cash.” Other bank accounts should not be Cash accounts, 

unless you will be writing a lot of checks from them. It’s 
expensive and tedious to write one check with the com- ny 

puter. 

Name the old and new Cash accounts after the bank 

names or account functions, such as “First National” or 

“Payroll.” Each Cash account will have two icons in the 
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Main window, one for the Cash Disbursements Journal 

(hand writing a check,) and one for the Cash Receipts 
Journal (money bag for deposits.) 

To avoid cumbersome sentences, this manual always refers 

to “the” Cash Disbursements Journal and “the” Cash 

Receipts Journal. If you have more than one Cash account, 

choose the proper one by opening its icon. This is the 

main reason Business Sense does not open Cash journals 

automatically when they are needed for Apply AR Pay- 
ments, Select AP Payments and Generate Payroll. 

ANALYZING DATA 
You can send Business Sense lists, journals and reports to 

a spreadsheet program with the Write to File command in 
the File menu. 

Export the Income Statement to analyze your profitability. 

You can analyze trends if you make the Income Statement 

with year-to-date figures. Exporting the Income Statement 
with budget comparisons will give you a basis for tracking 

budget performance or revising the budget. Export the 
Balance Sheet to analyze ratios. 

Export the Customer Analysis report, to calculate the gross 
profit for your most important customers. Export the Sales 
Commissions report, as another way to analyze sales. 

Export the Vendor Analysis report to estimate the effect of 
purchasing alternatives. 

Export the Payroll report to analyze wage costs. 

TRANSCRIBING STATEMENTS 
You can send any list, journal or report to a word process- 

ing program, or any other program that reads a Macintosh 
text file. 

Export the Income Statement and the Balance Sheet for 
inclusion in reports to banks and investors. 

DIRECT MAIL PROMOTION 
With the Print Mailing Labels command in the File menu, 

you can prepare labels for all or selected customers. 

With the same command, you can also create a Print Merge 

File, which can be used to address custom letters to 

customers. 
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LASERWRITER PRINTING 
If you leave the Font Substitution check box marked in the 

print dialog box, some of your LaserWriter reports may be 
truncated. You can solve this problem by turning off Font 
Substitution or by choosing Page Setup from the File menu 

‘ 

and selecting Reduction: 90 percent. 

BAD DEBTS 
When it becomes clear that a customer is not going to pay 

an invoice, then the balance due can be transferred into a 

bad debt account. Open the Sales/AR Journal and use Fix/ 
Adjust Entry in the Function menu to reverse the invoice. 
Before posting the reversal, change the Revenue account 

number to the bad debt account. This will close the 
invoice and increase bad debts. 

CLOSING EVERY MONTH 
Some companies have used older software packages that 
required closing the books every month for so long that 

they like it that way. If you want to “close” the books 
every month, choose New Data Disk from the Function 

menu. Your journals will look cleaner. They will contain 

only the beginning balances and the current month “ 
activity. Open invoices will still be carried forward, and 
you can still post a transaction to a prior month. You can 
print a financial report for any month or range of months. 

You won’t be able to void old checks or deposits, or 
reverse old General Journal transactions. The big advan- 

tage to this technique is that you can post an enormous 
number of transactions in a year without buying more 

memory or using two backup disks. 



EMPLOYEE ADVANCES 
Here is a procedure to handle employee advances. It has 
an option to have advances appear on the AR Aging 

report: 

e Add an advances suspense account to the Chart Of 
Accts: 

e Add summary and detail advances accounts to the 

Customers list: 

“LEARNED LUMBER CO. 
For the month of February , 1987 

To issue advances: 

e Debit advances checks to the suspense account: 

LEARNED LUMBER CO. 
For the month of Fet , 1987 

Total this Batch 

500 .00 

esstseshs3 33, 

eee Cee eee eee (eee eee ee eee reece ere ee eee eee eee ree ee! Serre errr Pre ee ee eines 

eee See eee eee) See eee eee eee eee eee eee ee eee ee eee eres Cee eee eee Pee ee ee eee es 

You can optionally show the advances on the AR Aging 

report: 

e Make Sales/AR Journal entries. Debit a customer ad- 

vance account and credit the suspense account: 

LEARNED LUMBER Bee 
os Laat the month of Fet 
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e Here is how the advances will appear on the AR Aging 

report: 

Totals: 

When you are ready to generate payroll, if the advances 

appear on the AR Aging report put the amounts to be 
repaid back into the suspense account: 

e Print the AR Aging report. 

e Open the Sales/AR Journal. 

e Select an advance. 

e Choose Fix/Adjust Entry from the Function menu. 

e If the advance is being fully repaid, reverse it. If it is 
being partially repaid, issue a credit memo and edit the 
amount to be deducted: 

—= Sales/ i eee 
EARNED LUMBER CO. 

F 

To deduct advances from payroll checks: 

e Open the Employees list, select the employee and click 

on “More” and “Withholding Information”. 

e Click on an unused deduction such as Other1 and enter 

the deduction charged to the suspense account: 
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Withholding Name [Brown, John J. 1D 

Federal © Withholding Acct #{1990 
FicR ©  Amt{300.00  |or{ _—| % withheld 

NET Max To Withhold|  —s_ 
State O 

Local ©O 

Other! @© 

DF Use Tas Table 

Other 2 © (CD Withhold From Employer 

Others O Amt[ sor % Withheld 
Other 4 O NET Max To Withhold 

Other5 O Expense Account -—— 

Other 6 O Liability Account 

Wage Information Personal Information 

e Generate the payroll: 

. Marvin/FICA 

. Marvin/State 

. Marvin/sol 

ae . Marvin/Advance 

; . Broen/PR-Hersosa 

Mi . Brown /Federa!l 

as . Brown/F ICA 

sat - Brown /State 

. Brown/Sso!l 

. Brown /Advance 

CUSTOMER DEPOSITS 
Here is a procedure to handle deposits received from 

customers. It has an option to have deposits appear on the 

Customer Ledger Card: 

To record a deposit: 

e Enter the deposit into the Cash Receipts Journal, credit- 

ing the Current Liability account “Deposits Received:” 
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If you want the deposit to appear in the Customer Ledger 
Card: 

e Open the Sales/AR Journal. 

e Enter the deposit crediting the customer account and 

Lo 

debiting Deposits Received: 

= aies/h SSS 
LEARNED LUMBER CO. 

F th of F 1987 

SeTrrers er. Seerrrrre rrr Tre reer rrr rere rr rerrrrrrrre (See eerrrrrre PECEeCer ere eee Pere reeereeeeees (ieee rere ees 

When the deposit is to be applied to a sale, if the deposit 

appears on the Customer Ledger Card: 

Open the Sales/AR Journal. 

Select the deposit entry. 

Choose Fix/Adjust Entry from the Function menu. 

If the deposit is being fully applied, reverse it. If only 
part of it is being applied, issue a credit memo and edit 

the amount to be applied: 

———————————— = Saeies/i —————_—S—— eee 

LEARNED LUMBER CO. Debits Credits 
For the month of Feb 1987 1000 .00 1000 . 00 

[Date || | Description/PO Number | Customer [| invoi 4 

Pree PYPOere rr eerereeer es SEE e eee eee ee ee eer COPE OESEEEE SOCEeEeeereeee Cee eeeeeeeeeees (Pee 



To apply the deposit on the sales invoice: 

e Open the Sales/AR Journal. 

e On the first line, enter the customer account number 

with no amount. 

e Credit the line items to Revenue accounts. 

e Debit Deposits Received for the amount of deposit 
applied to this invoice. 

e Choose Complete Invoice from the Function menu, to 

calculate sales tax and the balance to be charged to the 

customer: 

“Sales/Tax: | 
: Amount 

FEE SPLITTING 
Some professional services companies divide client reve- 
nues between the company and the person performing the 
service. If each client has one responsible person, you can 

set the client’s discount account to a current asset holding 

sub-account for the employee performing the service. 
When the client pays, enter all the revenue (or the 
employee’s portion) as a discount in the Customer Ledger 

Card. This will close the invoice and hold all or part of the 
proceeds. . 

Splitting fees based on invoices instead of cash receipts is 
easier. Use commissions in the Customers “More” screen. 

PRINTING A JOURNAL FOR AN ENTIRE YEAR 
There’s a trick to get more than one month of a journal to 
print in a single report. At the end of the year, date a 
transaction in the first month of the year and use a zero 

amount. Then close and reopen the journal to post the 
transaction. Choose the first month of the year in the 

Month menu, and choose Print from the File menu. The 

entire journal will print as shown on page 8-10. 
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LEARNED LUMBER CO. 

Checking-CRJ 
For the month of Jenuse 

WOUUOUOOL THOUUE bd SiddIOUOOL JOOOOUOOOUUUOUOUOOUOUOUUDUDOUUUUUUOOUOUUOUOUOOOU fl 

D1/05 OjCash Sales 

1800 .00}Cash Sales 

eT 

Ww _ N NM 

a 

Sales Tax Payable - 6.5% 

ash Sales 

anes 

oO 

ZO] "Force oll sonths to print 
= - = = — N N N ~ ~ ~ ~ —% N -— ui w an vs) 

This will not disturb the financial reports or any other 

months of reports. This trick works because the journals 
stay open all year. Journal windows and listings for a given 

month show the full span of transactions from the first 
transaction in that month to the last in that month. 
Amounts are correctly posted to the month given in the 

transaction date. 
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RESTORING DATA FILES 
What happens if your working files get clobbered by a 

power failure or machine error? Don’t just copy the backup 
files onto your working data. The procedure given here 

works not only with Business Sense, but could be adapted 

to recover important files for almost any program. 

Take your time. You may be confused and upset. More 

things could go wrong. Invite someone to work with 

you. 

Try again. Maybe this was a transient error. Maybe you 

pressed the wrong key or chose a different command 

from the one you thought you chose. 

Be suspicious of your machine. If another machine is 

available, try using it before you decide to restore your 

files from backups. 

If you’re not sure you understand exactly what you 

were doing, talk to your dealer or to Monogram Techni- 

cal Support. Maybe the problem is a misunderstanding. 

If your broken data is on a hard disk, back it up. There 
may be some useful information in there; don’t lose it. 

Copy the Company Data folder onto a new disk marked 

“Company Data - Broken.” 

If your broken data is on a floppy disk, retire that disk 

and restore your data onto a brand new disk. Your old 

disk may be dirty or worn out. Also, you may be able to 

recover some useful information from it, so don’t wipe it 

out now. 

Lock your backup disk. Slide the plastic tab in the 
corner to uncover the hole. 

If you will be restoring onto a floppy disk, restore to the 
new disk by dragging the backup disk icon to the new 

working data disk. 

If you will be restoring onto a hard disk, drag the 

Company Data folder from the backup disk to the hard 
disk icon. 

Test the restored data. One reason for recommending 

multiple backup disks is that your recent backup disks 
may be defective too. Try the same operation that failed 
before. If it fails again, lock your oldest backup and 
restore your data with it. Try the operation again. If it 
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still fails, take your computer with copies of the pro- 
gram and data to a repair center. Demonstrate the 
problem at the repair center, so they can see what's 

wrong. 

e If the restored data from the latest backup worked, 

you're ready to begin transaction recovery. 

e If the oldest data worked, but the latest data failed, try “wy 

the other backups to find the last backup disk that 
works. Then begin transaction recovery. 

e If none of the backup disks work and if your computer 

passes the diagnostic tests at the repair center, you will 

have to build your files from the original Master Data 
disk, as you did in Chapter 4. If you have a Trial 
Balance report and AR Aging and AP Aging reports, you 

can recreate your files as of the report date. Then begin 

transaction recovery. 

Transaction Recovery You will need to re-enter the transactions posted since the 
backup data was made. First, verify the status of the 

restored data. Print all five journals, the Income Statement, 
Account History for the Cash account, and Trial Balance 

report with individual customers and vendors. Compare “A 
the accounts receivable and accounts payable and total 
checks and deposits to the figures shown in your control 

log. This will show you where you have to start recovering 

transactions. 

Depending on how old your restored data is, you may 

have to enter only a few transactions from your manila 

folder, or several weeks of transactions going back to the 

beginning of the month. If you keep a control log, you can 
identify most or all of these transactions. If you have 
printouts archived in your drawer, they may contain the 
information you need. If open invoices are filed together, 
the newer ones will be identifiable. Try to print anything 
you can from your broken data disk or the most recent 
backups. Maybe you can print all the transactions for four 

out of five journals. 
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APPENDIX A: 
SOURCE FOR PRE-PRINTED 
FORMS 

To order pre-printed forms for use with Business Sense, 
contact: 

Deluxe Computer Forms 
1275 Red Fox Road 

P. O. Box 64046 

St. Paul, Minnesota 55164-0046 

Telephone (800) 328-0304 

Request Order Form #C06656 or use the order form 
enclosed with this manual. 

FORM NAME FORM # 

GHECK tice erat treuy ane ice ses nen arenes 091013 
PAV OLOG sie ote tee mt apetacscsus wearin a eee ent a eae 091300 

Billing. Statements. etcsracteee ns eia nde sucess coast ceases 091303 

FOOD PGI Silene oe ee 091636 
WZ FORTE (SEK: OAS 4 tre re 091644 
Wh 2 ROrni Cour Darts ences ekekt ee een on, 091647 

ENVELOPE NAME FORM # 
Envelope for Check... ae 091500 
Envelope for Invoice & Billing Statement.............. 091501 

ENVElOpe 1OG W-2:PORmn 2 yn. ee ee ee O91517 

ENVElIO DE IGF 1099 BOs. ies cncles coats cea: 091555 
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Show Main Window X%0 

Close 

Page Setup 

Print 
Reprint Entry 

Print Mailing Labels 

Write to File 

“Tabular Reports 

Graphs 

Quit 

GL Report 

income Statement 

Department Income 
Balance Sheet 

Trial Balance 

Financial Ratios 

Check Register 

Account History 

General Led 

APPENDIX B: 
QUICK REFERENCE GUIDE 

Delete a Line 
insert a Line 

More Info 

Repeat Search 

Unselect All 

AR Aging 

invoice Register 
Sales Tax 

Sales Commissions 

Customer Analysis 

AP Aging 

1099 Forms 

Payroll 

W-2 Forms 

Generate Payroll 

AR/AP/Payroll Report 

Function 

New Date 

New Fiscal Year 

New Calendar Year 

New Data Disk 

Fin/Adjust Entry 
Hash Totals 

Apply AR Payments 

Apply Finance Charges 

Billing Statements 

Set Sales Tax Codes 

Select AP Payments 

Enter Budget Information %# 

January 

“february 

March 
April 

May 
June 

July 

August 

September 

October 

November 

December 
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APPENDIX C: CODES 

Code fields in the Chart of Accts, Customers, Vendors, 

Employees, and Recurring Entries lists are limited to certain 

values. Allowable values are listed here. 

List: Chart Of Accts Balance Sheet Accounts 
Field: Account Type Code Name 

Cash Cash 

CA Current Asset 
Inventory Inventory 

FA Fixed Asset 

OA Other Asset 

CE Current Liability 
LL Long Term Liability 

& OL Other Liability 
Equity Equity (Capital) 

Close Close (Retained Earnings) 

Income Statement Accounts 

Code Name 
Revenue Revenue 

Returns Returns and Allowances 

CGS Cost of Goods Sold 

Expense Expense 
OINC Other Income/Expense 

List: Customers Code Name 
Field: Age by BAL Balance Forward 

& INV Open Invoice 
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List: Vendors 

Field: 1099 Type 

List: Employees 
Field: Pay Type 

List: Employees 

(Personal Info screen) 

Field: Marital Status 

List: Employees 
(Personal Info screen) 
Field: Payroll Period 

List: Tax Tables 

Field: Table 

C-2 Business Sense 

Code 

Rents 

Royalty 

Prizes 

Fishing 

Nonempl 

Medical 

Subpay 

Code 
HOUR 

SALR 

Code 
S 

Name Used For 
Don’t Print 1099 Vendor not an individual 

Rents 

Royalties 

Prizes and Awards 

Fishing Boat Proceeds 

Non Employee Compensation “ey 

Medical and Health Care 

Substitute Payments 

Name How Used 
Hourly Enter pay per hour and # of hours 

Salaried Enter total pay per pay period 

Name 
Single 

Married 

Unmarried Head of Household 

Name 
Weekly “ 

Bi-weekly 

Semi-monthly 

Monthly 

Daily 



List: Recurring Entries Code Name Used For 
Field: Jrn (Journal) # Index header Naming a group of entries 

GEN General 

SES Sales/AR 
PUR Purchases/AP 

CD1 Cash Disbursements _ First checking account 

CR1 Cash Receipts First checking account 
& CD2 Cash Disbursements 2 Second checking account 

CR2 Cash Receipts 2 Second checking account 

CD3 Cash Disbursements 3 Third checking account 

CR3 Cash Receipts 3 Third checking account 

CD4 Cash Disbursements 4 Fourth checking account 
CR4 Cash Receipts 4 Fourth checking account 

CDs Cash Disbursements 5 Fifth checking account 

CRS5 Cash Receipts 5 Fifth checking account 
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APPENDIX D: REPORTS 
CATALOG 

Business Sense prints 52 reports. This Appendix 

illustrates each report using the Demo Data files. 

Reports are generally produced on the screen, in a 

window with scroll bars. To print the report in the 
active screen window, choose Print from the File 

menu. 

Billing Statements, Checks, Invoices, W-2 Forms 

and 1099 Forms are printed directly onto pre- 
printed forms without appearing first on the 

& screen. You can order the pre-printed forms from 

the address in Appendix A. Because of its length, 

the General Ledger report is also printed directly 
without appearing first on the screen. 
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LEARNED LUMBER CO. STATEMENT 
6700 Hermosa Way 

Hermosa Beach, CA 90415 
DATE 

: ’ 
SAMPLE - VOID ACCOUNT NUMBER ACCOUNT NUMBER 

FORM 091303 nsn/O4NC 
COMPATIBLE ENVELOPE 091601 

To insure proper credit 
Mann & Sons please check those items 
21015 Victory being paid in the “‘v “ 
Woodland Hills, CA 96212 column and return this 
Attn: Je¢## Mann portion of the statement 

with your payment. 

0172071987 Cement Mix - 50 Bags 
02/19/1987 Cement Mix - 50 Bags 

02/28/1987 Gross 2x4’s/AB222 

CCR eu ©. PAvesEMT & - OrBCOUNT F - BmeAMCE Ww - WARRANTY C/A - CASH REFUND PLEASE 1369.32 TOTAL 1369.32 

COOES 0 - OR WED 1 ervoct LOWED CHANGE @ . BALANCE 8 . SERVICE /REPAR PAY 

Try 30 pays = “sooavs | 1200S 
869.32 500.00 

Billing Statements 
Procedure: Choose Billing Statements from the Function menu. 
Options: All customers, underlined customers, single customer. 
Remarks: Printed directly, on pre-printed forms. 
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LEARNED LUMBER CO. 

Accounts Payable Payment Preview 
2/28/1987 

Mahe eat Me hehehehe tehe®, 

ite ee eee eee CeCe eee eee ERE wee BER Eee EEE REE EEEREMEES BEER EEEEEEREEEESEe Cte e eee eee ee Pie har a aoa 

a ee) eR EERE) (RE RE RE RE REE REREREEEREES MERE EEEEREREERSLEMS (MESS che Sr SS ek is Mt a oe 

SHEESH SESE EH EEEE SESE EEEEEESEEEE ESE SE EEE ESESEEEEEES eeereseceses PRR eee S ee ee eee es ese e sess es esses esses Ses SSeS esses Ee eeese Heese seeeseeseesessesss Messesesesssssesessessse 
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Accounts Payable Payment Preview 
Procedure: Open the Cash Disbursements Journal. Choose Select AP Payments from 

the Function menu. Click on the Preview As A Report check box. 
Choose payment option. Click on the OK button. 

Options: All vendors, underlined vendors, single vendor. 
All invoices, all discountable invoices or all due through a given date. 

Remarks: To issue checks, choose Select AP Payments again with the same options. 
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$0000000000000000000 an eteteteleterere ee eee. s.8.8- 

Pe 

No Seg Se Types 

umber Sales 
4010/01 [Revenue [Lumber-Hermosa | __ 3900.00) 

4020 [Revenue [Building Materials Sales 3000 . 00 

Bldg Mat!-Santa Monica 

% 
4100 [Revenue [installation Services 2 eee 
4200 [Revenue [Finance Charges ies 

4500/01 [Returns [Returns-Hernosa ee en 
AS00702 [Returns |Returns-Senta Honea CP 
POTO/O1 {GS | OGS-Lunber-Hermosa J D . 00 2 00 
6010/02 [CGS CGS-Lunber-Santa Monica CS. 
5020 |[C6S  —=§ [Cost of Goods Sold - Building Materials 
020/01 G5 CGS-Bidg Mat |-Hermosa | 0.00 0.00) 170.00 | 
D020/02 [CS (CGS-Bidg MatI-Santa Monica | 170.00 | 

5090/01 [065] €05-Plysood-Herosa | 750.00 750.00) 

6010] Expense |dvert ising] 100.00 700: 00) 

6030 ijExpense [interest Bees 

6035/0 pens 90 . 0C 
6035/02 [Expense [Ofc Sply-Santa Monica 00 

6040701 Expense 
6010/02 [Expense | 00.00 
i 3000, 00 
6050 Expense —|Payrol Taxes} 500.00 
6050/02 [Expense [PA Tax-Santa flonlea—_ | 50.00 

6065/01 | Expense 

607" pense 00. 00 
6200 Expens 

6200/0. pens 
6500 s|Expense [Depreciation - Trucks 

JOINC __|Gain/(Loss) From Sale of Assets 

Enter Budget Information 
How to: Choose Enter Budget Information from the Function menu. 
Remarks: Before printing this wide report: 

Choose Page Setup from the File menu. 

Set Orientation to Wide. 
Set Reduction to 50 percent. 
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LEARNED LUMBER CO. 

Income Statement 
For 2 months ending 2/28/1987 

Operating Revenues Percent 

Lumber Sales Pests bogho ew 9 He 30.46 

Building Materials Sales 7053.00 LESTE 

\& Plywood Sales 29144.00 noe99 

Net Operating Revenues , 52052.00 100.00 

Cost of Goods Sold 

Cost of Goods Sold - Lumber 1560.00 3.00 

Cost of Goods Sold - Building Nateri 110000 30 

Cost of Goods Sold - Plywood 2790.00 2360 

Total Cost of Goods Sold 5060.00 9.72 

Gross Profit 46992.00 90.28 

General and Administrative Expense 

Alarm 130.00 G25 

Advertising 239.00 0.46 

Bank Charges 00 O..03 

Gas & Oil 235.00 O245 

& Office Supplies 480.00 0.92 
Postage 456.00 0.88 

Payroll Expense 12400.00 25562 

Payroll Taxes 886.62 bate 

Rentals 500.00 0.96 

Telephone 1822.50 i eee | 6) 

Travel 370.00 ar di 

Truck Maintenance 225.00 0.43 

Total General and Admin. Expense 17759.62 S442 

Net Operating Profit 29232.36 56,16 

Other |Income/(Expense) 

Net Income 29232.38 $6:..16 

&, Income Statement (Normal Income Statemenf, Tabular) 
rocedure: Choose Income Statement from the GL Report menu. 

Options: Select any month or series of months. 
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LEARNED LUMBER CO. 

income Statement 
For 2 months ending 2/28/1987 

Revenues $52052.00 = 100.00% 

Cost of Goods Sold $5060.00 = 9.72% 

ae Returns and Allowances $0.00 = 0.00% 

Be Enpenses $17759.62 = 34.11% 

me: |: Profit $29232.38 = 56.15% 

income Statement (Normal Income Statement, Graph) 
Procedure: Choose Income Statement from the GL Report menu. Choose Graphs in 

the File menu. 
Options: Select any month or series of months. 
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LEARNED LUMBER CO. 

Income Statement 
For 1 month ending 2/28/1987 

Period % YTO % 

Operating Revenues 

Lumber Sales 7788.00 29.78 15655, 00 30.46 

Building Materials Sales 3472.00 t3u26 7053.00 ee) 

Plywood Sales 14888.00 56.94 29144.00 55.99 

Net Operating Revenues 26148.00 100.00 52052:00 100.00 

Cost of Goods Sold 

Cost of Goods Sold - Lumber 760.00 2.91 1560.00 3.00 

Cost of Goods Sold - Building NMateri 360.00 1.38 710.00 1.36 

Cost of Goods Sold - Plywood 1390.00 acoe 2790.00 Jea0 

Total Cost of Goods Sold 2510.00 9.60 5060.00 9.72 

Gross Profit 23638.00 90.40 46992.00 90.28 

General and Administrative Expense 

Rlarm 65.00 O25 130.00 0.25 

Advertising 120.00 0.46 239.00 0.46 

Bank Charges 10.00 0.04 17.90 0.03 

Gas & Dil 110.00 0.42 233.00 0.45 

Office Supplies 280.00 ee Og 480.00 0.92 

Postage 156.00 0.60 456.00 0.88 

Payroll Expense 6200.00 rae ae 12400.00 25.02 

Payroll Taxes 495,31 bed 886.62 be #0 

Rentals 250.00 0.96 500.00 0.96 

Telephone 980.10 36%9 1822.50 3:50 

Travel 180.00 0.69 370.00 0.71 

Truck Maintenance 110.00 0.42 225.00 0.43 

Total General and Admin. Expense 8904.41 34.05 17759.62 S912 

Net Operating Profit 14733.59 30.23 29232.38 36.16 

Other Income/(Expense) 

Net Income 14733.59 56.35 29232.38 56.16 

& income Statement (Include Year to Date) 
Procedure: Choose Income Statement from the GL Report menu. Click on the 

Include Year to Date button. 

Options: Select any month or series of months. 
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LEARNED LUMBER CO. 

Income Statement and Budget 
For 2 months ending 2/28/1987 

$ % 
Sudget acu Variance Variance 

Operating Revenues 

Lumber Sales 14000.00 15855.00 1855.00 Lac29 

Building Materials Sales 6000.00 7053.00 1053.00 Hey see es 

Plywood Sales 28000.00 29144.00 1144.00 4.09 

Net Operating Revenues 48000.00 52052.00 4052.00 8.44 

Cost of Goods Sold 

Cost of Goods Sold - Lumber 1500.00 1560.00 60.00 4.00 

Cost of Goods Sold - Building Mat 680.00 710.00 30.00 4.41 

Cost of Goods Sold - Plywood 3000.00 2790.00 (210.00) (7.00) 

Total Cost of Goods Sold 5180.00 5060.00 C12000)» “¢2.32) 

Gross Profit 4#2820.00 46992.00 4172.00 aT | 

General and Administrative Expen 

Alare 130.00 130.00 

Advertising 200.00 239.00 39.00 19.50 

Bank Charges | 10.00 17.50 7.350 3.00 

Gas & Oil 200.00 23300 33.00 16.50 

Office Supplies 360.00 480.00 120.00 x Ree P| 

Postage 800.00 456.00 (344,00) (C4360) 
Payroll Expense 12000.00 12400.00 400.00 Fr 

Payrol! Taxes 1000.00 886.62 TAS 238 FO. F123 4) 
Rentals 500.00 500.00 

Telephone 2000.00 1822.50 (177.50): (6.68) 

Travel 500.00 370.00 (130.00) (26.00) 

Truck Naintenance °400.00 225.00 CUt5:-60) -€43...75) 

Total General and Admin. 18100.00 livisd 62 (340538) “Ci. 68> 

Net Operating Profit 24720.00 29232.38 $512.30 18-20 

Other Income/(Expense) 

Net Income 24720.00 29232.38 4512.38 16:25 

income Statement (Include Budget information) Me 
Procedure: Choose Income Statement from the GL Report menu. 

Click on the Include Budget Information button. 

Options: Select any month or series of months. 
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LEARNED LUMBER CO. 

Hermosa Beach Store 
For 2 months ending 2/28/1987 

Operating Revenues Percent 

Lumber-Hermosa 9366.00 33:22 

Bldg Nat!l-Hermosa 2726.00 10:23 

& P| ywood-Hermosa 4342.00 is Bae he 

Net Operating Revenues 26656.00 £100.00 

Cost of Goods Sold 

CGS-Lumber-Hermosa 760.00 2:93 

CGS-Bldg Mat!l-Hermosa 355.00 hes 

CGS-P!lywood-Hermosa 1395.00 aueo 

Total Cost of Goods Sold 2530.00 9.49 

Gross Profit 24126.00 90.51 

General and Administrative Expense 

Ofc Sply-Hermosa 240.00 0.90 

Post age-Hermosa 226.00 0.66 

PR-Hermosa 7600.00 29.26 

PR Tax-Hermosa Bat. C2 2.09 

& Tel ephone-Hermosa 911.25 3.42 

Total General and Admin. Expense 9736.9? 36:33 

Net Operating Profit 14389 .03 53.98 

Other Income/(Expense) 

Net Income 143869 .03 33.98 

& Departmental Income (Normal Income Statement, Tabular) 
Procedure: Choose Departmental Income from the GL Report menu. 
Options: Select any month or series of months. 

Remarks: Report is titled with the name of the Department. 
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LEARNED LUMBER CO. 

Hermosa Beach Store 
For 2 months ending 2/28/1987 

Revenues $26656.00 = 100.00% 

hed Returns and Allowances $0.00 = 0.00% 

HEE Cost of Goods Sold $2530.00 = 9.49% 

Expenses $9736.97 = 36.52% 

Profit $14389.03 = 53.98% 

Departmental Income (Normal Income Statement, Graph) 
Procedure: Choose Departmental Income from the GL Report menu. 

Choose Graphs in the File menu. 
Options: Select any month or series of months. 
Remarks: Report is titled with the name of the Department. 
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LEARNED LUMBER CO. 

Hermosa Beach Store 
For 1 month ending 2/28/1987 

Period % YTD 2 

Operating Revenues 

Lumber-Hermosa 4588.00 33.91 9388.00 35.22 

Bldg Nat!l-Hermosa 1350.00 9.98 2726.00 105.23 

Pl ywood-Hermosa 7592.00 56.11 14542 .00 S155 

Net Operating Revenues 13530.00 100.00 26656.00 100.00 

Cost of Goods Sold 

CGS-Lumber-Hermosa 380.00 2,61 780.00 2.93 

CGS-Bldg Mat!l-Hermosa 180.00 ees k 30008 Lead 

CGS-P|lywood-Hermosa 695.00 5.14 1395.00 S23 

Total Cost of Goods Sold 1255.00 9.28 2530.00 9.49 

Gross Profit 12275.00 90.72 24126.00 90.51 

General and Administrative Expense 

Ofc Sply-Hermosa 140.00 103 240.00 0.90 

Postage-Hermosa 78.00 0.58 228.00 0.86 

PR-Hermosa 3900.00 28.82 7800.00 29.26 

PR Tax-Hermosa 278.86 2.06 557.72 2.09 

& Tel ephone-Hermosa 490.05 3.62 911.25 3.42 

Total General and Admin. Expense 4886.91 3031-2 9736.97 36.53 

Net Operating Profit 7388.09 54.61 1458903. .53,.98 

Other Income/(Expense) 

Net Income 7388.09 54.61 14389 .03 53.98 

& Departmental Income (include Year to Date) 
Procedure: Choose Departmental Income from the GL Report menu. 

Click on the Include Year to Date button. 
Options: Select any month or series of months. 

Remarks: Report is titked with the name of the Department. 
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General 

PR-Hermosa 

LEARNED LUMBER CO. 

Hermosa Beach Store 
For 2 months ending 2/28/1987 

$ 
Variance 

2388.00 

(274.00) 

Jae OU 

To 
Variance 

2656.00 

30.00 

15.00 

C1035. 00) 

2716.00 

60.00 

(172,00) 

1800.00 

athe 

(88.75) 

33393 

(43.00) 

30.00 

Budget Actual 

Operating Revenues 

Lumber-Hermosa 7000.00 9388.00 

Bldg Mat !l-Hermosa 3000.00 2726.00 

Pl ywood-Hermosa 14000.00 Lst2c00 

Net Operating Revenues 24000.00 26656.00 

Cost of Goods Sold 

CGS-Lumber-Hermosa tab; 00 780.00 

CGS-Bldg Mat!l-Hermosa 340.00 g25.00 

CGS-P|lywood-Hermosa 1500.00 1395.00 

Total Cost of Goods Sold 2590.00 2530.00 

Gross Profit 21410.00 24126.00 

and Administrative Expen 

Ofc Sply-Hermosa 180.00 240.00 

Postage-Hermosa 400.00 228.00 

6000.00 7600.00 

PR Tax-Heramosa 500.00 557.02 

Telephone-Hermosa 1000.00 911.25 

Total General and Admin. 8080.00 9736.97 

Net Operating Profit 13330.00 14389 .03 

Other Income/(Expense) 

Net Income 13330.00 14389 .03 

Procedure: 

Options: 

Remarks: 

D-I12 

1059.03 

Departmental Income (Include Budget Information) 
Choose Departmental Income from the GL Report menu. 
Click on the Include Budget Information button. 
Select any month or series of months. 
Report is titled with the name of the Department. 
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LEARNED LUMBER CO. 

Balance Sheet 
2/28/1987 

ASSETS 

Checking 

YY Current Assets 

Money Market Account 

Prepaid Insurance - Fire 

Prepaid Insurance - Trucks 

Prepaid Taxes 

Accounts Receivable 

Total Current Assets 

Inventory 

Beginning Inventory - Lumber 

Purchases - Lumber 

Beginning Inventory - Building Mater 

Purchases - Building Naterials 

Beginning Inventory - Plywood 

Purchases - Plywood 

Purchase Discounts 

Total Inventory 

Fixed Assets 

Trucks 

Accumulated Depreciation - Trucks 

Furniture 

Accumulated Depreciation - Furniture 

Buildings 

Accumulated Depreciation - Buildings 

Total Fixed Assets 

Total Assets 

@ cic 

Options: 

Balance Sheet 

hott (1.30 

9210.00 

fetes se 

(10.01) 

92078.38 

30000.00 

(6500.00) 

12500.00 

(3500.00) 
350000 .00 

(35000.00) 

307049.68 

Choose Balance Sheet from the GL Report menu. 
Select any one month. 
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LEARNED LUMBER CO. 2 

Balance Sheet 
2/28/1987 

LIABILITIES AND EQUITIES 

Current Liabilities 

Sales Tax Payable 

Federal Payroll! Taxes Payable 

State Payroll Taxes Payable 

Accounts Payable 

Total Current Liabilities 

Long Tera Liabilities 

Ist National - Buildings 

Ist National - Trucks 

Total Long Tera Liabilities 

Equities 

Capital Stock 

Retained Earnings 

Total Equities 

Net Profit 

Total Liabilities and Equities 

Balance Sheet, Page 2 

D-14 Business Sense 

6008.65 

3632.64 

1035.20 

6227.61 

23904..50 

190750.00 

3000.00 

195750.00 

60000.00 

176163.00 

256163.00 

29292. 30 

507049.68 



LEARNED LUMBER CO. 

Trial Balance 
2/28/1987 

Account Title 

O10 Checking $5164.32 eee TEE CTIGT aL TAT CE 11 Seana MISE LT PRISTON 

aes aanemanearae Se a ee ae 

fost ea eee ee erg 

joao 7 Ne aieeneed Dela) 1] Hemeaanas 

hater etree kee ee os ae aaa 7 ie a 

Aes apie hate ES aT cn) TU ancy 9 SP 

ein becinging Inuentcou > Euidine Heueicla | ieee Go| 

Soeen ea ictaiieted cies icine ee 

is30000 Baginnioa (euentond Gklueond a ool 

1521 Purchases - Plywood: ede ce hohshncen teers Se eg re na rae aie 

renee SE a a Ce a a 

ee canoe San nr P er IP TEP ree Sins =i NEE GHMMEAERTERLINE Cable raya 

eueriaeeseveh uahons aaa (aes Tr 77 pec 

ee pecunulaced r prec ec acd NE ‘eeu 3300.00 

peasathasnacceaatda ice! FTI 11 ai SOR MAA nil cary 7-7-1 | Ries 

wr Accu een a ee oes 

is" cna Soe on = Sank ne 

oe peqaear wichhelatna ee eee RN STEVE RENS! LMFT TMU ET Tey Comrie eee oe 

bd18/0002 FGA Payable EERE. SERA PETER Y AAT TETTETITS RATIO TTT TEST PR AREES Bren tr Te re ry 

& p 019/0001° State Wi th holding lake eRe Mae SSeS fs (6,0, 6:850,0,0,0;0;8 161200 

b019/6003 sbi Payable RIT Lene eMC TET TCP OR TT ET TREE CEE ORNT TREC STCNETSSN OS) COPPREEEELISAREAT SEN SNSTINOE EN LUECOMEE EE EERE eos 

Ds00 ANE aol Frc eae suivaincs Ee Ne TET TE TTT (COE ETM TT TESTS arreeter Tren 

2505 fist National = Trucks Do ccnmmmmmmnnaf sommnnnd 000,00 ange pocicar Stcee Se eR REET SPER NOR eT Ore eT NT eT TT NN (ne ORE ETE STEER TCRIOS Ureesr Phere? Bene any 

ane povaived Earnings. ee TRC ETT TTR RCH eT rere RErrre oan 

PE ean ero epee rr eam a) a ais Gas aan ce 

ie Dea a aaa a a a Sean 

020/01 sere TET ELE CLiTT TT Cae eiaaaaamnaNgainaaade enUinLieN id) ee 3736.00 

Fe aaeue Bia Ln SS Rae Pe Pe ea oe Pay 

coso7on eiieeads ice oes [icc ALU A mnie MA (4842.00 

anaes bast: pipose Sones i SR ae SA ec (aaa Sas 

EE ue Epa egSe TT NC iaac cne aa  eaTY r  aa 

rae icscusber canta Henican any a it | a aeeuuneiee 

5020/01  |CGS-Bldg Matl-Hermosa 88500 T ssn Ea saiae Regane pesceidg Hall sante fenica iH 06 | Reece 

5030/01 i. "EES Pi yasod-Harecs a ana tikes i398.00, 

Trial Balance 
Procedure: Choose Trial Balance from the GL Report menu. 

Options: Select any month or series of months. 
Print individual customers versus accounts receivable summary. 
Print individual vendors versus accounts payable summary. 

Print zero balance accounts versus omit them. 
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Procedure: 

Options: 

LEARNED LUMBER CO. 

Financial Ratios 
2/28/1987 

Ratio Name 

Current Ratio 

Quick Assets Ratio 

Cash Ratio 

Net Working Capital (1000's of $'s) 
Debt to Assets Ratio 

Debt to Equity Ratio 

Long Term Debt to Equity Ratio 

Receivables Turnover Ratio 

Average Collection Period (in days) 

Inventory Turnover Ratio 

Assets Turnover Ratio 

Gross Profit Margin Cin %) 

Net Profit Margin (in %) 

Return on Assets (in %) 

Return on Equity (in &) 

Financial Ratios 

Choose Financial Ratios from the GL Report menu. 
Select any month or series of months. 

D-16 Business Sense 
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. 68 

39. 64 

UIA 6 

. 76 

.68 
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40 
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LEARNED LUMBER CO. 

Checking Check Register 
For th 

1231 02702 Federal Express netted cite, 56+ 00° 231 02702 i cs ne pees 
voocee [92202 nes eae Ea ta | Sac 

“ar ase Sa mean anni sin RO 
i. ioe at re cee 

Prag pa Rat lena Cethehhegg gn Oe 
er me PoC eee 

ee |e Saeear cea ti 
Sa (Ec (ZA CLR PRECTT 7771 Mn aes 

ee ory ee David, Sam R:80 x 12.50/Hr = 0 Sta pie fai econ ie a en eer See in 
a ott Paes 

(N242 00 (02715 nice ets 

& Check Register 
Procedure: Open the Cash Disbursements Journal window. 

Choose Check Register from the GL Report menu. 
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LEARNED LUMBER CO. 

Checking Cash Flow Analysis Starting Balance 
For the month of February, 1987 39058.90 

P2/02 [Total Deposits S| 622] 8192162 | 
D2/02 |3 Checks, 1231..1233 Pe stawaceuiee ic sea 471.00] = 41450.62 | 

p2/05 [i other Credit <i +i 10.00] ——+41440.62 | 
p2/09 [Total Deposits EEA) SE EK 7 “wy 
p2/09 [i Check, 1234. *i{ ‘| 980.10] —-42377.52| 
pa/it [i Check, 1295] dT OOO] 4226 7.52 | 
p2/i4 |i Check, 1236 +‘ -*‘i{ 280.00] _41987.52| 
p2/is [6 Checks, t23r.i242 | ~*d —steaz 23] 3734023 | 
02/16 [Total Deposits 6163.16] ——*+| ———-43503.39 
02/23 [Total Deposits EL) 1 
p2/25 [Total Deposits r400.00[ «iY 4516432 | 

Totals: 12603.81 6498.39 45164.32 
Marthe eee ete Meee teeta teeta teeter en eta tate e terete te tatan ene tamete tata tatarntararatarararataararararararararararararanarararararatetaratataratn sm sree remata na tataraterama ta mamatateraratatanatata tans Ms arate tetera tera rarararanararatararnranrararararatatanntn uraratatatn rata rararanarararararerararararatararatararatatatararatareta 

Re ee Be eee eee eee eee EERE HEHE EEE EERE EEE EEE E ESE REET EHH EEE EEE EEE EEEE SEER EEES SEES MD SOSH EE EEE EE EH ESTEE EH EEE SESE MEOH EEE TEESE SEE HEHE EESEE TEESE ED EEEEEEEEEEEEETEE EEE SEE HEE EEE EE EEEES 

POOR Ce en es Ol ae 

ORCC Ce ee ee eee Pee ee ee ee ee eee Ce ee ee ee 

ee ee ee eee eee eee Cee eee ee ee eee eee eee eee EEE eee eee eee REE EEE EEE ED (Cee eee eee eee ee eee ee ed 

COCR e ee ee ee eee eee ee eee ee ee eee eRe OCC eee Cee RRC RRREREEEERE COMER OREM EMMEREREEMMEEREREREE POUR E RESO Ree eee eee eee eee 

ee ee ee eee ees eee ee eee eee eee REE Meee eee EERE EERE EERE EEEMEEEE MERE REE MEE EE EEE REE REE EMER EMRE eh hy 

ieee eR Cee eee RACERS OCC ee eR R RO CRRMRREEEES (OREO OC eRe eee Ree RES EC RECESS 

a"e"e"e"e"e"e"e"se"ee"e" of o's e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"n"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"s"e"e"s"e"e"a"e"e"e"e"e"s"e"e"e"e"e"e"e"e"e"e"e"e"e ahh "e"e"e"e"e"e"e"e"e"e"e"o"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"s Pha "e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"b"e"e"ee"e"e"e"s Pha 'e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"s"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e" 

CORR) Ce ee ee ea Cee eee eee RRR C CREE OCMC eee Cee CERO ORERRMERMERERES (OCC E RCE O ROE CRC eee eee eee ee 

ee ee Be ee eee ee ee eee ee ee eee EERE REED (REE EEE ee ee Eee EERE SE Ee eee ee eS 

POPC ee ee ee eee ee ee RRR PPR EREERE PROC ERE CREME REREREMEERREEESE EOOUOOO OOOO RE CER Eee ee ee ee ee 

“e'e"e"e"e"e"e"e"e"e"e's"s ie "o"e"e"0"e"e"e"0"e"e"e"s"e"0"e"0"e"e"e"e"e"e"e"e"s"e"e"e"e"e"e"e"e"e"e"e"e"s"e"e"e"e"e"e"e"e"e"e"e"e"e"e"ee"e"sMe"e"e"e"e"s"e"s"e"e"e"e"e"e"e"s "Phe “o"e"e"e"e"e"e"e"e"e"e"e"e"o"e"e"e"e"e"e"e"e's"a"ee"s" ail "o"e"e"e"e"e"a"e"e"e"e"e"e"e"e"e"e"e"e"s"e"e"e"e"e"e"e"e GR “o"e"e"e"e"es"e"e"e"e"e"e"e"s"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e” 

OO) Ce eR Ce ee ee eee Cee ee ee eee eRe RE RERREEEES (COO e Ee R Eee eee eee eee eee ee eee ee 

<e*e"e"e"e"e"e"0"s"e"e"0"e" ofl oe"0"0"e"e"e"s"e"e"e"e"e"e"8"e"e"e"e"e"e"e"e"e"0"0"e"e"e"e"e"e"0"0"870"0"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"ee"ee7ee"e"e7e"e"e"e"e aah ee"e"e"e"s"e"e"e"e"e"e"e"e"o"e"e"e"e"e"e"e"e"e"e"e"e"e-Phe’o"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"a"e"e"e" es ee ee eee eee ees (eee ee eee eee ee 

CeCe ee ee ee eee ee ee eee eee eee ee eee eee eee CROMER RRR EREEES COCe COREE RREREREREREREREEEEE CECSEECERECECEEOCEEEERCREOOE EE CCC Cee eee ee ee ee 2 

eee Cee eee ee eee eee ee ee eee ee eee eee EEE EERE EEE EE EEEE MEM EEE MERE EERE MEEEEEEEREREEM PERE EEEE EEE MEERERESEREREMEEE BEUEE EE UE MEER EMER EEE EEE REE REE eT 

eee Ree, Cee ee ee eee ee ee eee ee eee ee eC R RRR Cee eee eee eee eee eee eee eee RRRREMEED (COCR eee eee eee ee eee ee 

Pee Cee eee eee eee eee eee eee eee ee eee eee ee ee eee ee eee EERE REESE Bee eee ERM EERE EEE EEEEEEE See eee eee EERE EERE EERE EEE (PEER Ee EEE Eee ee ee ee ee 

Tae e ee ee ee RR RRR Ce PRR Ce 

Oe Ree eee eM OOO EEE H HEHEHE EEE EE EEE EE EEE EEEEEEEEESE SESE TEESE EEE EEEESESEEEEEE EEE HES MESHES EET ES EEE EEE EEEHEEE TEES MEETS EEE EES OSE ESET EEE ESEEEE SS SEES EEE EEE EEEEESEEESESEEEEEEEEEES 

Me etetetatetetetatatetete Ba ete hetatetatetatetetetatatatetetataretatatatehatatetatatatatatatatatatatatataratatatatatatatatatatatatatatatatatatatetataretetatatatatatatateta te tatetetatatatatatatatetatetetetetatatatatatatatatetate Mena tetatetetatatatatateteteratetatarateharateratatatatata mene tatatatatetatatatatatatatatatetatatatatatatatatetatatatatatatatatate” 

COCO Re Hee MEOH EEE EEE EEE EEE EERE EEE EE EEEEEEHEEEEEEEEE EEE EES EE EEEEEEEEEEE ESE SEES ESM EEEEEE EEE SEES SESE SEEEEE EEE ES MH SESE O OSE SEES ESE SESE EEEEEEEEO MH TEESE EEEESESEEESEEEEEE SESE EE EE EE EES 

Hate te tate aaa tate te tate a arate he tate haha Matera Matera eM Meena et aa ne Matera tetera tatatataMatatarataratatatntaretataratatatareratatatararararatann tata tntatatatata ara afratatate tata tntarareta tate tatatatatn re tatntatatararn tn a Tla a tataratateratnnataratatatataratatarerate rata rn tatate tn Mu" atatetatataratareratatatarararatarara rata taratatntata tata tatatatatn*n 

Cash Flow Analysis (Tabular) 
Procedure: Open the Cash Disbursements or Cash Receipts Journal. 

Choose Cash Flow Analysis from the GL Report menu. 
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LEARNED LUMBER CO. 

Checking Cash Flow Analysis Starting Balance 
For the month of February, 198? 39058.90 

$45164.32 

$36131.45 

$27098.59 

$18065.72 

$9032.86 

$0.00 

$9032.86 

$18065.72 

$27098.59 

$36131.45 

st es32 eek Ss eae gs eas See Re ee tae lee’ poe” 3 
0 

0 0 
890 12345678 9 

& Cash Flow Analysis (Graph) 
Procedure: Open the Cash Disbursements or Cash Receipts Journal. 

Choose Cash Flow Analysis from the GL Report menu. 
Choose Graphs in the File menu. 
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LEARNED LUMBER CO. 

Checking Account History Starting Balance 
39058.90 
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eee dna eee eget ORS 81 6496.39] 419164 52 

Account History 
Procedure: Choose Account History from the GL Report menu. 

Options: Select any account. 
Select any month or series of months. 
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General Ledger 

LEARNED LUMBER CO. 

For 2 months ending 2/28/1987 

Checking Starting Balance 0.00 

Total Debits, Credits, and Balance 60022.67 14858.35 45164.32 

1020 Money Market Account Starting Balance 0.00 

1/01 OPEN BOOKS - JAN 1, 1987 GEN OPEN BKS 20000.00 0.00 20000.00 
Total Debits, Credits, and Balance 20000.00 0.00 20000.00 

1025 Deposits Paid Starting Balance 0.00 

Total Debits, Credits, and Balance 0.00 0.00 0.00 

1030 Prepaid Insurance - Fire Starting Balance 0.00 

01/01 OPEN BOOKS - JAN 1, 1987 GEN OPEN BKS 2500.00 0.00 2500.00 

Total Debits, Credits, and Balance 2500.00 0.00 2500.00 

1031 Prepaid Insurance - Trucks Starting Balance 0.00 

01/01 OPEN BOOKS - JAN 1, 1987 GEN OPEN BKS 5250.00 0.00 $250.00 

Total Debits, Credits, and Balance §2:50:..00 0.00 5250.00 

1040 Prepaid Taxes Starting Balance 0.00 

01/01 OPEN BOOKS - JAN 1, 1987 GEN OPEN BKS 4230.00 0.00 4230.00 

Total Debits, Credits, and Balance 4230.00 0.00 4230.00 

1500 Beginning Inventory - Lumber Starting Balance 0.00 

01/01 OPEN BOOKS - JAN 1, 1987 GEN OPEN BKS 20000.00 0.00 20000.00 

01/31 Jan Cost of Goods Sold GEN JAN CGS 0.00 800.00 19200.00 
02/28 February Cost of Goods Sold GEN FEB CGS 0.00 760.00 18440.00 

Total Debits, Credits, and Balance 20000.00 1560.00 18440.00 

1501 Purchases - Lumber Starting Balance 0.00 

01/15 Purch. $00 2 by 4 - 5° Long PUR D 778925 1232.59 0.00 1T232°559 

01/15 Purch. 400 6 by 8 - 5‘ Long PUR D 778925 2362.88 0.00 3595.47 

01/20 Purch. 100 Redwood Planks PUR D 779915 500.26 0.00 4095.73 

02/16 Purch. 400 6 by 8 - S' Long PUR D 780115 2362.88 0.00 6458.61 
Total Debits, Credits, and Balance 6458.61 0.00 6458.61 

1510 Beginning Inventory - Building MaterialsStarting Balance 0.00 

01/01 OPEN BOOKS - JAN 1, 1987 GEN OPEN BKS 15000.00 0.00 15000.00 

General Ledger 
Procedure: Choose General Ledger from the GL Report menu. 
Options: Underline in Chart Of Accts, Customers or Vendors, for selective report. 

Print One account per page. 

Print the Cash accounts in detail versus summary. Print Customers in 
detail versus summary, Print Vendors in detail versus summary. 

Remarks: Printed directly, on plain paper. This is a lengthy report. 
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LEARNED LUMBER CO. 

Open Invoice Aging 
2/28/1987 

AR Aging (Open Invoice) 
Procedure: Choose AR Aging from the AR/AP/Payroll Report menu. 
Options: 1 to 4 Aging Periods. All Open Invoice customers, underlined customers 

or single customer. Include Credit Memos vs. omit them. 

Remarks: Only Customers with Open Invoice aging will appear. Turn off recent 
Aging Periods to focus on older invoices. 
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LEARNED LUMBER CO. 

Balance Forward Aging 
2/28/1987 

AR Aging (Balance Forward) 
Procedure: Choose AR Aging from the AR/AP/Payroll Report menu. Click on the 

Balance Forward button. Click on the OK button. 
Options: 1 to 4 Aging Periods. All Balance Forward customers, underlined 

customers or single customer. Include Credit Memos vs. omit them. 

Remarks: Only Customers with Balance Forward aging will appear. 
Turn off recent Aging Periods to focus on older invoices. 

: Appendix D: Reports D-23 



LEARNED LUMBER CO. 

invoice Register 
For 1 month ending 2/28/1987 
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Invoice Register 
Procedure: Open the Sales/AR Journal. 

Choose Invoice Register from the GL Report menu. 
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LEARNED LUMBER CO. 

Sales Tax Report 
For 3 months ending 3/31/1987 
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Sales Tax 
Procedure: Choose Sales Tax from the AR/AP/Payroll Report menu. 
Options: Select any one quarter. 
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LEARNED LUMBER CO. 

Sales Commissions 
For 2 months ending 2/28/1987 
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Sales Commissions 
Procedure: Choose Sales commissions from the AR/AP/Payroll Report menu. 
Options: Select any month or series of months. 

All employees, underlined employees or single employee. 
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LEARNED LUMBER CO. 

Customer Analysis 
For 3 months ending 3/31/1987 
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Customer Analysis (Tabular) 
Choose Customer Analysis from the AR/AP/Payroll Report menu. 
Select any quarter or series of quarters. 

OO De ee ee ee OO 

All customers, underlined customers or single customer. 
Print customers with zero activity. 
Show cash sales for comparison. 
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LEARNED LUMBER CO. 

Customer Analysis 
For 3 months ending 3/31/1987 

Total Customers $52052.00 = 100.00% 

Tall Pines Estates $16356.00 = 31.42% 

O 

eee Cash Sales $20687.00 = 39.74% 

Bd Allen Contractors $6700.00 = 12.87% 

= Ocean Front Sales $3900.00 = 7.49% 
te be erat erate 

Ye All Others $4409.00 = 8.47% 

Customer Analysis (Graph) “"y 
Procedure: Choose Customer Analysis from the AR/AP/Payroll Report menu. 

Choose Graphs in the File menu. 

Options: Select any quarter or series of quarters. 
All customers, underlined customers or single customer. 
Print customers with zero activity. 
Show cash sales for comparison. 
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LEARNED LUMBER CO. 

Accounts Payable Days Until Due 
2/28/1987 
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& AP Aging (Age Days Until Due) 
Procedure: Choose AP Aging from the AR/AP/Payroll Report menu. Click on the 

Days Until Due button. Click on the OK button. 
Options: 1 to 4 Aging Periods. Include Credit Memos. All vendors, underlined 

vendors or single vendor. 

Remarks: Shows all open invoices. Past due invoices are shown in the 0-7 
column. 
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LEARNED LUMBER CO. 

Accounts Payable Days Past Due 
2/28/1987 

Acme Sash & Fra {0 
eee eee eee Shed eee Cee eee eee eee Cee eee Reh CREE eee ee Sa trae a Set a aries toto oe a oe or ord 

titties Pes Cee Cee eee eee eee! (CeCe CEC eee Eee eee CeCe CCE C CeCe eee eee CeCe eerrr rere erin) Cle ree ee eee ee ee ee 

ttt ttt, Pe, POPP Pee eee PPPS eee) CeCe eee CCPC eee Eee) COC eee eee ERE EEeEeEes (CECE CEEEEE ESE eee! SECC ee ee eee eee eee ey 

Totals: 3595.47 3595.47 . . . 

RCT ONS INOS LEN TONI LOTTE ED OTE REE ESET SEA SUPE ARERLTRU FSMRURERER MRA AM/OTIEM, PON Race Nit Minti neatan 
BSEBSSSESSFEBSIZSSZSSESESEBSE(ZSSZSSESESEBSSSESIZSSESSSESBZSEISZSSSESZSZBEZES ES 

See itera Pemerrener rey (ttn Foss caatacaad Vaisssatndaassaiiae Lasence inclement Magic crue, ane 
Totals 4417.47 4417.47 

eee Meee MERE EEE EEE EERE BEE EEE EERE EREE EEE CECE eee Shee ee) Cee ee eee eee eh Pe he et $e ra eee ee ed 

ET TTT NON Ce Taree NUR OT ROTC Ce eneaee ny (Tener eReTre? Cte NRenEn! Se Me ttenen seamen 
ee, SN SERN PRR CTTEN LORRI CRIM INE MURR Rated Monn nTr tere 
Te eM (COHAN [ene a ORE HEC ONNTEL PVRS TERE TT! SPECT ENUM ETEN (ROME OT n 
TTS COP Tre (ROC UCR TEN Eke ene) Gene e Me (MET pee meets 

NET ETT, CPEET IEE IRE RSTES AEN ROCTRMEEY STIS MAUNETERIEPAEE SNEED, COT RALIARLANUAARR AE: ERAN EATER ERIE SNR NR SRM MrIEN te 

Eee OTE COLNE LORETO T CTT A MINTERRETE SEITE! ICON MEROE NI) Met nt ment 
CO RET ee CARTE CNET TT CUTRT CO MEAT NE TARTTEST ETT CTT TC I NnTy erent ere 
stds cated hasnt ooocebdat fl waseeiankde Metadata trust A tag ta iia aeaiv Ue ieee ded daxssanamerdcehenei laussnaataneandodsdk Sarton pusttees 
eT TET TROON (MERON ATOR RNT CoennCrT mE Te RE TEe QTC METER Tn, OMT vrecet ttre 
CNT OT BROS PRCA TRECERNG LTT TION ET (EMT ee eee (ORNS VENNE (SSEerER ten eer 
Pa RET T er RUCTS UTNE VENT (MONT Ty NCETM CPOE TE SE AOTRENEROTE TORTIE NM (meter tn nent 

SEL E OT AT TET STCECEMY TNE OETET OE! LOOT T NEEL IERIE STORE LOM TE MER ONER ETOP: TPE mD MER eEPREOr 

Eh attaeaaussd Da lbesetdsrents cS ecpsss  caaansthuc each Mseay 08 re dedcedc Ral ed cde fecepedagtads A beziotaastanaoi es Mateo eae eesin a bcete esa eRe 
PERT (LTS MTT METTLE eee S EEE ee: ERT ae [amen 
aap ta anaiaecitea tices Mechanic eda edpesbictsss Ss dahoasa nooo neta Be erhaapiaes neate A aapeseuccante MAO eseesencsias eos ata nei bod 
asada le siaeeaea aoa adorns gaenboananetens Bete uatecinunena BAe he atengmnanin a Bat reia diode MS aad een cel 
en ONTENTS ORTON OTTER MenCent Cite tenants SNC Mr en mVEten (CMT ORn RET Oe [Smee ter teeter 
RO OTT CTE ENN CNET Cy SVCRON MONIT CUT TMOON [RnR n sam 
OEY SLTENT (RSTRORNTTT UAE SMTTERT, HUT UMERE EEE: GZORERT CCIE NORRIE ETON ORD: (Otte eer nrtore 
ETA ES CETTE OTM TITS CTT SNS (eeemnTAaUDE: | nrmnEETERNTORN, (OTe enttrer tine yet 

LOE ET LAIN MEET SREN LOR UEUME ATCT FIMERONTORCENS (CRMMERTRETEL SEMTR ERC NTS, (eRe ny ny 
REE RETA ML RANKL LTC LETT Mc eTeT CTE ROREE SEE (RACE ER te emer 

Laelia ae ese cy bat grates ceo Aun A naa ese ualld eeaax easing alas Beainans iadnsassne Medicina 
REN NUNN, SMR eD CNT! LETT ENvenN UMPC arr COMM Meee reren mnt 
eT ONE) REIN ERGOT CORSE SIT AOU RE TTT (CM nnennnT ene e (Ruan ar tree 
RENT TTEY REA CRUEL ON PROCEMOMAME! REINS MOREE RUR IE COMIN TS mT! Tremere 
ee eee! nT! CeIn ee SECO NTEG ME NNTCCON: UnTaRIOnTE Rei. SRCCmnE nn OSnnN, (tir nie M ETE HFT? 
TO I PM RITE IRON U re! Mnen iene ERAC TE RTEN ERM ON TERN OTEN inereeee erences 
OE ETE ONS CRORE COIN LCCMMENOEM TTORVRTARES FERRETTI IneRer ae a rte 
ETT NE TTT TORTS PROTEC SETTERS (OUNCE CAP TTTRTeTEN TON! SFT Ter nr EMEnCEN rnmcyviNnn nto 

AP Aging (Age Days Past Due) 
Procedure: Choose AP Aging from the AR/AP/Payroll Report menu. Click on the 

Days Until Due button. Click on the OK button. 

Options: 1 to 4 Aging Periods. Include Credit Memos. All vendors, underlined 
vendors or single vendor. 

Remarks: Shows only due and past due invoices. Turn off recent Aging Periods to 
focus on older invoices. 
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LEARNED LUMBER CO. 

Vendor Analysis 
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Vendor Analysis (Tabular) 
Procedure: Choose Vendor Analysis from the AR/AP/Payroll Report menu. 
Options: Select any quarter or series of quarters. 

All vendors, underlined vendors or single vendor. 

Print vendors with zero activity. 
Show cash expenses for comparison. 
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LEARNED LUMBER CO. 

Vendor Analysis 
For 3 months ending 3/31/1987 

Total Vendors $6383.77 = 100.00% 

Cash Expenses $4473.00 = 70.06% 

i Acme Sash & Frame $650.00 = 10.18% 

Dover Lumber Milling $490.25 = 7.67% 

st Clark Products $470.00 = 7.36% 

Y = 2, Zh All Others $300.52 = 4.70% 

Vendor Analysis (Graph) “ 
Procedure: Choose Vendor Analysis from the AR/AP/Payroll Report menu. 

Choose Graphs in the File menu. 

Options: Select any quarter or series of quarters. 

All vendors, underlined vendors or single vendor. 
Print vendors with zero activity. 
Show cash expenses for comparison. 
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[J voio [] CORRECTED For Official Use Only 
Type or machine print PAYER’S name. street address. city, state, and ZIP code OMB No. 1545-0115 

LEARNED LUMBER CO. 

6700 Hermosa Way ae 1987 Miscellaneous 

Hermosa Beach, CA 90415 ai Income 
Statement for 
Recipients of 

PAYER’S Federal dentitication number | RECIPIENT'S dentification number 3 Prizes and awards 4 Federal income tax withnetid Copy A 

95-1 2949547 123-435-4789 $ $ For Internal 

Notice and 
instructions for 

Street address 

788 Forrest Lane $ 650.00 
completing this 

City. state, ana Z1P code 9 Payer made direct sales of $5.000 of more of consumer form. see 

Mendicino, CA 96659 products to a buyer (reciprent) for resale ms Instructions for 
Forms 1099, 

Account number (optional) 
1098, 5498, 1096, 

Form 1099-MISC Do NOT Cut or Separate Forms on This Page Avereree | A. Depariment af tne Tressury—tecsrasl Revenue Service 13. 7070002 

Type of machine print RECIPIENT'S name (first, middie. last) 5 Fishing boat proceeds 6 Medual aad Realth cave payments Revenue 

Jack Franklin $ $ Service Center 

7 Nonemployee compensation | & Sudstitute payments in lieu of For Paperwork 
Omdends or imerest Reduction Act 

$ 

1099 Forms 
Procedure: Choose 1099 Forms from the AR/AP/Payroll Report menu. 

Options: Threshhold earnings to trigger forms. 
All vendors or underlined vendors. 

Remarks: Printed directly on pre-printed forms. 
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LEARNED LUMBER CO. 

Monthly Payroll Report 
For 3 months ending 3/31/1987? 
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aa opetele teh ey S44" 30 wari ie seule F088. 40 4 ‘e884 o 

TERETE EEE TERETE eee eee eee COCO RCRA See eA RCA? (See) CC ee ee? (ee Ce 

ee ee he % Se te ee ee ee Ne et NN a 

Payroll a) 
Procedure: Choose Payroll from the AR/AP/Payroll Report menu. 
Options: Select any quarter or series of quarters. 

All employees, underlined employees or single employee. 
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1 Controt number For Paperwern Reduction A! Foy Oficial 

pw _ | ezeee | EES coe 
2 Employer's name. address. and Z!P code 3 Emptoyer s dentsticaton wumber 4 Emonove s state 0 sumper 

LEARNED LUMBER CO. 935-1234567 111=2222 
? oOtota Te orreg 

6700 Hermosa Way § Statvtwy Occceosed 
e™olever 

Hermosa Beach, CA 90415 
7 Aovarce £'1C darmert 

B Emopteyee's sacral security aumoer 9 Federal income tax withneld 10 Wages trios other compensation L 1 Soceal securety tan ert ned 

111-22-3436 400 .00 3000.00 214.50 
12 Employee's name (first. middle, iast) 13 Social security wages 14 Soc:a: secu: ty "Ds 

John T. Carson 3000.00 
16a S-mge reretts mci om Bos 10 

John T. Carson 

431 8th Court 

Un i t B SF Score 440 Z 00 18 Store 3000. 00 FALIF.., 

Venice, CA 90291 R 
15 Employee's address and ZIP code 36.00 3000.00 eeeepie ul 

sore W-2 Wage ond Tax Statement 1 OE Capy 4 Per Gece! Genwty Admeasweten © See instructors ter Porm W-2 and ©-2P ye 
7Bee Oe NOT Cut of Seoarate Forms on This Paoe saa ; 

W-2 Forms 

Procedure: Choose W-2 Forms from the AR/AP/Payroll Report menu. 
Options: All employees or underlined employees. 

Remarks: Printed directly on pre-printed forms. 
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LEARNED LUMBER CO. 

02/28/87 1447.00 Acme Sash & F/I nv AS 3350 1256 2050/0150 625.00 
oe Acme Sash & F/Inu# AS 3258 1256 2050/0150 822.00 

LEARNED LUMBER CO. MATIONAL STATE BANK 
DOWNTOWN OFFICE 

YOUR CITY, STATE 12345 

00-6 789-0000 

6700 Hermosa Way 
Hermosa Beach, CA 90415 

DATE AMOUNT 
###1,447 Dollars and 00 Cents 

02/28/1987 $1,447.00 

Acme Sash & Frame 
788 Forrest Lane SAMPLE - VOID 

Mendicino, CA 96659 FORM 081013 
COMPATIBLE ENVELOPE 001560 - 081608 

POO0’«2SE" wOOOCOG THAI ’23456 78 

Vendor Checks “oY 

Procedure: Close the Cash Disbursements Journal window. 

Or: choose Reprint Entry from the File menu. 
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LEARNED LUMBER CO. 
g yah oa f 

02/28/87 617.62 John J. Brown/PR-Hermosa 1250.00 Gross YTO 3750.00 

aes John J. Brown/Federal With # 228.00 Federal YTD 684.00 

er John J. Eroawn/FICA Payable # 89.38 FICA aie) 268.14 

aa John J. Brown/State Withho # 100.00 State YTO 300.00 

fs Jotin J. Brown/SD] Payatle #W 15.6.0 Local NTO 45-00 

LEARNED LUMBER CO. NATIONAL STATE BANK ples a & 
6700 Hermosa Way DOWNTOWN OFFICE 

Hermosa Beach, CA 90415 POG arias 

DATE AMOUNT 
*##%B17 Dollars and 62 Cents 

02/28/1987 $817.62 
PAY 
TO THE Fe er 
ORDER ohn J. Brown 

OF: 2598 West Hill St. SAMPLE - VOID 

Gardena, CA 90556 See ene 
COMPATIBLE ENVELOPE 091500 - 091508 

wOOskesS7" sOOOOG7E8RURIS &£23456 780 

Payroll Checks 
Procedure: Close the Cash Disbursements Journal window. 

Or: choose Reprint Entry from the File menu. 
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Invoices 
Procedure: Close the Sales/AR Journal window. 

Or: choose Reprint Entry from the File menu. 

D-38 

LEARNED LUMBER CO. 
6700 Hermosa Way 

Hermosa Beach, CA 90415 

SAMPLE - VOID 
FORM 1300 

COMPATIBLE ENVELOPE 1601 

Allen Contractors 

3346 South Hill 

Long Beach, CA 96881 
Attn: Ralph Miller 

voeyemn; nw COUP P] 2.0.8 com | 

Freight 
6.3% Sales Tax 

Chank You 

Business Sense 

INVOICE 
23133 

DATE OF INVOICE 

02/28/1987 

Meadowview Homes 

11 Apple Tree Lane 

Irvine, CA 94221 

Attn: Brad Culver 



LEARNED LUMBER CO. 

Chart Of Accts 
For the month of February, 1987 

= 7% ecking 

ney Market Account 

posits Paid 

epaid Insurance - Fire 

epaid Insurance - Trucks 

MILOFOITOITOo To 

Di Di Di wDia 

wT: mee Bee 

ce 0 

Mm] Of VO} VIO] ajo 

D_BDP_@_O 

epaid Taxes 3 

nventory eginning Inventory - Lumber 

nventory Purchases - Lumber rso1 Purchases - luaberSSOSOSCSCSSSCC~*s 
[S10 [Inventory [Beginning Inventory - Bullding Nateriale 
i511 [Inventory [Purchases - Building Haterials SCS 

a G Accumulated Depreciation - Buildings 

les Tax Payable 
| 

wm 9 pois. 
pois 

poig Sd 

yo ederal Payroll Taxes Payable 

ederal Withholding 

ICA Payable 

tate Payroll Taxes Payable 

tate Withholding 

Dl Payable 

eposits Received 

OPO orporo 

od eee ee ee ee ee 

m™ ro Ca EC National - Buildings 

Ce ES National - Trucks 

Equity |tapital Stock 
—|{O ose etained Earnings 

e100 
pa0G 2 
e505 
000 
p100 
foio 
foios/o1 

Revenue Lumber Sales 

010701 
h020|Revenue foul iding Materials Sales SS 
4020/02  jRevenue Bidg Mat!i-Santa Monica 

4030 | {Revenue Plywood Sales 

& Chart Of Accts List 
Procedure: Open the Chart of Accts icon. 

Choose Print in the File menu. 

Options: All accounts or underlined accounts. 
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LEARNEN LUMBER CO. 2 

Chart Of Accts 
For the month of February, 1987 

Account: 
aes St NO Sotisiene pes Sey pes: 

h030/01 [Revenue [Pl ywood-Hernosa 
Plywood-Santa Monica 

H100 __|Revenue [Installation Services. —~—S=~=“*“‘*S*S“‘~*~‘S*~“‘~*“‘~*~*~*S 
h200 Revenue [Finance Charges 
h500 [Returns Returns @ Allowances. ——SOSC—C—SCSC“C‘“‘“‘;<CS* 

ms) 4500/02 xa eturns eturns-Santa Monica 

5010 =§=——s«d{C GS Cost of Goods Sold - Lumber 

5010/01 CGS CGS-Lumber-Hermosa 

5010/02 CGS ==——s«d{CGS-Lumber-Santa Nonica 

5020 ~=—SséCGSS Cost of Goods Sold - Building Materials 

5020/01 [ess 
5020/02 [ces 
5030 ~=—SséiYF;C'GSSS Cost of Goods Sold - Plywood 

5030/01 |CGS = {CGS-Plywaod-Hermosa 

5030/02 — ‘|cGs CGS-P lI ywood-Santa Nonica 

6005 
dvertising 

as & Oil 

ffice Supplies 

fc Sply-Hermosa 

fc Sply-Santa Nonica 

ostage-Santa Monica 

ayroll Expense 

R-Hermosa 

—}—1] OC} Os D 

oO 

6035/01 

“Ui UO, Vi Di OO; © 

vi v0 R-Santa Monica 

vu 9 yroll Taxes 

so me) Tax-Hermosa 

S 2) Tax-Santa Monica 

elephone 

elephone-Hermosa 

elephone-Santa Monica 

oO ae =) ~ oO 

— 6065/02 

Chart Of Accts Ust. page 2 
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LEARNED LUMBER CO. 3 

Chart Of Accts 
For the m of February, 1987 

Cas ONC Gai ain/(Loss) From Sale of Assets 

OR TEMAS PM MUR REC eae Seam N Maan e vee Air ew emMaTT SEED TIS TL PON Set CUI SREOEPSS Me CE OER et POSS TONEY Oe me eee ENT EN ee 

PI ceased cabot ee Ate Wh tines ccamasenscespreead ca ddI akan sseata aes ore es ecaetn a slate eps bd e  HATEtd Eo ls 

TERRA AA EA (eam MUNI STSER ETRE Deere aN SRS S mMTENS £00 COIMROEN IONE ERT RERERY PSY RT TE ORS IME CERU TE RERSE ONY OPT PET: RERRL ET RAE LORY? TeReee eer a ena Tee 

Eee tcc ceric a Sd Math acs ce sic I eet nese ctnctds ce aps ede teas AA pnb sats ca alee bd EESTI ats eat ee eae a aa 

PREC R Tea ORE E SETS SEMA TITS CEP IORT Un PEON EVR CRIN STEER R TR rene NC MONE NTA R EUR Tee emg ROR eRae Oe SR TRIE: CM Ten SET TE reR CRITE. 

LLP NTE TER See TE PET MERU TT TOMER: LNTRR RTE Cr Ee kot tem mNn ITO NT AIG IH EORENE NEUES OERNESS FEET T ENTE ToC REPRINT ENT Ue LEMON OTR S Le? R OPS STSES ett Mee eT 

Se Gs Selene Sete sa date Ae SE Ra eas a aes oucted A aaleda SU Sh arse se SSP DEG Oe 6 LS GSES Ilda sade Laat sr ad Cada can cneat entree Mdciaisaceo 

ee, NTC TROUT Sonn toy MN AAR CTO Aaa ci cey mt ne D Er i he ee tLe een MPT Ar Tena TTT ane Ree eer Ee CANE COE 

Noes el ae eS rat Noack NT ND ta ca aie cca oa dee ona Sla accentuate ened iia he tie neha 

Satna Sea caw ose raceme Bite eee aed ca tea a esa cease case A 

si nuscabsiSiaiesbe dat cea teu a wdiscioce tc distaste al Meshal at oeeiats se casters danacas kde a secs eb eeasfea ecb bi ec ad ries hts shi Yh a Sle ao sk 

CELESTE TCR AMR TCE TR: MCEMU RAN nD Sm meE Orr eth tooth? “Ener a ROR SE POTEET OnAROE NEES 7D AEE TE MERE TEER NORE EY AB ORR RE YE AREER AMA NET, 
' 

ssid eahasetcd sehaculanhir Meabatekticsttbsee anonedadicat ee Meck wattle she weaesinl kasd stee ON hearin Cieert iat ah Tiot ot acti Ceel Ah atid chan up ee (tiara 

sca hee Si tesa aa ed cect cea och ss cay Bocas capa Bea eh ie hails aa J tae ciaciah a eet pa cise cases esacta Ath cape ied acit ds dartnasee Oa eda caumanieantvead 

SCORE SEPT NIIP TION Fey Senn ee Tae er en ne Senne eee ee ener Te LTE ee ee en ee werner 

ER RTE HON STREPERETO RENEE nee RnR Riee RATE CMDEN RET SORT ENE N ERS TEETER Beit ed ERROR AE er Nee TT ER AARN SPEIER R Ss SEMEN Oe NAT 

Ee PT OTERIE | eREe RETO OTEM RDN) Rete ane ORAL INET FE PRETO NEUPUCETRRTOTND COUR TR ER ERATE IR CEE ENTERED HELTER ME REDE TELE EN Oe Orne FEES 

Le Schade eaves ites A EM enced atcha cee tea Wet De ap eased etsaais tated ita sonasahenaa tad edapanaleisnza ta ute iudese de Secs ch MAA eea eee 

set hGehe peal iceecasea <A derek AMM Avestan ot Mls calgt ACCA EE dash p asta sing ot ideal Paccde tego behead sedate cedn alates eats ttbicekeh ectae 

Sh nen atte ok a NE oa a a IN RN 8 a line Ue Dl ate East Nis as hah AN Soe a Ie rac ha in to 

ssouhaebianioceaha egecltceereiee Geach haha Ro sab essiedec eee REAL Salers tra AO ROO RECUR AOU A ROPE ORC EN COTO ETE REDRESS CON NRO 

spat RE 2 RAD Sh ss an ss 8 tle Baca alg SelM chm angola Tuma GSTs NAC ag SR Ts i od ae cat ett 

Daca i tatng deh Sina ditt M hae athena est N bata hitb Ripcth ant Sani € Noes ccadadeneeliaueasadarepnasedewses ox tne len CCl oaL ett oh INCA aibip ese talgeiites utes tsp: 

bre Ai Mee i ieee haiatc lah Weber Eoaan tected nde essen A bescsh tel face ce ntattuie he iuoulee ates / am eoan take wea eda sesluioeted cel wand Deed aa taadaeeag naan ae ekse se eae 

Me feces tele ce oma const Miah ah 9 ch nue on as Sane Mesa ee tec nuuelacutnce Cenc ag ad laa glut Meehan ce cees Naat ties leat al ied a Saas aa dacs bad ainda Sh 

aces aocsis ae lnte ocsesxsissnsscasesns tet MA Reno snce hm basen Eten etd > oe seb mo ecectne tas nA Bam eB SSRORB Ain GRAB RB Soh oRAirt snail ah RRR ER AREA RAR BOA Oi RRR RRB Re RRR AR A RSLS RAED Riaip Rio RAR sale, 

Chart Of Accts List, page 3 8 
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LEARNED LUMBER CO. 

Customers 
For the month of February, 1987? 

ccounts Receivable 

me ENO. Se 

noso NU [A 
oO ul Oo Ss oO oO Oo CH xD ie XD llen Contractors 

NO050/0200 —__—‘{INU Baker & Baker 

05070500 BAL 
1050/0700 INU Cc right Room Additions 

ee Ce ek Oe ee OO a 

TORO O TRH R eRe ERE ERE EEE HOS eee eH Eee EEE E HEHE SEES EEE EEE HES EEE EEEEE ESE SESE EEEE SESE EEEEEE EEE HESS HERES EEEHEEEEEEEEEEE SHES EEESESEEEEEEE EEE ESEEEEEEEESEE EEE EEEEEEEEEEE EEE HE SSS 

eee ee) Cee Cee eee ee ee eee ee ee 

eee eee Ree REET He EEO EEE Eee EEE EEE EE EEEE EEE EEE EE EEE EEE EEE EES EEEREEE EEE EEHEEE ESE HEHE EE EEE TEES EE EEE EES EE EEEE EEE SESE EHEEEEEE EEE EEE EHH EEE EEEEEESE HEHE ESESESEEEEES 

eee ee eee Cee eee! (eee eee eee eee ee eee ee eee ee eee ee eee eee eee ee eee eee ee ee eee eee eee eee eee eee ee ee ee 

tate ete e eta ete e tata e ata te tater eta tate ta tetera tetera ts Matte teat na tate ta tn anata tetera te ata tata te te tararareratara tata tararatataterarerararntaratatatararnrarererarararareratarararatanatatararararartnraratararatarararararatararararatarataratatarararaterataratarararanaraterataterntararerarararntatararararararararararararatatararatarararataratntatata® 

eee Ree EERE EERE Ee Me eee eee eee PEERS EEE HERES EEE TEESE EEE EEEEEEE SHEE EEE EEEEE SESE EE EEEEEEEEE EEE EEEE EES EEE HEHEHE EHESEEEEES HERE EE EEEEEEE EHEC EEE EEEEEE SEES EEE EE HEEE EEE SESS 

0.0.0.0 0.0.0.6.0.0.0,.0.9.0.0.0,0.6.0.0.0.0.0.0.0.0,.0.6.9.6.8.6.9.6.6.5.9.0. 68.88.88 80 FOROS OSOOR EOE EO EROS E SOE O FESO EET E SESS OBS ew 

Hee ete tate tate te tet ate tetera tata t ete ta ns Mate te rena tata ta ne a hn Mana ta tata te tate a tetera teeta tetntata tana ta ta tama tamara taratarararararararararatarararnrerarerara rata taratanena tana tatatatatanatanararararararana tata tatareratatarataretaratataareraranatatatanatararararerarara sana taranata tamara rane tatatanararnratntatann te tateratatatatarare” 

RRR E EE OEE HE EERE HEE E EEE H EEE EEE EE EEE EEE EEE EES EEEEEESE SESE SEE EEEE EEE ESSE ET ESEE HEH ER ESSE EET EEE RESTS EE EEEEESEE ES EEE EEEEEEEEEESEEE EEE EEEEEESEE EEE EEE DEES 

eee eee Cee (Oe ee ee ee ee ee 

aM a%araterarareretate rete Metatatataratarataratatate tetera ta" Maratea tetera tata tas Mute Ma tate tatetatatetatatareratarara tamara atamatatarareratararararatararatarareratararerarararararararararararararararararerarararararararatarararararararararararararararerararararararararararatararararararararararsrararararararataratatarararanararararatatararararararnrare” 

“p"e"e"e"e"e"a"0"e"s"e"e70"0"0"e"0"e"e"e"0"0"e"e"ee"e"e"e"s Ep “0'o"e"e"e"e"0'e"e"0 Gh 'e"e"e"e"e"e"e"0"0"e"0"0"e"e"0"e"e"8"0"e"a"e"0"00"8"0"s"o"e"e"e"e"s"e'e"b"e"e"0"0"0"e"e"e"0"e"e"0"e"e"e"0"8"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"0"e"e"e"e"e"e"o"e"s"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"a"e"e"o"e"e"e"o"e"e"e"e"e"e"e"e"e"0"0"e"e"e"e"e"e"e"e"e"e"e"e"e"e"8'e"e"e"e"e's” ‘nee a ee ee ee a ee a ee eee e's a ee ee + ee e's eee "e a's s Ge e's e's" e a ee ee ee ee eee ee a ee ee ee se ee es a ee ee ee ee ee ee ee 8 "eee ee eee ee ee 8 ee ee 8 8 ee ee a ee be be a a ee ee ee be ee ee ee a ee ee ee ee eee ee eee ee ee ee eb a ee eee ee ses eee es 

eee eee CP! Ce ee ee ee ee ee ee ee ee 

aaa Mate em ete e tate t eta te tata ta Meta t era Mamata tate te tate a Meneame tte ra ns Menara te tata a Mamata tama ma mamma mararamara nara ta nana ta nanan a tetera tan ararera manana mama tatararnrarara manana ma tamarara mara tamara nna rarararararararatamaratatarama nara manera ta tatanararnmaranararanamananararata tata tatarataratararararanananaranemararararareraramarararanatare” 

eee eee Me Mo ee eee eee eee eee eee eee eee eee ee ee ee eee ee eee ee eee ee ee eee 

eee eee ee Cee (ee ee ee ee ee eee ee ee ee 

Hote te tata te tote tetetaMe teeta tatetatate atatetatateta "a Mate %atatatatetatatats Mea tetatetatatetatatata tata tetaMata tate tatetatetetatatatateta tata tetatatatatetatatatatetetatatatatatatatetatetatatetatatatatetatetatatatatatetatytatetateteMa raha tatatetetatatatatatatetetatatetetetetatetatatatetetatahatetatatatatetetetatatatetetstatetntetetatetetatatatatete"| aaa atateta tate arate ata ta tata ta tate ta tate ata te ata te tats ME nme te tetera tata ta tats Mou anata ta tana tata tatatntatatetatatatatn rata tatatatntarataratntatatatarararararararataranaratatatataratatatatatatataratatatataratetaratatatatataneratatatatatata arate tatatatata tata tatatatatatetatewatara tana ta tata tatatatatatatatewatatatatatatanatatatatatatataratarata tata ta te 

eee eee eee eee PEE eee Pee eee ee eee ee ee eee ee eee ee ee eee eee ee eee ee ee EEE eee EE EEE Ee Eee EEE eee eee ee eee ee ee eee ee eee ee eee eee ee 

CRE RRR Ree EERE EEE REESE MMOH REO E RHEE HME HEE E REET REET EEE EEE EEEEEEEE EEE EEE EEE EESEEE EEE EEE RESETS ESE EHEEEEEHESESE ESE EEEE ESTEE HEHE EEEEEEE EEE EEE EEEEESESESEEE EEE ESE SEEEEEE EEE EEEE SEES 

ata a tate Me tate M etter arate tata a tetera tetera tate ta Marana tetera tata ta tate hn Mata tata rare raterararataratatarerareratataratararanataratararararatnrarararararararatararararararararararatararararatararatarararararararararatararararararararanarerarerarararanatarararanaratataratarararatanataratararatararataratarataararararatatarataratatararatatatatate®| 

eee eee eee Me BO ee ee ee eee 

eee RRR Ree EERE EEE EEE EE HEHE EERE EEE ME ESSE SHEET EEE EEE EEE EEEEE TEESE RHEE EEEEHEEEE SESH EEEEEEEEEEEESSETEEES ESET EEEEEH EES EEEEEEESESES EEE ESESESEEEHHESE ESTE EES ESESEEHEEEESEEEHESEESES 

aah ete tate t ete e tetera tetet erat eret aerate retatatata tata ta a Mata eta ta tata tete ta ea tate tata tamerarerara tata rara tata ta tn nanatatataratararetereraratarararararataratatatatarareratararararatarerarataratareratararararatararnrannrarararararerararatararararataratatararatntatatatatararararatatarataratarataratatataratatatatararatarararetartaratatataratatatarara ra 

CS Ce a a ari Se ee 

ROR EEE RHEE EEO E EEE E EMM HEHE EEE EEE MEE SEEEEEEEE EEE ESTEE EEE EES EEEEEE EEE EEE EEEEEESESESEEEEE EEE EEEEEEEEESEEEEEESEEE ESE SES EH EEEEEHEE SESE SESS ESESEEEEESEEEEEEEEEESEEEEEESHEEEEEES 

i ee tee he be ee ee ee ee arate atetahataMata tetera te tetera tem erate tata teteteteta tara ta na tateetatatntatatntaratatanataretanatererntatanatata tata tetanatateteratataratatann tata ta satan atatataratetararataretatatatatatatatatatatatate tata tatatata te 

<g"e"e"e"s"e"e"e"e"e"e"e"e"e"e"e"e"e"e"e"a"s"0"e"e"s"e"e"e"e” Eb's"e"e"e"e"e"e"e"s"0" Gb" o"e"e"e"e"e"e"e"e"e"e"e"s"e"e"e"e"e"e"e"e"e"e"e"e"e"a"e"e"e"s"e"e"e"e"e"e"e"e" -a"e"e"e"e"e"e"e"e"e"a"a"e"e"e"e"e"e"e"e"e"e"e"e"a"e"e"e"s"e"e"e"e"e"e"e"e"e"e"s"e"e"e"s"e"e"s"e"e"e"e"e"e"s"e"e"e"e"s"e"e"e’s"e"e" 

SOOO RRR EEE HEHE EEE E EEE E SEM EES EE EEEE EEE EEEEEEEEEEES EEE EEE EEE EES EESESEEEEEH EEE EESEESEE SESE EHEEE SES EEEESEEEEEEEEEEEEEEEEEEEEEEEEEESEEEEEEEEEEEEEEEEEEEEEEEEE EEE ETE EEHEEEEEEE ESSE 

Customers List 

Procedure: Open the Customers icon. 
Choose Print in the File menu. 

Options: All accounts or underlined accounts. 
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LEARNED LUMBER CO. 

Vendors 
For the month of February, 1987 

2050/0350 over Lumber Milling 

P050/0450 Frank Wilson & Sons 

SRO e em mmm meee reer eee Mew eee eee EERE EEE E EMH SETTER EEE E EEE EEE HEHE EEE EEE E EEE EE EEE EHH EH EOE EEE EEE EEE EERE EE EEE ETHER EHH DETER EEE TEESE EEE EEE EEE ME EEE E HEHE EEE E EEE eee beeeEeeeees 

ee ee oo ee ee ee ee ee eee ee ee ee ) Cee ee ee 

eee eee Cee ee ee ee eee ee ee ee ee ee ee ee ee Oe Me ee ee ee ed 

CORREO RROD EEO EERE Ee Ree eee REE REE EEE ME SOE EEE EEE EE EEE EEE EERE EERE EEE EERE EEE OE EEE EEE HEE EEE HEE HEE EE EEE EEE EE EEE EEE E EEE EEE EEE EE EEE EEE OEE EE ES Me HEEL EEE E ES EEE EEE HEHE EERE EEE DE EESE SEED 

a ae a a aS et aa ea a a ha aaa aaa aaa a, a a 
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Vendors List 
Procedure: Open the Vendors icon. 

Choose Print in the File menu. 

Options: All accounts or underlined accounts. 
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LEARNED LUMBER CO. 

Departments 
For the month of February, 1987 
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Departments List 
Procedure: Open the Departments icon. 

Choose Print in the File menu. 
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LEARNED LUMBER CO. 

Employees 
For the month of February, 1987? 

Brown, John J. 
Carson, John 1. 
David, Som RR SSSCSSCSC~diS A847 798 
Marvin, Pete H.————~——S~w 28 BTS 
Roberts, Sara 6. 

Stern) Rede necR ANS? DOR Umeer EMT Sree car Renee corer Po are ie eee eine ea NOE Be oe a eee 

SCOT LCM Ua ara ern AE Ra TS TL CI em renee rN e END PERE een nen re PUTTS TIC tee 

Beier Ween Wepre nccercretees Wekaey ran ee RRI Nar Ferrer reer INT a ete Ree a eee 

Employees LUst 
Procedure: Open the Employees icon. 

Choose Print in the File menu. 
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LEARNED LUMBER CO. 

Tax Tables 

= : AL: as aL tes Swi Bo 

Federal |S Senition | | 700.00] 720.00] —*(100.00 | 
Federal [Single [semition | | ?20.00[ 740.00] 103.00 | 
Federal [Single Seminon | | ?40.00] ?60.00[ 109.00 | 
Federal [Single Seminon | | 760.00 760.00] 114.00 
Federal [Single Semition | | ?60.00| 800.00 120.00 
Federal [Single Semiion | | 600.00 820.00] __125.00_| 
Federal [Single Semition | | 620.00 640.00] 131.00 | 
Federal [single |semiion | | 040.00 660.00 114.00 | 
Federal [Single |semition | | 660.00) 860.00f 142.00 
Federal [Single Semition | | 860.00] 900.00] 148.00 | 
Federal [Single Semition [1 | 1200.00 1220.00 —215.00 | 
Federal [Single Semition |i | 1220.00] _i240.00{ 221.00 
Federal [Single Semifion |i | 1240.00] 1260.00] 226.00 
Federal [Single Semition [1 | 1260.00] 1260.00] 235.00 
Federal [Single Semifion |i | 1260.00] 1300.00[ 242.00 | 
Federal |farried  [Semition |i | 920.00) 940.00] 123.00 
Federal |farried [Semition |i __ 940.00 960.00] 126.00 
Federal |Married [Semition [i _| 960.00| 960.00] 129.00 | 
Federal |farried  |Semifion |! _ 960.00] 1000.00] 132.00 
Federal |married  [Semifion |i | 1000.00] 1020.00] 135.00 | 
Federal _|farried  |Semifion |i | 1020.00] 1040.00] 136.00 | 
Federal |farried  |seminon [1 | 1040.00] 1060.00] 141.00 | 
Federal |narried |Semifion |i | 1600.00] 1620.00] 250.00 | 
Federal |farried _[Seminon |i | 1620.00] 1640.00] 256.00 | 
Federal |narried _|semimon [1 | 1640.00] 1660.00] 261.00 | 
Federal |farried  [Semition |v | 1660.00] 1660.00] 26.00 
Federal |married  [Seminion |i | 1660.00] 1700.00] 273.00 | 
Federal _|farried  |Semifion |2 | 1440.00[ 1460.00 163.00 
Federal |narried  [Seaifion [2 | 1460.00) 1460.00] 169.00 
Federal |farried  |Seminon [2 | 1400.00] 1500.00] 195.00 
Federal |farried  [Semifion |2 | 1500.00] 1520.00 200.00 
Federal |married  [Semitton [2 | 1520.00 1540.00] 206.00 

Tax Tables 
Procedure: Open the Tax Tables icon. 

Choose Print in the File menu. 
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LEARNED LUMBER CO. 

Recurring Entries 
For the month of February, 198? 

ermosa Beach Register/H 
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onthly Service Contract 

tw Recurring Entries 
Procedure: Open the Recurring Entries icon. 

Choose Print in the File menu. 
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Us cf w co _ 0350/0200 88.0 
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LEARNED LUMBER CO. 

General Journal 
For the month of February, 1987 

SO ort ete 

John J. Brown/Payroll Tax Payroll! {6050/01 |) a 

John J. Brown/FICA Payroll [eoie/ooo2| ——=s«[~ —~—=~=da8 9.38. 
John T. Carson/Payroll tax [Payroli |o0so/o2 § 107.25) 
John T. Carson/FICA ___—‘fPayrol! [2016/0002 —~—=«| ~——=it10?. 25, 
Sam R. David/Payrol! Tax Payrol! |eosovor | 71.50 
Sam R. David/FICA Payroll |2018/0002f | 71.50 

Pete W. Marvin/Payrol! tax |Payrol! |ooso/02 f s?.20f 
Pete W. Marvin/FICA ‘(payroll |2ore/ooo2p | S20. 
Sara 6. Roberts/Payroll Tax payroll jeoso/o1 f 117.96] 
Sara B. Roberts/FICA ——*Payrol! |2orevooozf | 1798. 
February Cost of Goods Soid res cos |s010/0i | 300.00] 
February Cost of Goods Sold res cos |s0io/02 300.00) 
February Cost of Goods Sold |FEB CGS {5020/01 180.00, — | 

February Cost of Goods Sold ree cos [5020/02 f 160.00[ 
February Cost of Goods Sold Feb COS [5030/01 695.00[ 
February Cost of Goods Sold free cos [so0s0/02 | 605.00)  — 
February Cost of Goods Sold res cos |is00 | | 760.00, 
February Cost of Goods Sold ree cos [isio |  —~*+| 360.00] 
February Cost of Goods Sold free cos |is20 | 1390.00, 

oat e heehee he eM Met atet Meta eta Ma Matern tatetatetara tetera tara tatatara tata tatatatatatararataratnraterararararatararatare tata tataratararatatareratn ta aretetetetetatatetetetatatetatatere nena Matera tatatetarataratetatatanetatasatatararn* Mare tatara tata tatatatatetarararatatatatatate tata ta ta I “aa tatatatatatatatatatatatataratatetatatatata tate 

Ps ee ee ee eee ee ee eee eee eee PERE E EER EERE ERE EERE Be) | ee eee Cee eee, 

eee eee ee eee OEE O EES E HEHEHE HEHEHE H EEE SEES HEHE EEE EEE EEE EEEEEEEEEEEESEEEEEE ESSE EESEESEEEEEE EEE EES HEEFT EEE EEE ESE SEES EEEE ESS EE EEEEESE SEEDS EEEEESEE SES EE EEEEEEEE HESS SEEEHEEEEEES 

General Journal “A 
Procedure: Open the General Journal icon. 

Choose Print in the File menu. 
Remarks: Prints the journal for the current month, or choose a differer.t month 

with the Month menu. 
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LEARNED LUMBER CO. 

Sales/AR 
For the month of February, 1987 

RESIS ha a he tt de te ae ee ee ae CRS Ch ht bt hh 

: csecolon ra numbe voeet_ | Gecuerts [mount Te 
P 3408.00) | 

[froa7 6 by 8 (5 Foot Length) pai? foro/or |_| 3200.00] | 
[|oc5t Sales tax. ——Ss=~S~=~i sors «dE SSSCSCS~SCS*~*«i 
52/092 Nail Guns, 1 Belt Sanden fosi2a froso/ozoof 135.caf —s«sd; ‘| 
[37 Natl Guns —~S~S~i TW“ ODI —| «dC ~~ | 
i Bett Sander SSS~*i 2B ~#ODD7O2_|———~dY S00] 
[608 Sates tox. —Ss~=“*é‘~*és COs —CPSSSCSC~dSCSC~“CS*ésSi« CS 
D2/15|150 Sheets .750 Inch Plysood[2a129  froso/os00| 1600.00) ___—'| {v 
[ [150 Sheets 750 Inch Plywood|23129 fs030/01_| | 1600.00] [| 
2719 [Cement Hix - 50 Bags? Ass09 [23130 fioso/oso0] so0.00|——<+dt'd 
[507 Bags Cement Nix eat30__ 020/01 _—_—*| 500.00) [| 

LLL) SS Os 
[[r907 6 by 8 5 Foot Lengtha [esta fo1o/o2 |_| 1900.00] [1 

CLEC | a 
[507 Boxes, 10 Haile  feata2__ 020/02 J —_—*| 300.00] [1] 
[—it7Boor Franes___'feaiaa__eozovo2_ |__| __r44.oo] |r 
[i007 Sheets 3/4" Plywood feai32_h030/02_f ——*‘| 7086.00] [1 

Sales/AR Journal 
& Procedure: Open the Sales/AR Journal icon. 

Choose Print in the File menu. 

Remarks: Prints the journal for the current month, or choose a different month 
with the Month menu. 
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LEARNED LUMBER CO. 

Purchases/AP 
For the month of February, 1987 

= Dote::$:: Date sf: 

3/17|Purch. Window Franes - Acne|AS 3350 [1511 | egies 
| sPurch. Window Franes - Acme [As 3350 [2050/0150) _—*| 625.00, 
12/16 /03/08 Purch. 400 6 by 8-5 Lon|p reolis|isoi | 2362.60]  —* 
Purch. 400 6 by 8 - 5° Lond 700115|2050/0350) ——=s«L__—2362.68 
D2/22|03/2¢|Purch 150 Sheets 3/4" Plywd]22690 [1521 ff 300.52} | 

D2/25]03/27 Purch 200 Boxes #10 Nails |55703C |i5Sil | 242.86, | 
| | Purch 200 Boxes #10 Nails 55703C [2050/0250 =— | 242.86 
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PO Se ee eee ERE EERE EEE EEEEEEEEE EEREMEMEREREEEREES CCREEEELEREEE ESSE 3 acne fC h ohhh hh A cho oc cn oa a ocr ne 

itt i Cee eee eee eee eee ee eee eee eee Ee CPPCC ESEUSEEEEECES EEEECSCECESSLSOLOCESS CLEC ererrrrrrrrrrerrrrnrs Sree ee eee rs 

CV Se CRRA SRR R RRR R ee CC CCER CERES E CeCe Seer 3 (LCCC e Cee eee eee eee ere eee eee eee ee ee eee 

Se Se te Cee LECCE e eee Cee ee ee ee es 

Ce) Ce) ee ee eee eee REE EERE) CREE REE E EERE REESE EEPEPE eke Eee ees CCST eee i Se cr can accra 

COPE PE Pe eee eee eee eee eee eee eee ee eee eee eee Cee E SE EECESEEEES SECC CESESEEEESEES COCCECCECSCESESELES eS = SECTS STC Seer rrrrre! Corre r errr rrr re eee eee ees 

COOP, COP, Cr RRR RRR CMR CR RR MRR REE REE SOCEM RRREERRERERECEES CEE ERORERERESOOEE SS SSS Cee ee ee ee 

ie cn oe FRR RRA CRP RRR (eee eee ee eee ee ee 

Pe Meee Se ee ee ee eee ee eee eee PERE MEER EEE BER EEEEEREMMEEEEM, CEREEEEEEEEEEEEREESES ieee eee ee eee eee Pi i et Sk Sh i ki ir 

COOP) POP Cee eee eee eee eee eee eee eee ee eee eee ee eee ee eee USeEeSeee COCCCEUCSECECOSECES SECECCCOCOSOSSSSOOCLS CLCCCCCeeeerercerrceerrres SETerrrerr rer rere eee ee ey 

OPO Se A SOP) PRR RRR EEEEREREE (CECE CERERREROCREEECEO ES SECO ee ee eee ee ee 

Purchases/AP Journal 
Procedure: Open the Purchases/AP Journal icon. 

Choose Print in the File menu. 
Remarks: Prints the journal for the current month, or choose a different month 

with the Month menu. 
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LEARNED LUMBER CO. 

Checking-CDJ 
For the month of February, 1987 

‘aid to/Descriptio gheck# | Account FFE 
Federal Express ———=«dit 23‘ |easovor | 

T__|Fedenal Express ——=~=édi231__foosovo2__| | 
250.00]Barnes Equip. - Saw Rental 1232 {6055 ~— |_| 

65.00|Pacitic Alarm ———*ii2aa_feoos + | 
[__10,00|Service Charge SSSCd®SSC«*dSOS sd 

980.10jGeneral Telephone - Jan 1234 [6065/01 | | 

P| General Telephone - Jon _[iza4__feoeso2_| | 
p27i1 | 110. 00|Hickman Mobile - Tire 235 [eons 
p2/14| 260. 00|National - Letterheads [1236 Jeoas/o1 | | 140,00] 
[| ___|National - Letterheads [1236 _[eoas/o2_| | 140.00] | 
271s | 410, 00[American Express - Gas/0ii fi2s?_|eo20 | | 110.00] | 
PT _[ ____|finerican Express - Hotels [i237 oora | | 160.00] 
T[___._|fmerican Express - Prints i237 _fooro | | 120.00] _ 
P2715 | 817. 62[John J. Brown/Payrol| i238 [eo4s/o1__| | 1250.00] 
P| [John J. Brown/Federal jr238 [201870001 f*| 228.00] 
| ft fdohn J. Brown/FICA 1238 {2018/0002 [*] 89.38] | 

[[-___*iohn J. Brown/State 1238 201970001 [*| 100.00] 
FUT [Sohn J. Brown/SD! 1238 |2019/0002 [*{ 15.00] | 

D275 | __1054.?5|John 1. Canson/Payroi! [1239 _|eoas/o2__| | 1500.00] | 
[_[__* ohn T. Carson/Federal _|i239__ faote/oo01 *| 200.00] 
[| __-_ohn 1. Carson/FICA 1239 201870002 [*| 107.25] _ 
T | ___[ehn_T. Carson/State 239 2019/0001 [*| 120.00] | 
[| ich 1 Carson 7801 239 J2ors/o002 [=| 18.00] | 
P2715] 01. so[0avid, Sam A680 x 12.50/Hr [i240 _ooas/o1 | | 1000.00] | 
| sae R Oavid/Federal [i240 2018/0001 |*| 135.00] | 
[sae A daviavricn_[raagf2o1e/oo02 [*| 71.50] 
[| Sam RF Dovia/state __fiaa0_|2orgvo0o1 [*| 80.00] | 
[Sanh davia/sor 1240 J2019/0002 |#| 12.00] ~ 
02/15 544.20jMarvin, Pete:80 x 10.00/Hr |1241 [6045/02 | | 800.00] | 

[| dPete W. Horvin/Federal [i241 _|2oreo001 f*| 125.00] | 
Prete Marvin /FicA r24r _J2018/0002 [*| 57.20] 
[| —iPete W. Marvin/State raat 201970001 [*| “00 
[| __|Pete # Marvin/sol ____|t241__ [2019/0002 [* al 
p2715 | _1119.22|Sara 6. Roberts/Payroli  [ra42_faoas/oi | 
[| ___|Sara 8. Roberte/Federal _|t242__|2018/0001 [* a 
| UP Sara B. Roberts/FICA 1242  |2018/0002 |* | zx 

[| Sara 8. Roberts/State [1242 [2019/0001 || a 
[| _|Sara 8. Roberts/S0| i242 2019/0002 |* eS 

& Cash Disbursements Journal 
Procedure: Open the Cash Disbursements Journal icon. 

Choose Print in the File menu. 
Remarks: Prints the journal for the current month, or choose a different month 

with the Month menu. 
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LEARNED LUMBER CO. 

Checking-CRJ 
For the month of February, 1987 

— 8 SSSR SO ROARS Se 5 
hnenasnncpe: Deposit: setrstinbieiedier mien hiiee Pe actotinca| Giebte te SRRE EOI BORER ARON EARD AS HM poietic eeaniee Re : C: 

p2/o2] 2862. 72|Cash Sales _———~——S—«dFeb uk 1 [e010/01 | | 1968.00] | 
[| __|tesh Sales ——S™S~S eb 1 fev 702 | 130000 | 
[ost Sales tox SOS~C~i eT OTS Sd Pt 
2705 1917.00|tash Sales ~~—~—~——~S~*~di eb‘ 2 f20701 | | 050.00] | 
| ___|eesh Sates ——Ss~S~*~*i oR 2 fnzO7O2_| | 950.00] 
a Da scan 2 ee 
2/16] 6163.16|tash Sales ———~S~S~ nb HDI | 5502.00] | 
[| __* [Cash Sales ——~—S~SPe bk 3 3702 | | 195.00] | 
[| ___|e.5% Sales Tax Feb uk apis | | ste 16] _ 
p2/23| 260.93|tash Salea_———~S~S~*di ob 4 f030701 [| | 200.00] | 
[_[__|eash Sates Feb uk + [4030/02 | | #5.00| | 
[eS Sates Tax Fob uk # pois [15.93] _ 

1400 O0|tongview Dev. - Paid Inv. festa  [roso7os00| | 1400.00] 

Cash Receipts Journal “A 
Procedure: Open the Cash Receipts Journal icon. 

Choose Print in the File menu. 
Remarks: Prints the journal for the current month, or choose a different month 

with the Month menu. 
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Bank of America 

Wilshire-15th Office #044 

P.0. Box 31 

Santa MNonica, CA 90406 

Victory Insurance 

999 La Playa Del Nar 

Oxnard, 

Nercury 

Suite 44 

CA. 9031-2 

Insurance 

1325 West Pontiac Blud. 

Los Angeles, CA 92115 

General Telephone Co 

PQ Box 4392 

Los Angeles, CA 92588 

ABC Answering Serv. 

12235 Washington Blyud. 
Narina del 

& Procedure: 

Options: 

Remarks: 

Rey, CA 90292 

Chart of Accounts Mailing Labels 
Open the Chart of Accts icon. 

Choose Print Mailing Labels in the File menu. 
All accounts or underlined accounts. 

Alternate addresses will be printed as well. 
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Allen Contractors 

956 South Hill 

Long Beach, CA 96881 

Attn: Ralph Niller 

Baker & Baker 

15589 South Avalon 

Gardena, CA 95662 

Attn: John Hansen 

Longview Developers 

1050 Ocean Park Blvd. 
Suite: 330 

Santa Nonica, CA 90415 

Attn: Betty Franklin 

Mann & Sons 

2io0ls Vietory 

Woodland Hills, CA 96212 

Attn: Jeff MNann 

Ocean Front Sales 

201 Nain Street 

Unit 190 “ 

Venice, CA 90225 

Attn: Art Fischer 

Tall Pines Estates 

11256 Rye Canyon Rd 

Valencia, CA 98776 

Attn: Brad Butler 

Wright Room Additions 
PU Box 3345 

Torrance, CA 90504 

Attn: Sally Field 

Customer Mailing Labels 
Procedure: Open the Customers icon. 

Choose Print Mailing Labels in the File menu. 
Options: All customers or underlined customers. 

Remarks: Ship-To addresses will be printed as well. 
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Acme Sash & Frame 

788 Forrest Lane 

Mendicino, CA 96659 

Clark Products 

21010 Hawthorne Blvd 

Lawndale, CA 90665 

Dover Lumber HNilling 

11 Riverdale Road 

Portland, Oregon 98577 

Frank Wilson & Sons 

4305 Wilson 

Suite B101 

Los Angeles, CA 90448 

Choose Print Mailing Labels in the File menu. 

Vendor Mailing Labels 
Procedure: Open the Vendors icon. 

Options: All vendors or underlined vendors. 
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Brown, John J. 

2598 West Hill St. 

Gardena, CA 90556 

Carson, John T. 

451 6th Court 

Unit B 

Venice, CA 90291 

David, Sam R. 

2035. Strand 

Nanhattan Beach, CA 91775 

Narvin, Pete UW. 

1243 Oakhurst Avenue 

Torrance, CA 90552 

Roberts, Sara B. 

8915 Victory Ave 
Unit 201 

Santa Nonica, CA 90408 

Employees Mailing Labels “ey 
Procedure: Open the Employees icon. 

Choose Print Mailing Labels in the File menu. 

Options: All employees or underlined employees. 
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Current Ratio 

Quick Assets 

Ratio 

Cash Ratio 

APPENDIX E: 
FINANCIAL RATIO 
FORMULAS 

The Financial Ratios report can be selected from 

the AR/AP/Payroll menu. It is a list of business 
financial ratios used by banks, managers and 

investors to measure the strength of a company. 

The formulas used to calculate each ratio are 

shown below. 

The current ratio indicates a company’s ability to 

meet its short-term obligations. The ratio is calcu- 

lated by dividing current assets including inven- 

tory, by current liabilities. 

Current Ratio = 

(Current Assets + Inventory) / Current Liabilities 

The quick assets ratio measures a Company’s 

ability to meet its current obligations without 

depending on sales. The ratio is calculated by 
dividing current assets, without inventory, by 

current liabilities. 

Quick Assets Ratio = 

Current Assets / Current Liabilities 

The cash ratio measures a company’s ability to 

service its short-term obligations directly from 

cash. The ratio is calculated by dividing cash by 

current liabilities. 

Cash Ratio = 

Cash / Current Liabilities 
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Net Working Capital 
(1000’s of $’s) 

Debt To Assets 

Ratio 

Debt To Equity 
Ratio 

Long Term 
Debt To Equity 
Ratio 

Receivables 

Turnover Ratio 

E-2 Business Sense 

Net working capital is a dollar amount, not a ratio. 
Net working capital is used to measure the re- 
sources that are readily available after meeting 

current liabilities. Net working capital is calculated 

by subtracting the current liabilities from the 

current assets, including inventory. 

Net Working Capital = 

Current Assets + Inventory - Current Liabilities 

The debt to assets ratio indicates the relationship 

of money owed to total assets. This ratio is calcu- 

lated by dividing total liabilities by total assets. 

Debt To Assets Ratio = 

Total Liabilities / Total Assets 

The debt to equity ratio indicates the relationship 

of money borrowed to money invested. This ratio 
is calculated by dividing total liabilities by stock- 

holders equity. 

Debt To Equity Ratio = “ 
Total Liabilities / Stockholders Equity 

The long term debt to equity ratio indicates the 

relationship of long term debt to money invested. 
The ratio is calculated by dividing long term 

liabilities by stockholders equity. 

Long Term Debt To Equity Ratio = 
Long Term Liabilities / Stockholders Equity 

The receivables turnover ratio indicates the 
number of times that the receivables have been 
paid off since the beginning of the fiscal year. The 
ratio is calculated by dividing the total credit sales 

by the average receivables. For purposes of this “oy 

calculation, Business Sense assumes that all sales 

are credit sales. The receivables are averaged at 

their value as of the end of each month. 

Receivables Turnover Ratio = 

Sales / Average Accounts Receivable 



Average 
Collection 
Period (in days) 

Inventory 

Turnover Ratio 

Assets Turnover 

& Ratio 

Gross Profit 
Margin (in %) 

The average collection period is the average 

number of days from the date of a sale until it is 
paid. It is calculated by dividing credit sales by the 

number of days since the beginning of the fiscal 

year, then dividing this result into the accounts 
receivable. For purposes of this calculation, 

Business Sense assumes that all sales are credit 
sales. 

Average Collection Period = 

Accounts Receivable / (Sales / Days) 

The inventory turnover ratio is the number of 

times inventory has been turned-over or replaced 
since the beginning of the year. The ratio is 

calculated by dividing the cost of goods sold by 

the inventory. 

Inventory Turnover Ratio = 

Cost of Goods Sold / Inventory 

The assets turnover ratio is the number of times 

that total assets have turned-over since the begin- 

ning of the fiscal year. It is a measure of how 
efficiently the company uses assets to generate 

sales. The ratio is calculated by dividing total sales 

by total assets. 

Assets Turnover Ratio = 

Sales / Total Assets 

Gross profit margin percentage indicates the 
relationship of gross profit to sales. The ratio is 
calculated by dividing gross profit by sales, and 

multiplying by 100. 

Gross Profit Margin = 

(Gross Profit / Sales) * 100 
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Net Profit 
Margin (in %) 

Return On 

Assets (in %) 

Return On 

Equity (in %) 

E-4 Business Sense 

Net profit margin percentage indicates the relation- 

ship of net profit to sales. The ratio is calculated 
by dividing net operating profit by sales, and 
multiplying by 100. 

Net Profit Margin = 

(Net Operating Profit / Sales) * 100 

Return on assets percentage indicates the relation- 

ship of net profit to assets employed. The ratio is 

calculated by dividing net operating profit by total 

assets, and multiplying by 100. 

Return On Assets = 

(Net Operating Profit / Total Assets) * 100 

Return on equity percentage indicates the relation- 

ship of net profit to money invested. The ratio is 

calculated by dividing net operating profit by 

equity, and multiplying by 100. 

Return On Equity = 

(Net Operating Profit / Equity) * 100 
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APPENDIX F: ALERT MESSAGES 

These alert messages are listed in alphabetical order. 

A Close account exists. 
There can be only one Close account in the Chart Of Accts. 

This is the account to which net profit is added at New 
Fiscal Year. 

Account does not exist. 
The account number was not found. Correct the account 

number, or add an account to the Chart Of Accts, Custom- 

ers or Vendors. If the journal line seems to be blank, delete 
the line. 

Account has had activity. 
After an account has been used for transactions, it cannot 

be deleted and the account number cannot be changed. 

Account name not found. 
The account name was not found in the Chart Of Accts, 

Customers or Vendors lists. Correct the name and try again, 
or cancel the dialog box to consult the list. 

Account number not found. 
The account number was not found in the Chart Of Accts, 

Customers or Vendors lists. Correct the number and try 
again, or cancel the dialog box to consult the list. 

After making a change to a previously posted 

account, please remember to repost this window 
before doing work in a data entry journal, so your 
changes will take effect. 
Close the account window now so your changes will take 

effect immediately. New accounts and changes to accounts 

will not be available in the journals until the account 

window is closed. 
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F-2 Business Sense 

Are you sure you wish to pay off all open invoices? 
You are about to pay all the invoices for an individual 
vendor, group of vendors or all vendors, depending on 

the selection you just made in the Select AP Payments 
dialog box. This alert allows you to confirm your choice 

or cancel it. 

Can’t coerce to Cash acct, must add to end of “ 

Chart Of Accts. 
A non-Cash account cannot be changed to a Cash account. 

Instead, add the new Cash account at the end of the Chart 

Of Accts list. 

Can’t delete a Cash account. 
Cash accounts may not be deleted. Change the Description 

in the Chart Of Accts to “Not in Use” or “Old Checking 

Account.” 

Can’t exceed remaining balance. 
You are trying to pay more than the remaining balance of 

the invoice. You may continue if you intend to create an 

Overpayment. 

Can’t make entries into master. “ 
Once you define sub-accounts under a master account you 

must make all entries into these sub-accounts. A master 

account is used only to summarize sub-accounts. This 

message typically appears when a transaction is attempted 

for the master accounts receivable account or accounts 

payable account. The transaction should be posted to the 
customer or vendor account instead. 

Can’t promote to a master - this 4-digit account has 
had activity. 
You may not add sub-accounts to a four-digit account after 

posting to it. The solution is to create a new master and its 

sub-accounts. 

Customer name not found. 
The customer name was not found in the Customers list. 

Correct the name and try again, or cancel the dialog box ‘&® 

consult the list. 

Customer number not found. 
The customer number was not found in the Customers list. 

Correct the number and try again, or cancel the dialog box 

to consult the list. 



Customer past credit limit. Will you allow invoice# 
XXXXX? 
The invoice shown will push the customer account over 

the credit limit. You may issue the invoice anyway, if you 
choose. 

Department name not found. 
The department name was not found in the Departments 
list. Correct the name and try again, or cancel the dialog 

box to consult the list. 

Department number not found. 
The department number was not found in the Departments 
list. Correct the number and try again, or cancel the dialog 
box to consult the list. 

Don’t change the starting month if you’ve made 
entries. 
You may not change the First Month of Fiscal Year after 
recording transactions. 

Duplicate account number. 
The number being added already exists in the Chart Of 

Accts, Customers or Vendors. Duplicate account numbers 

are forbidden. Note that Customers and Vendors are 

extensions to the Chart Of Accts, so all three are checked. 

Duplicate employee ID. 
The Employee ID being added already exists. The ID must 
be unique. 

Employee ID not found. 
The employee ID was not found in the Employees list. 
Correct the number and try again, or cancel the dialog box 
to consult the list. 

Employee has had activity. 
You have attempted to delete or change the ID of an 

employee who has been paid. This record must remain on 
file, in order to print a W-2 Form at the end of the year. If 

an employee is inactive, zero out the wage information. 

Employee name not found. 
The employee name was not found in the Employees list. 

Correct the name and try again, or cancel the dialog box to 
consult the list. 
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F-4 Business Sense 

Entry doesn’t balance. 
The debits do not equal the credits. Click on the OK 
button, and the unbalanced transaction will be selected. 

Either the entry does not balance, or you are dating more 

than the first line of a multiple-line transaction. Business 
Sense marks the beginning of each transaction with the 
date. If you date each line, the transaction will not balance. “ 

Entry must be dated. 
Each entry must have a date on the first line. If this seems 

to be a blank line, delete the line. This situation typically 
occurs in the Purchases/AP Journal, because two dates, 

Invoice Date and Due Date, are required. 

Important! | was unable to open the file ‘name’! 
This is a serious problem. One of your files has been 
renamed, erased or damaged. Consult the Restoring Data 

Files Section of Chapter 8: Tips for Advanced Users. 

Important! This entry will not pay off a valid open 
invoice. 
The Ref field in the Cash Receipts Journal does not match 

an open invoice. You should probably be using the Apply 

AR Payments command in the Function menu. Correct the 

invoice number or delete this transaction. 

Important! This entry will not pay off any currently 
open invoice. 
You tried to apply a Cash Disbursements Journal entry to a 

vendor without choosing Select AP Payments in the 
Function menu. Pay open vendor invoices with the Select 
AP Payments command. Otherwise, open invoices will not 
be matched and closed. If you are making a C.O.D. 
payment to a vendor, post it to purchases or to an expense 
account in the Chart Of Accts, not the vendor account. 

Delete this transaction, or change the account distribution. 

Important! You are running out of room on this disk! 
Perform the procedure given for the New Data Disk 
command in Chapter 7: Pull-Down Menu Commands. Your 
data will be summarized to give you more space, without “ 
changing account balances, open invoices or financial 

reports. 

Incorrect account type. 
The account type is not one of the 15 valid types. Select a 

valid type and click on the OK button. 



Incorrect journal designation. 
The Recurring Entries journal code is not one of the valid 
codes. Select a valid journal and click on the OK button. 

Last entry must balance. 
The transaction entered before requesting automatically 

generated entries does not balance. Click on the OK 

button, and the unbalanced transaction will be selected. 

Business Sense marks the beginning of each transaction 

with the date, so enter a date only on the first line. If you 
date each line, the transaction will not balance. 

Multiple entry lines dated. Date only the first line of 

entry. 
Business Sense marks the beginning of each transaction 

with the date, so enter a date only on the first line of a 

transaction. If you date each line, the transaction will not 

balance. 

This entry only has one line. In this journal, entries 
need at least two lines. 
Business Sense marks the beginning of each transaction 

with the date, so enter a date only on the first line of a 

transaction. If you date each line, the transaction will not 

balance. 

Must have a master account. 
You can’t have sub-accounts without a corresponding 

master four-digit account. Add the master account to the 

Chart Of Accts, Customers or Vendors window. 

Must be a 4-digit account number. 
All Cash accounts must have a four-digit account number. 

Cash accounts are not permitted to be sub-accounts. 

Must be non-zero after Slash. 
Sub-accounts must be numbered greater than zero. 

Must have a Close account. 
In order to choose New Fiscal Year, you must have exactly 

one Close account in the Chart Of Accts. This account will 

receive the net profit for the year. Consult the New Fiscal 

Year command in Chapter 7: Pull-Down Menu Commands. 

Must have an account number. 
Each line must have an account number. If this seems to 

be a blank line, delete the line. 
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Name or Number not found. 
In the Find Name or Number command, the String/Number 
to Locate was not found. If you expected to find a match- 

ing entry, choose the command again with a different or 

shorter String/Number to Locate, or activate a different 
window or click on Search All Open Windows. 

No data disk in data drive. “ 
The Company Data folder could not be found. Insert your 

Data Disk. Perhaps the Company Data folder is buried in 
another folder. One Company Data folder and the Business 
Sense program should be in the “root” directory, the first 
window you see when you open the disk icon. This 

arrangement is designed to allow other Company Data 

folders to be hidden inside another folder. 

Not covered in tax tables. 
No entry matching the employee’s wages and filing status 

was located in the Tax Tables. Look at the last line gener- 

ated in the Cash Disbursements Journal: record the em- 

ployee name, withholding category and gross wages. 

Review the employee’s filing status: select the employee in 

the Employees window, click on the More tab and click on 
the Personal Information button. Add lines in the Tax “ 
Tables for the relevant filing status and wages, and close 

the Tax Tables window. Delete the unposted transactions 
in the Cash Disbursements Journal and the General Jour- 

nal, and choose Generate Payroll again. 

Only one value per line is allowed in this journal. 
In the Sales/AR, Purchases/AP or General Journal, only one 

account can be referenced per line. Either a debit or a 
credit is permitted on a line, but not both. 

Please select a 1099 compensation type. 
You are shown a list of valid 1099 compensation types. 

Click on a radio button to choose one. 

Please select a valid account type. 
You are shown a list of valid account types. Click on a 
radio button to choose one. “ 

Please select a valid journal. 
You are shown a list of valid journals. Click on a radio 

button to choose one. 



Please select a valid marital status. 
You are shown a list of valid marital or filing status 
choices. Click on a radio button to choose one. 

Please select a valid pay period. 
You are shown a list of valid pay periods. Click on a radio 
button to choose one. 

Please select a valid tax table. 
You are shown a list of valid tax tables. Click on a radio 

button to choose one. 

Previous entry doesn’t balance. 
The debits do not equal the credits. Click on the OK 

button, and the unbalanced transaction will be selected. 

Business Sense marks the beginning of each transaction 

with the date, so enter a date only on the first line of a 

transaction. If you date each line, the transaction will not 
balance. 

Printing of checks postponed until window is closed. 
Because of an error in account numbers or amounts, the 

checks will not be printed now. Fix the error. Then print 
checks by closing the Cash Disbursements window again. 

Printing of invoices postponed until window is closed. 
Because of an error in account numbers or amounts, the 

invoices will not be printed now. Fix the error. Then print 
invoices by closing the Sales/AR window again. 

Same Cash account as journal. 
In the Cash Disbursements Journal or Cash Receipts 

Journal, you cannot distribute a transaction to the same 

Cash account. This would be like writing a check and 
depositing it to the same account. 

Sorry, you already have a report open, and must 

close it first to open this one. 
You can view only one report at a time. Close the old 

report window and choose the new report again. 

Sorry, your passwords do not match. 
Your second attempt to enter a valid password was 
incorrect. You will be returned to the Finder. 
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There’s some problem with your printer. 
The printer is not ready. Fix the problem and click on the 

OK button to continue printing. 

This account number is invalid. 
You have specified an invalid account number for one of 

these fields: “A 

e Discount Acct # in the Customers list. 7 

e Revenue Acct # in the Customers list. 
e Wages or Withholding account in the Employees list. 
e Discount Account in the Vendors list. 

Correct the account number. You can use the name to 
number shortcut shown in the Shortcuts Section of Chapter 

3: Tips for Users. To consult the Chart Of Accts list, close 

the dialog box by clicking on the DONE button. 

This employee ID is invalid. 
You have specified an invalid employee ID for Sales 
Person ID in the Customers list. Correct the ID number. To 

consult the Employees list, close the dialog box by clicking 
on the DONE button. 

This tax table information is invalid. 
The Personal Information tax table choices are not valid. A“ 

Change the entries to one of the listed choices. 

Too many Cash accounts. 
You attempted to add a sixth Cash account. Business Sense 

allows up to five Cash accounts. 

Undefined 1099 compensation type. 
The 1099 Type is invalid. Select a valid type and click on 
the OK button. 

Undefined date. | 
The date is invalid. Enter the date as “mmdd” with leading 

zeros for month and day. 

Undefined employee status. 
The marital status is not Single, Married or Unmarried head 

of household. 

Undefined payroll period. 
The payroll period is not Weekly, Bi-weekly, Semi- 

monthly, Monthly or Daily. 
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Undefined withholding allowances. 
The number of withholding allowances must be zero to 10. 

Undefined withholding table. 
The withholding table is not Federal, State or Local. 

Unknown tax code. 
The Sales Tax Code in the Sales/AR Journal or Cash 

Receipts Journal is not valid. Consult the table by choosing 

Set Sales Tax Codes in the Function menu. The default 

code is a blank. The other codes are digits. 

Vendor name not nound. 
The vendor name was not found in the Vendors list. 

Correct the name and try again, or cancel the dialog box to 
consult the list. 

Vendor number not found. 
The vendor number was not found in the Vendors list. 

Correct the number and try again, or cancel the dialog box 

to consult the list. 

Wait! The payment on this invoice exceeds the 
invoice’s remaining balance. 
You should probably adjust the amount paid to the 
remaining balance shown. 

You are not allowed to look in this folder. 
The Company Info and Employees icons cannot be opened 
by the restricted user. 

You are not allowed to view this report. 
The Income Statement, Balance Sheet, Ratio Report, 

Customer Analysis, Vendor Analysis and Payroll Report are 
sensitive information not available to the restricted user. 

You don’t need to insert, just add to the end of the 

list. 
Add to the Chart Of Accts, Customers, Vendors and 

Employees lists at the end of the list. When the window is 

closed, the new lines are sorted into sequence. 

You have changed some account types to blank! 
The account type is essential for proper processing. 

Change the account to a valid type as soon as possible. 
Type an invalid type to see a list of valid choices. 
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You have entered a new calendar year. 
Before posting transactions for the new year, close the 

books, print W-2 and 1099 Forms, print the Sales Tax, 
Customer Analysis and Vendor Analysis reports. Make two 
backup copies of your data, and choose New Calendar 
Year from the Function menu. Then begin entering transac- 

tions for the new calendar year. “& 

Your data disk is write protected. 
Business Sense will not be able to post changes and 

transactions. Restart Business Sense after you unlock the 

Data Disk by sliding the plastic tab to cover the hole. 
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APPENDIX G: 
RECURRING ENTRIES 
TRANSACTION LAYOUT SHEETS 

Recurring Entries are powerful tools for efficiency and 
accuracy. 

Designing Recurring Entries is discussed in the Recurring 

Entries Sections of Chapter 3: Tips for Users and Chapter 6: 
Main Window Icons. 

Photocopy the layout sheets on the following pages to 

design your own Recurring Entries. There is a worksheet 
for each of the five journals. 
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Recurring Entries 

Generate 
Entries 

General Journal 

Recurring Entries 

Generate 
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Purchases/AP Journal 
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APPENDIX H: 
CONTROL LOG LAYOUT SHEET 

The Control Log Section of Chapter 5: Using Business Sense 
gives three methods for monitoring the status and integrity 

of your accounting data. Photocopy the sheet on the next 

page if you choose to use the manual control log 

technique. 
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Business Sense Control Sheet 

Batch Accounts 

Total Deposits Checks Receivable Description i. i=) @ ~ @o oO 
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APPENDIX I: INDEX 

1099 codes, 6-14 

1099 Forms, 7-48 to 7-49, D-33 
1099 Initializer program, 4-12, 3-12 

A Account Balance command, 7-17 to 7-18 

Account History report, 7-40, 4-8, D-20 

Account name to number shortcut, 3-10, 2-8, 2-12 

Account numbers, 3-1 to 3-2, 4-3 to 4-6, 6-8 
Account To Journal button, 3-9 

Account type, 6-8, 4-3 to 4, 4-6 
Accounts Payable, 1-3, 4-6, 4-8 to 4-10 

Accounts Payable Payment Preview report, 7-30, D-3 

Accounts Receivable, 1-2, 2-7, 4-6 
& Adjustments, 7-22 to 7-24, 3-5, 3-8, 6-36 to 6-37, 6-40 

Advances, 8-5 to 8-7 

Aging method, 6-11, 7-43 
Analysis techniques, see Exporting data, Financial Ratios 

report, Customer Analysis report, Vendor Analysis 

report 

AP, 1-3, 4-6, 4-8 to 4-10 

AP Aging report, 7-46 to 7-47, 4-8 to 4-9, D-29 to D-30 
Apple menu, 7-3 
Apply AR Payments command, 7-25 to 7-27, 2-8 

Apply Finance Charges command, 7-27 
AR 9-22-7446 

AR Aging report, 7-43, D-22 to D-23, 2-7 

AR/AP/Payroll Report menu, 7-42 to 7-51, 2-23 

B Backing up data files, 5-5 to 5-8 

& Bad debts, 8-4 
Balance forward aging, 7-43 

Balance Sheet accounts, 4-4 

Balance Sheet report, 7-38, D-13 to D-14 

Bank accounts, 8-2 to 8-3, 6-3 
Batch totals, 7-24 to 7-25, 6-34 
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Billing Statements, 7-28, D-2 

Bill-To address, 6-13 
Budgets, 7-34 to 7-35, 4-12, 1-3, 2-21 

Ce Cash accounts, 4-4, 6-3, 8-2 to 8-3 

Cash Disbursements Journal, 3-3, 6-41 to 6-45, 2-16 to 2- 21 
2-19, 8-3, D-51, see also Generate Payroll command, , 

Select AP Payments command 

Cash expenses, 4-8 to 4-9 
Cash Flow Analysis report, 7-40, D-18 to D-19 

Cash method, 4-7, 4-8 

Cash Receipts Journal, 3-3, 6-45 to 6-47, 2-17 to 2-18, 8-3, 

D-52, see also Apply AR Payments command 

Cash sales, 6-46 to 6-47 
Chart Of Accounts numbering, 4-3 to 4-6 
Chart Of Accts list, 6-7 to 6-10, 4-3 to 4-6, 4-8 to 4-9, 2-3, 

D-39 to D-41 

Check Register report, 7-39, D-17 

Check writing, 4-8 to 4-9, 6-41 to 6-44 
Clear command, 7-8 

Close account, 7-19 to 7-20 

Close command, 7-4, 6-4 
Closing the books, 3-6, 7-19 to 7-21, 8-4 
Codes, see Sales Tax Codes, Account type, 1099 codes 

Command key shortcuts, 3-10 
Commissions, 6-13, 7-44 to 7-45 
Commitments, 4-9 

Company Data folder, 3-11 to 3-12, 4-1 to 4-3, 5-6 to 5-8 
Company Info, 6-4 to 6-5, 2-3, 4-3 
Complete Invoice command, 7-14 to 7-15, 6-34 
Computer forms, A-1 
Control log, 5-3 to 5-5, 8-11, H-1 

Copy command, 7-8 
Cost centers, 4-4 

Credit limit, 6-12, 3-8 
Credit memo, 7-22 to 7-24, 3-5, 3-8, 6-36 to 6-37, 6-40 
Customer Analysis report, 7-45 to 7-46, 2-23, D-27 to D-28 

Customer invoices, 4-8, 6-32 to 6-37 
Customer Ledger Card, 7-26 to 7-27, 2-9 “ 
Customer numbers, 4-7, 3-1, 6-11 
Customer payments, 7-25 to 7-27 
Customers list, 6-10 to 6-13, 2-5, 4-6, 4-8, 3-2, D-42 

Cut command, 7-8 

l-2 Business Sense 



D Data disk, 3-11 to 3-12 
Debits and credits reversed, 7-23 

Default values, 3-9, 2-12 

Delete a Line command, 7-9 

Deleting accounts, 3-8, 6-9 
Demo data, 2-24, 4-4 

Demo program, 2-2 

Department Income report, 7-37 to 7-38, D-9 to D-12, 2-21 

Department accounts, 4-4 to 4-5, 3-1 

Departments list, 6-16, D-44 

Deposits, customer, 8-7 to 8-9 
Depreciation, 6-30 
Desktop, 4-1 to 4-3, 5-1, 5-6 to 5-8 
Detail accounts, 4-4 to 4-5 

Dialog boxes, 3-9 
Dimmed menu items, 7-2 to 7-3, 7-36, 7-42 
Discounts (payables), 6-15 to 6-16, 7-32 
Discounts (receivables), 6-13, 7-26, 2-9, 8-9 
Due date, 6-38, 2-12 

e Edit menu, 7-8 to 7-15 

Editing, 3-8, 6-25, 6-27 to 6-28 
Employee ID, 4-10, 6-13, 6-17 

& Employees list, 6-17 to 6-22, 4-10 to 4-12, 2-13, D-45 
Ending a session, 5-3 to 5-8 

Error checking, 3-7 to 3-8 

Excel program, 7-6 
Exporting data, 8-3 

Expressions, 3-9 

FE Fee splitting, 8-9 
FICA withholding, 6-20 to 6-21 
File menu, 7-3 to 7-7 
Files, 3-11 to 3-12 

Finance charges, 6-12 to 6-13 
Financial ratios, E-1 to E-4 

Financial Ratios report, 7-39, D-16, 2-22 
Financial statements, see Income Statement report, Depart- 

ment Income report, Balance Sheet report 

Find Name or Number command, 7-10 to 7-13, 2-15 

Finder program, 4-1 to 4-3, 5-1, 5-6 to 5-8 

Fiscal year, 4-3, 4-8, 4-10, 6-5 
Fix/Adjust Entry command, 7-22 to 7-24, 3-5, 3-8, 6-36 to 6- 

37, 6-40 
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- Forms, 4-1, A-1 

Fringe benefits, 6-18 to 6-19 
Function menu, 7-16 to 7-35 

General Journal, 6-29 to 6-31, 3-4, 4-6, 2-17, D-48, see also 
Generate Payroll command, New Fiscal Year comman 

General Ledger function, 1-2, 4-3 to 4-6 
General Ledger report, 7-41, D-21 

Generate Entries button, 2-18, 2-20, 6-27 
Generate Payroll command, 7-33 to 7-34, 2-16 
GL Report menu, 7-36 to 7-41, 2-21 to 2-22 
Graphs command, 7-7, 2-23 

Hard disk, 4-2 to 4-3, 5-6 to 5-8, 8-2 
Hardware requirements, 1-4 

Hash Totals command, 7-24 to 7-25, 6-34 
Help icon, 6-24 to 6-25, 2-23 

Icons, 3-1, 6-1 to 6-3 
ImageWriter printer, 1-4 

Importing data, 3-12 

Income Statement accounts, 4-4 

Income Statement report, 7-37, D-5 to D-8, 2-21 

Index menu, 7-52, 6-24 to 6-25, 6-26, 2-19 
Insert a Line command, 7-9 

Installing Business Sense, 4-1 to 4-3 

Invoice Register report, 7-44, D-24 

Invoicing, 6-32 to 6-36, 7-14 to 7-15,1-3, 2-6, 4-7, 4-8, D-38 

Jazz program, 7-6 
Job costing, 4-5 

Journal code, 6-28 
Journals, 3-2, 3-9 

Keyboard shortcuts, 3-10 

" 



Labels, 7-5, 8-3, D-53 to D-56 

LaserWriter printer, 1-4, 8-4 
Lists, 3-2 

Mailing labels, 7-5, 8-3, D-53 to D-56 
Main window, 5-2, 2-2 

Manual checks, 6-42 

Manual invoices, 4-7 

Master accounts, 4-4 to 4-6, 3-1 to 3-2, 3-8 
Master program disk, 4-1 to 4-2 

Menus, 7-1 to 7-3 
Minimum finance charge, 6-12 
Month menu, 7-51 

Monthly closing, 8-4 

Monthly checks, see Recurring Entries. 

More Info command, 7-9 

More info dialogs, 2-4, 2-5, 2-10, 2-13 to 2-14, 4-8 to 49, 6- 
9 to 6-10, 6-15 to 6-16, 6-18 to 6-22 

Multiplan program, 7-6 
Multiple checking accounts, 8-2 to 8-3, 6-3 
Multiple companies, 8-2 

Multiple distribution, 3-4 to 3-5, 6-28, 6-43 to 6-44 

Multiplication expressions, 3-9, 2-9 

Name to Number shortcut, 3-10 

New Calendar Year command, 7-20 to 7-21 

New Data Disk command, 7-21, 8-4 

New Date command, 7-16 to 7-17 

New Fiscal Year command, 7-19 to 7-20 

Open invoice aging, 7-43 
Open invoices (payables), 7-31 to 7-32, 4-10 

Open invoices (receivables), 7-26, 4-8 
Open Main Window command, 7-3 

Page Setup command, 7-4, 7-35 
Partial payments (payables), 7-32 

Partial payments (receivables), 7-26 
Passwords, 6-5 to 6-6, 4-3, 5-2, 3-12 
Paste command, 7-8 

Pay off invoice (payables), 7-32 
Pay off invoice (receivables), 7-26, 2-9 

Index 1-5 



l-6 Business Sense 

Pay type, 6-17 
Payments (payables), 7-30 to 7-33 
Payments (receivables), 7-25 to 7-27 

Payroll function, 1-3, 4-10 to 4-12 

Payroll processing, 7-33 to 7-34, 6-22, 2-15 to 2-17, 8-5 to 
8-7, D-37 

Payroll report, 7-49 to 7-50, D-34 “a 

Periodic payments, see Recurring Entries = 

Personal information, 6-21 to 6-22, 2-14 

Posted to wrong account, 7-22 to 7-23 

Posting, 3-5, 1-1, 6-4 
Pre-printed forms, A-1 

Preview Accounts Payable Payments report, 7-30, D-3 

Print command, 7-4, 8-9 

Print Mailing Labels command, 7-5 
Printers, see ImageWriter, LaserWriter 

Printing checks, 4-8 to 4-9 
Printing invoices, 6-32 to 6-36 
Product lines, 4-5 

Profit and Loss Statement, 7-37, D-5 to D-8, 2-21 

Profit centers, 4-4 

Project costing, 4-5 
Purchase order, 4-7 

Purchases/AP Journal,6-37 to 6-40, 3-4, 3-9, 4-8 to 4-10, 2- fy 

11 to 2-12, D-50 

Purchases, cash, 4-8 to 4-9 

Purchases on account, 6-39 

Quit command, 7-7, 5-5, 3-10, 2-23 

Ratios, 7-39, D-16, 2-22, E-1 to E-4 
Recurring Entries, 6-26 to 6-28, 4-7, D-47 
Recurring Entries (creating), 3-11, 6-27 to 6-28, G-1 to G-4 

Recurring Entries (using), 3-11, 6-27, 2-17 to 2-18, 2-19 to 
2-20 

Reimbursements, 6-18 to 6-19 
Repeat Search command, 7-14 
Reports, 3-6 to 3-7, 2-21 to 2-23, D-1 to D-56 “ 
Reports catalog, D-1 to D-56 
Reprint Entry command, 7-4 to 7-5 

Resale, sales for, 7-29 

Restricted password, 6-5 to 6-6 
Restoring data files, 8-10 to 8-12 



Return key, 3-9 

Reversing entries, 7-22 to 7-24, 3-5, 3-8, 6-36 to 6-37, 6-40 

Sales/AR Journal, 6-32 to 6-37, 3-4, 2-6, 4-8, D49 

Sales, cash, 6-46 to 6-47 
Sales Commissions report, 7-44 to 7-45, D-26 
Sales on account 6-32 to 6-36 
Sales tax codes, 7-29, 4-6, 6-33 

Sales Tax report, 7-44, D-25, 2-23 

Sales taxes, 4-6, 7-29, 6-33 to 6-35 

Select AP Payments command, 7-30 to 7-33 

Set Sales Tax Codes command, 7-29, 4-6 
Ship-To addresses, 6-13 
Shortcuts, 3-9 to 3-10 

Social Security tax, 6-20 to 6-21 
Spreadsheet files, 7-6, 8-3, 4-12 
ST field, 6-13, 6-33 to 6-34 

Starting Business Sense, 5-1 to 5-3 
Stopping Business Sense, 5-3 to 5-8 

Sub-accounts, 4-6, 3-1 to 3-2 

Summary accounts, 4-4 to 4-6, 3-1 to 3-2, 3-8 
SYLK file format, 7-6 

Tab key, 3-9 

Tabular reports command, 7-6 to 7-7 
Tax codes, 7-29, 4-6, 6-33 
Tax Tables, 6-23 to 6-24, 6-21 to 6-22, 4-11, 3-8, D-46 

Taxes, see Sales taxes, Withholding 

TC field, 6-33, 6-35, 6-46 

Text files, 7-5 to 7-6, 8-3 
Tips on using Business Sense, 3-1 to 3-12, 8-1 to 8-12 

Tips paid, 6-18 to 6-19 
Trial Balance report, 7-38 to 7-39, D-15, 4-1, 4-6 

Underlining in lists, 3-7, 7-11 to 7-13, 7-33, 2-15, 8-1 

Underlining in menus, 7-36, 7-42 
Unrestricted password, 6-5 to 6-6 
Unselect All command, 7-14 

Vendor Analysis report, 7-47 to 7-48, D-31 to D-32 

Vendor checks, 7-30 to 7-33, 6-15 to 6-16, 4-8, D-36 
Vendor codes, 6-14 
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Vendor invoices, 4-10, 6-37 to 6-39 
Vendor Ledger Card, 7-31 to 7-33 
Vendor numbers, 4-9, 6-14, 3-1 

Vendor payments, 7-30 to 7-33 

Vendors list, 6-14 to 6-16, 3-2, 4-6, 4-9, 2-10, D-43 
Voids, 7-22 to 7-24, 3-5, 3-8 

“ 

W2-1099 Initializer program, 4-12, 3-12 

W-2 Forms, 7-50 to 7-51, D-35 

W-4 Forms, 4-10 

Wages, 6-18 to 6-19, 2-13 
Withholding, 6-20 to 6-22, 4-11 to 4-12, 2-14 
Write to File command, 7-6 

Year to date, 4-11 to 4-12, 6-19 to 6-20, 2-21 


